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Precautions
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Thank you very much for buying a BROTHER sewing machine. Before using your new machine,
please read the safety instructions below and the explanations given in the instruction manual.

With industrial sewing machines, it is normal to carry out work while positioned directly in front
of moving parts such as the needle and thread take-up lever, and consequently there is always a
danger of injury that can be caused by these parts. Follow the instructions from training personnel
and instructors regarding safe and correct operation before operating the machine so that you
will know how to use it correctly.

SAFETY INSTRUCTIONS

1 Safety indications and their meanings

This instruction manual and the indications and symbols that are used on the machine itself are
provided in order to ensure safe operation of this machine and to prevent accidents and injury to
yourself or other people. The meanings of these indications and symbols are given below.

Indications

The instructions which follow this term indicate situations where
A DANGER failure to follow the instructions will almost certainly result in death
or severe injury.

The instructions which follow this term indicate situations where
A CAUTION failure to follow the instructions could cause injury when using the
machine or physical damage to equipment and surroundings.

Symbols

A ................. This symbol (/\) indicates something that you should be careful of.
The picture inside the triangle indicates the nature of the caution that must be
taken. (For example, the symbol at left means "beware of injury".)

® ................. This symbol (®) indicates something that you must not do.

9 ................. This symbol (‘) indicates something that you must do.

The picture inside the circle indicates the nature of the thing that must be done.
(For example, the symbol at left means "you must make the ground connection”.)
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2 Notes on safety

A DANGER

Wait at least 5 minutes after turning off the power switch and disconnecting the power cord from the wall
outlet before opening the face plate of the control box. Touching areas where high voltages are present can

result in severe injury.

A CAUTION

Environmental requirements

Use the sewing machine in an area which is free
from sources of strong electrical noise such as
high-frequency welders.

Sources of strong electrical noise may cause
problems with correct operation.

Any fluctuations in the power supply voltage
should be within +10% of the rated voltage for
the machine.

Voltage fluctuations which are greater than this
may cause problems with correct operation.

The power supply capacity should be greater
than the requirements for the sewing machine's
electrical consumption.

Insufficient power supply capacity may cause
problems with correct operation.

The ambient temperature should be within the
range of 5°C to 35°C during use.

Temperatures which are lower or higher than this
may cause problems with correct operation.

The relative humidity should be within the range
of 45% to 85% during use, and no dew forma-
tion should occur in any devices.

Excessively dry or humid environments and
dew formation may cause problems with cor-
rect operation.

Avoid exposure to direct sunlight during use.
Exposure to direct sunlight may cause prob-
lems with correct operation.

In the event of an electrical storm, turn off the
power and disconnect the power cord from the
wall outlet.
Lightning may cause problems with correct
operation.

Installation

O @ 0 @ QU

Machine installation should only be carried out
by a qualified technician.

Contact your Brother dealer or a qualified elec-
trician for any electrical work that may need to
be done.

The sewing machine weighs more than 720 kg.
The installation should be carried out by a lift
or a crane.

Do not connect the power cord until installa-
tion is complete, otherwise the machine may
operate if the start switch is pressed by mis-
take, which could result in injury.

Be sure to connect the ground. If the ground
connection is not secure, you run a high risk of
receiving a serious electric shock, and problems
with correct operation may also occur.

When securing the cords, do not bend the cords
excessively or fasten them too hard with
staples, otherwise there is the danger that fire
or electric shocks could occur.

Be sure to wear protective goggles and gloves
when handling the lubricating oil or grease, so
that no oil or grease gets into your eyes or onto
your skin, otherwise inflammation can resuit.
Furthermore, do not drink the oil or grease un-
der any circumstances, as they can cause vom-
iting and diarrhoea.

Keep the oil out of the reach of children.

Avoid setting up the sewing machine near
sources of strong electrical noise such as high-
frequency welding equipment.

If this precaution is not taken, incorrect machine
operation may result.

Secure the machine with the adjustment bolts
on the sound floor so that it will not move.
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A CAUTION

Sewing

This sewing machine should only be used by
operators who have received the necessary
training in safe use beforehand.

The sewing machine should not be used for any
applications other than sewing.

Be sure to wear protective goggles when using
the machine.

If goggles are not worn, there is the danger that
if a needle breaks, parts of the broken needle
may enter your eyes and injury may result.

Turn off the power switch at the following times,
otherwise the machine may operate if the start
switch is pressed by mistake, which could re-
sult in injury.

« When threading the needle

« When replacing the bobbin and needle

» When not using the machine and when leav-

ing the machine unattended

Do not get on the table.
Table may be damaged.

A

A
A\
0
0

Secure the machine with the adjustment bolts
on the sound floor before use the machine so
that it will not move.

Attach all safety devices before using the sew-
ing machine. If the machine is used without
these devices attached, injury may result.

Do not touch any of the moving parts or press
any objects against the machine while sewing,
as this may result in personal injury or damage
to the machine.

Do not touch the pulse motor and sewing ma-
chine bed section during operation or for 30 min-
utes after operation. Otherwise burns may resuit.

If an error occurs in machine operation, or if ab-
normal noises or smells are noticed, immediately
turn off the power switch. Then contact your
nearest Brother dealer or a qualified technician.

If the machine develops a problem, contact your
nearest Brother dealer or a qualified technician.

Cleaning

Turn off the power switch before starting any
cleaning work, otherwise the machine may op-
erate if the start switch is pressed by mistake,
which could result in injury.

O

Be sure to wear protective goggles and gloves
when handling the lubricating oil or grease, so
that no oil or grease gets into your eyes or onto
your skin, otherwise inflammation can result.
Furthermore, do not drink the oil or grease un-
der any circumstances, as they can cause vom-
iting and diarrhoea.

Keep the oil out of the reach of children.

Maintenance and inspection

e O

Maintenance and inspection of the sewing ma-
chine should only be carried out by a qualified
technician.

Ask your Brother dealer or a qualified electri-
cian to carry out any maintenance and inspec-
tion of the electrical system.

Turn off the power switch and disconnect the
power cord from the wall outlet at the following
times, otherwise the machine may operate if the
treadle is depressed by mistake, which could
result in injury.
» When carrying out inspection, adjustment
and maintenance
- When replacing consumable parts such as
the rotary hook and knife.

If the power switch needs to be left on when
carrying out some adjustment, be extremely
careful to observe all safety precautions.

Use only the proper replacement parts as speci-
fied by Brother.

If any safety devices have been removed, be ab-
solutely sure to re-install them to their original
positions and check that they operate correctly
before using the machine.

Any problems in machine operation which re-
sult from unauthorized modifications to the ma-
chine will not be covered by the warranty.
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3 Warning labels

* The following warning labels appear on the sewing machine.
Please follow the instructions on the labels at all times when using the machine. If the labels have been
removed or are difficult to read, please contact your nearest Brother dealer.

may resulit.

1 Safety devices: Finger guard, Belt cover, etc.
A\ CAUTION
Moving parts
may cause injury.
Operate with safety devices.
turn off main switch before
changing needle, cleaning
etc.

2
ADANGER | AGEFAHR | A DANGER | A PELIGRO
Hazardous voltage | Hochspannung Un voltage non adapté Un voltaje inadecuado
will cause injury, verletzungsgefahr! | provoque des blessures. | puede provocar las

heridas.
Turn off main Vor Offnen des Pour ouvrir cette plaque,
switch and unplug Gehauses couper le contact Antes de abrir esta
power cord before Hauptschalter general de la machine tapa, desconecte la
opening this cover. | ausschalten und et debrancher le cable maquina y
Netzstecker ziehen! | d’alimentation. desenchufela de la red.
3
A CAUTION | A ACHTUNG | A ATTENTION| A ATENCION
o Table may Der Tisch kann | Vous risquez La mesa se
be damaged. | beschadigt d’endommager | puede dafiar.
werden. la table.
\ / Do not get on| Nicht auf den | No montez pas | No pise la
the table. Tisch stehen. | sur la table. mesa.

4 Never touch or push the thread 5 Never touch or push the
take up during operation as it needle bar during operation
may result in injuries machine. as it may result in injuries or

damage to the sewing ma-
chine.

6 Direction of operation 7 Py ——

CE rmvmE=R
CAUTION
Do not touch this part during activitation or
for 30 minutes after shut-off. Otherwise burns
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Procedure of Reading This Manual

Explanation of models

This manual explains two models:
- BES-962BC (9 needles)
- BES-1262BC (12 needles)

Explanation for individual model is provided by identifying the model name. Check
the model before using the machine. The display is BES-1262BC.

Configuration of this manual

This manual consists of the following chapters:

Chapter 1 An Introduction of Embroidery Machine

Provides information on the specifications of the embroidery machine, software
installation environment, and basic software operations.

Chapter 2 Preparation of Embroidery Machine

Describes machine installation and preparation to be conducted before starting
embroidering operation.

Chapter 3 Embroidering Procedures
Provides explanations on the operation panel and briefly reviews the flow of

embroidering processes.

Chapter 4  Selecting and Transferring Embroidery Data
Explains how to use the Embroidery Data Explorer.

Chapter 5 Editing Embroidery Data
Explains how to use the Embroidery Data Editor.

Chapter 6 Embroidering
Explains how to use the Machine Controller.

Chapter 7  Operation of Machine
Provides information on machine operation during embroidering.

Chapter 8  Creating Production Report
Explains how to use the production report program.
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Chapter 9 Maintenance
Describes appropriate maintenance of the machine.

Chapter 10 Adjustment
Explains how to adjust the needles.

Chapter 11  List of Error Codes
Provides information on error codes and action to be taken.

Chapter 12 Troubleshooting
Provides troubleshooting for the machine.

Connection and Installation of Optional Equipment

Describes connections between the machine/computer and optional equipment
available.
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Chapter 1 An Introduction of Embroidery Machine

1. Specifications

Embroidery machine used

9 needle embroidery machine head | 12 needle embroidery machine head
(six-head type) (six-head type)

Application

Pattern embroidery

Sewing speed

Maximum 1000 rpm

Distance between heads

400 mm

Maximum feed range

450 (V) x 420 (H) mm (With all heads)
450 (V) x 500 (H) mm (With every other head)
95 (V) x 360 (H) mm (With cap frame)

Sewing area

450 (V) x 420 (H) mm (With sash frame and all heads)

430 (V) x 300 (H) mm (With maximum-size tubular square hoop/flat hoop and all heads)
85 (V) x 360 (H) mm (With cap frame)

450 (V) x 500 (H) mm (With sash frame/flat hoop and every other head)

Feed system

By timing belt and stepping motor drive

Stitch length

0.1 ~12.7 mm (minimum pitch: 0.1 mm)

Storage medium

3.5 2DD floppy disk (Tajima format)

Paper tape with 25.4 mm width/8 holes (Tajima, Barudan, Zanks)
3.5 2HD floppy disk (the equivalent to Tajima format)

3.5 2DD floppy disk (Barudan FDR/FMC format)

3.5 2DD floppy disk (ZSK format)

Thread trimming

Automatic thread trimmer

Needle thread breakage

Needle thread breakage detector

Power supply

Single phase 200 V, 50/60 Hz, 1.7kVA

Weight 720 kg
. . (Before assembly) 3650 (W) x 810 (L) x 1650 (H) mm
Dimensions (Leg height) 1310 mm
(After setup) 3650 (W) x 1400 (L) x 1650 (H) mm
: Embroidery hoops in different sizes, Bobbin winder,
Options

Parts for boring

Fluorescent lamp

Option Standard

16
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2. Software

2-1 Necessary Systems

The following systems are needed for installing the software.

« Personal computer with a CPU of Intel Pentium 133 MHz or above
(150 MHz or above is recommended.)

* Memory of 16 MB or above (32 MB or above is recommended.)

* Free space of 100 MB or above in the hard disk

3.5 floppy disk drive

* CD-ROM drive

* Video card of 1024 x 768 resolution in 256 colors
(1280 x 1024 in 65000 colors is recommended.)

* Windows 95

2-2 Configuration of Software

This software is mainly composed of the following four programs. The software is
provided on CD-R.

(1)
(@)
(3)
(4)

Embroidery Machine Controller
Embroidery Data Explorer
Embroidery Data Editor
Production Report

Program Functions

(1)

(2)

3)

(4)

Machine Controller

This program controls embroidering operation of the machine.

A embroidering status can be displayed on the screen in real time, and data for
operating the machine can be set.

Embroidery Data Explorer

This program handles files of embroidery data on patterns.

Transmission of embroidery data to the machine, as well as copy, move and
retrieval of a file are available by means of this program. Embroidery data can
be converted from the paper tape or floppy disk.

Embroidery Data Editor
This program allows editing of data on embroidering operation including scaling,
rotation, color change, etc.

Production Report

This program is for collecting data on actual embroidering operation and
calculating output, etc.
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Relationship among Programs

When the software is started, the program (1) for actuating the machine starts first.
Next, embroidery data is called by the program (2). Use the program (3), when
required, for editing and embroidering. The embroidery data is totaled by the

program (4).

The programs (2), (3), and (4) can be started from the menu of the program (1).

Each program can also be started independently.

(2
Embroidery
Data Explorer

N &
\\ )
TSy Zz=Z

(1)
Machine
Controller

(4)
Production
report

2-3 Notes on use

Effective only when this is
independently started

T |
Embroidery

Data Editor

» Do not start other application software while the machine controller is used.

» Do not set the screen saver.

To cancel setting, select the "Screen saver" on the "Control panel” screen and

set "Not used".

» Set the computer not to use the system agent included in the Windows 95 PLUS!.

2-4 Help

The software is equipped with an on-line help function as an accessory.
Click El , then the icon of the desired item. A message is displayed to explain the
meaning and usage of the item. Pressing the [F1] key brings up the help screen of

the application for your reference.
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2-5 Basic Operation of Software

This section explains the basics of using the software. It covers only the operating
procedures that are commonly used for the software. If there are any special
operating procedures inherent to a program, they are explained in each section.

How to Use the Mouse

When selecting an icon or a menu displayed on the screen, move the white arrow
pointer on the screen to the required position, then press the button on the mouse.

B Ei Chegn e B

ZFid QG Al 0] @I6H 82 D 0F) Sk P W)

L2
Fliow the ankroideny dts horimntalke

Place the mouse on a flat, smooth surface and move it by sliding on it. The white
arrow pointer moves along the mouse motion.

The mouse has two buttons. The left one is used in general. There are three ways
of operating the mouse button as described below:

H Click
Press the left button of the mouse once.
"Click [xx]" means moving the white arrow pointer to "xx" and pressing the left
button once.
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H Double-click
Press the left mouse button twice continuously. Do not leave a long pause in
between.
"Double-click [xx]" means moving the white arrow pointer to "xx" and pressing
the left button twice continuously.

|

H Drag
Move the mouse while holding down the left button.
Dragging is used for defining an area.

7
W,
K2
L2
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Names of Screen Components
Names of major components on the screen of the machine controller are described
below:

or -
we Tool Settings Window Help

Tool bar Q 513 : EEIlEl @J@l &@lEﬂlVlmﬁ | 7 W?”

an Basket.ecs Border (A1)
16400-800) Speed Orpm 110dee.
=|
Dimmed icons cannot Upward
be used unless an movement
appropriate item is
selected.
croll bar ———
Downward
movement
1.
| o
or mal peration i
|T Help, press F1 |DISCONNECT | [l |
Leftward movement Status bar Rightward movement
H Menu

Processing of software is carried out by giving relative commands.
Commands are divided in groups and stored in each menu. The menu displayed
on the screen changes depending on the program which is currently active.

H Tool bar
A command is executed by clicking a relative icon (illustrated button) on the
screen. Ifitis hard to recognize icons from illustrations, move the white arrow
pointer to the icon. The name of the icon is displayed.

H Scroll bar, scroll box, and scroll arrow
Some patterns may not be displayed entirely on the screen. Use the scroll bar to
see hidden parts of the pattern into view.
When displaying the right part, for example, click the scroll arrow at the right end.
The box in the scroll bar moves to the right. By dragging the scroll box to the
right, the screen can scroll quickly.
The vertical scroll bar can be used in the same way.

Bl Status bar
This bar is for displaying a brief description of the selected command.
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Selection of Menu

Processing of software is carried out by giving a command. A command can be
given by the mouse as described below:

1. Move the arrow pointer to a menu name and click there.

1 Wiew Tool gettilﬁ\gs Windc

o
——
o—

=14

P

2. Alist of commands is displayed. Click the required command.
o ____________________|

LG Vindow  Help Dimmed commands

| ’ E|V|EE|| . g: cannot be used unless
| Pause » e, an appropriate item is

Speed Range selected.
! Head Operation Suspend
' Hoop Feed Position

Embraidery Area

Embroidery Hoop

Thread Trimming

[+ Tubulsr G810
Tubular (1,357

Boring

. Thread Breakage Sensor Flat (1,35)

. Automatic Step Back Eorder (2112
Automatic Hoop Feed Border (1,35) Commands with a » mark
End of embraidery Wfide Cap G
Mending Semi—wide Cap (A10 have sub menus.

. Adjust

| Activating speed up of driving shaft

. Activate escape with pause.

| Short stitch speed reduction.

|

| Thin ane ¢ thick one

i Area Trace 3
i

Default Settings

" Show Setting
Load Setting
Save Setting
Load Hoop

The check mark (v)
indicates that the
command is selected.

When the arrow pointer is moved to another menu while a list of commands is displayed, those
of the latter menu are displayed.

Messages and symbols

Some messages to be displayed on a computer screen may contain the following
symbols. These are the symbols for Windows; therefore, they are different from the
symbols described in "SAFETY INSTRUCTIONS" on page 1.

@ Information: This symbol indicates the information on the result of an
operation.

& Warning:  This symbol indicates a warning if user's judgment is needed
to continue the current operation.

Q Important:  This symbol indicates a problem if it occurs.
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2-6. Handling of floppy disk

Do not force open the shutter for
direct contact with the magnetic
area.

Do not store floppy disks in an
extremely high or low ambient
temperature.

Do not use or store floppy disks in a
dusty place.
Do not place it on cloth.

ems e o a
o S
. .
.

Do not bend the disk. Do not put
things on the disk.

Store it in the case immediately after
using it to protect it from dust and

damage.

Do not bring disks near magnetic
matters such as magnetic
screwdriver or the back side of the
programmer.

EO

Do not use floppy disks under high
humidity.

c d D
4 ‘ R )
I l :-'

Do not store floppy disks under
direct sunlight.

B%!

Avoid contact with solvent or drink.

’
v
d

Use a commercially available
cleaning disk to clean the head of
the floppy disk drive periodically.

Do not remove the disk out of the drive during the access lamp is lit.
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24

Protecting data in floppy disks
Write-protection is available for a floppy disk to prevent undesired data deletion.
A write-protected disk is read-only. It is recommended to provide write-protection

for disks which contain important data.
To do so, slide the write-protect notch to open the slot as shown below.

Slide the notch in this direction to
prevent data loss or overwriting.

Slide the notch in this direction to write
data.
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1. Names of Machine Components

W BES-962BC

Rear

Thread tension ‘Q
switch .
Thread />TIT1:‘eaddguu?: Bc
A =S
— =
SR —
\Z Fluorescent
lamp
Fluorescen i ———
lamp switch -—’
1‘ i /
Control bo | BIQ =
Power switc @\bﬁ
F table
Head switc
Leg Y J/g
Hl BES-1262BC
Rear

; switch
Operation pane}—\ Thread guide B

Thread tension dia Thread .
guide A ﬁThread guide C ’g@
Cotton stand F '
/ S

Fluorescent

—
I A

== —

Wi@

Sisisist

-

lamp switch —— = \ —
L =
i |
N - —
Control b:—ﬁ BQ D
Power switc ‘&\bﬁ %
F table T
Head switch
Leg A J/g

The machine heads are humbered 1 to 6 from the right front.
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2. Installation

A DANGER

© @@ O

Embroidery machines should be installed only
by trained engineers.

Electric wiring should be laid by your distribu-
tor or electric experts.

The sewing machine weighs more than 720 kg.
The installation should be carried out by a lift
or a crane.

Do not connect the power source until installa-
tion is completed. Doing so may start the ma-
chine unintentionally through an accidental
activation of the START switch, resulting in
bodily injuries.

o

Install a machine in a place away from a high-
frequency welding machine or other machines
that may generate a strong electric noise. Fail-
ure to do so may cause the embroidery machine
to malfunction.

Be sure to connect the ground. If the ground
connection is not secure, you run a high risk of
receiving a serious electric shock, and problems
with correct operation may also occur.

Secure the machine with the adjustment bolts
on the sound floor so that it will not move .

* After installation is completed, get the power supply from a dedicated outlet.
* When connecting multiple machines, exercise care not to exceed the capacity of the outlet.

2-1 Transportation of Machine

When relocating the machine, push the steel frame.
Note) Never push the cover or carriage.

B When using a fork lift

(37

’ The central sea

Lift fork

Viewing the machine from the back, position their center at the central seal, insert the forks
under the legs and lift the machine.
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l When using a crane

L-shaped stee

Rectangular ba

Place two rectangular bars on the four L-shaped steels on the bottom of the machine steel
frame. Loop four ropes around the bars and lift the machine.
Note) When lifting the machine, make sure that the ropes do not contact the machine table or the tension plate.
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2-2 Installation of Machine

—
"

3]

Place an adjustment bolt base @, a rubber
cushion 10 © (provided with the machine),
and PE sheet @ under each of four
adjustment bolts M20 @. The adjustment
bolt base must be on the rubber cushion.

Fit four adjustment bolts M20 @ into the
conical dents of adjustment bolt bases O,
and adjust the embroidery machine in
height.

The adjustment must be made in such a
manner that the four bolts are under an
equal load when the machine is placed
down. (To lower adjustment bolt M20 @,
turn it in the direction of the arrow.)

Also, the casters should be raised by
several millimeters.

After adjusting four adjustment bolts M20

©, turn nuts M20 @ in the direction of the

arrow to fasten them.

Note) If the floor is not strong enough, the embroi-
dery machine may be rocked during opera-
tion. In such a case, it is recommended that a

secure base of concrete be placed below the
embroidery machine.
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2-3 Preparation of Needle Bar Case

l BES-962BC

FOED T T DT T D L - - - - L2 - - - E—

T

1. Loosen the bolt @ and set screw @, and move the needle case @ to the left.

2. Press the change bracket collar @ against the change case base @ on the light, while pressing
the change bracket collar @ against the change case base @ on the left, and tighten the bolt
© and set screw (. Check that needles at needle bar No.1 and 9 are inserted into the needle
plate holes smoothly.

Notes) - Check that the connecting shaft @ does not have backlash in the horizontal direction.

« Never loose the bolt @ of the change bracket coller @. If this bolt is loosened, the change bracket
coller @ will be dislocated and the position of the needle bar case @ will need to be adjusted.
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H BES-1262BC

Connecting shaft
Fixing bracket
ixing bracket B

o T T
el i N

o
IV iy A s == =
c)o‘oooooooooooo 9( //o @@
(7] \
(8]

o bfothef o }

e |
T °

1. Remove 3 pieces of fixing screw @, loosen 2 pieces of screw @ and remove the color change
cover ©.

2. Remove the bolts @ and detach the fixing bracket for transportation from the bridge and the
connecting shaft.

3. Loosen the bolts @ and set screw (I, and move the needle bar case @ left side.

4. Press the change bracket collar @ against the change case base @, while pressing the left
side change bracket collar @ against the change case base @, and tighten the bolts @ and
set screw (0. Check that needle bar No.1 and 12 are inserted into the needle plate holes
smoothly.

Notes) -+ Check that ther is no play for the connecting shaft in the horizontal direction.

« Never loose the bolt of the change bracket coller @. If this bolt is loosened, the change bracket coller
O will be dislocated and the position of the needle bar case @ will need to be adjusted.

5. Attach the color change cover © by 3 pieces of fixing screw @ and 2 pieces of fixing screw @.
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2-4 Mounting of Table

H Preparation for mounting the F table

1. Tentatively mount the F table guides UN @ and L @ on both sides of the legs using two bolts
each.

2. Tentatively mount three F table supports F © on the leg front using two bolts each.

3. Tentatively mount eight F table stoppers O on the rear legs using two bolts each.
Notes) - The steps 1 and 3 are required only when the F table set is purchased separately from the machine.
- The F table is a standard attachment.
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H For embroidering with tubular square hoop (middle position)

Lower by 1 mm

1. Attach four hexagon socket head cap screws to each of F table parts R @, M (2 pcs) @, and
L © from the back.

2. Mount the F table parts from L © in order. Insert the bent part (lower) of F table guide UN O
into the guide. Insert the F table rear pin into the hole of F table stopper N @.

3. Adjust F table supports F @ in height so as to make the F table parallel with the floor.

4. Tighten all hexagon socket head cap screws @ firmly.
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H For embroidering with cap frame (lower position)

:

—O0

Note) If the F table is kept at the height adjusted for embroidering with tubular square hoop, the cap frame may
interfere with the table. Lower the table by one level in this instance.

1. Attach four hexagon socket head cap screws to each of F table parts R @, M (2 pcs) @, and
L © from the back.

2. Mount the F table parts from L © in order. Insert the bent part (lower) of F table guide L @
into the guide. Insert the F table rear pin into the hole of F table stopper N @.

3. Adjust F table supports F @ in height so as to make the F table parallel with the floor.

4. Tighten all hexagon socket head cap screws @ firmly.
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H For embroidering with flat hoop/sash frame (upper position)

Pin

1. Attach four hexagon socket head cap screws to each of F table parts R @, M (2 pcs) O, and
L © from the back.

2. Mount the F table parts from L @ in order. Insert the bent part (upper) of F table guide UN @
into the guide. Insert the F table rear pin into the hole of leg cover @.

3. Adjust F table supports F @ in height so as to make the F table lower than the bed top by 1 mm.
4. Tighten all hexagon socket head cap screws firmly.

5. Attach five thumb bolts to the lower front steel pipe of the leg section. Fasten the F table and
the leg section using F table stays A (3 pcs) @ and B (2 pcs) ©.

H Procedure for embroidering with flat hoop/sash frame and every other head

Only the odd-numbered heads are operated for embroidering with flat hoop/sash frame.
Embroidering is possible within an area up to 500 mm in the X-axis direction.

1. Set the needle bar case in the needle bar No. 1 position. Remove the presser feet.

2. Select a flat hoop (sash frame) for every other head operation.
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2-5 Mounting of Cotton Stand

l BES-962BC

Thread guide C

Thread guide B

Thread guide A

()
0
a
@m\
)

1. Attach four thread guide support bars @ to the cotton stand assembly @, while fitting into
the four holes.

2. Mount the thread guide assembly © on the thread guide support bars @ using the four
screws 0.

Notes) - When mounting, use one flat washer @ below the thread guide support bar ©.
- Pay careful attention to the front and back directions of the thread guides (A, B, C).
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l BES-1262BC

(3]
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Thread guide
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Thread guide B
Thread guide A
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1. Attach four thread guide support bars @ to the cotton stand assembly @, while fitting into
the four holes.

2. Mount the thread guide assembly © on the thread guide support bars @ using the four
screws 0.

Notes) - When mounting, use one flat washer @ below the thread guide support bar ©.
- Pay careful attention to the front and back directions of the thread guides (A, B, C).
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2-6 Lubrication to Needle Bar Case

Proper lubrication is necessary for keeping the machine head in good condition.

A CAUTION

Turn off the power switch before starting any cleaning work, otherwise the machine may operate if the start
switch is pressed by mistake, which could result in injury.

Before operating the machine for the first
time after unpacking or after leaving the
machine without operation for a long
period of time, supply one or two drops of
oil to two sections at the top and the bottom
of each needle bar. (See the left figure.)

Notes) -+ Use the Brother's specified embroidery
machine oil (Nisseki Embroidery Lube No.
10 or the equivalent).

» Supplying an excessive amount of oil will
cause dripping onto the material.

BES-962BC

BES-1262BC
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2-7 Connection of Personal Computer to Machines (for connecting 4 sets)

Interface board

-
<
/
' (1st machine)

RC
cable
\ / 1 IF cable
\

Control bo

(2nd machine)

A CAUTION

Z
Before inserting or removing IF cables or RS %‘
cables, turn off the power switches of the

machine, the computer, and peripheral

equipment.
IF cable
(3rd machine)
E '
(4th machine)
Terminator
(Be sure to attach
? a terminator.)

1. Turn off the power switch.

2. Open the cover of the personal computer and insert an interface board into the slot for the
PCl bus.

3. Connect the interface board male connector and the personal computer RS-232C connector
(COM1 or RS-232C-1) using the attached short RS cable.
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4. Connect the interface board female connector and the control box connector SBUS1 of the
first machine using an IF cable.

5. Connect the control box connector SBUS2 of the first machine and the control box connector
SBUS1 of the second machine using an IF cable.

6. Connect the control box connector SBUS2 of the second machine and the control box
connector SBUS1 of the third machine using an IF cable.

7. Connect the control box connector SBUS2 of the third machine and the control box connector
SBUS1 of the forth machine using an IF cable.

8. Attach a terminator to the control box connector SBUS2 of the forth (last) machine.

* The IF cables used for connection are identical. There is no difference between the two ends
of the IF cable.

* The order of connecting four machines is arbitrary.
* The maximum number of connecting machines is four.

* A terminator should be connected to the connector SBUS2 of the lastly connected machine.
Connection to SBUS1, 2 can be interchangeable.

* Do not connect anything to the RS-232C connector.
Optional paper tape reader cannot be connected to this connector.
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2-8 Connection of Power Supply

H Uninterruptive power supply

This unit is for protecting a personal computer
from commercial power interruption, voltage
drop, and external noise. Use of an
uninterruptive power supply is strongly
recommended.

Note) This unit is not an attachment of the Brother's
embroidery machine, and should be pur-
chased separately from a different source.

Uninterruptiv
power supply

Note) When using an uninterruptive power supply,
be sure to establish grounding.

(S
[Q~\/

Grounding cable

H Grounding

A CAUTION

Turn off the power switch before starting preparation.

Failure to do so may start the machine unintentionally through an accidental activation of the START switch,
resulting in bodily injuries.

Notes) - When connecting the power supply, make
sure to connect it to the grounding cable
(with green and yellow stripes) .

» When plugging in the outlet, use a plug
suited to the outlet.

Grounding
cable
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2-9 Installation of Software

Use an attached CD-R for installing software. If a personal computer with no CD-R drive unit is
used, connect a drive unit to the computer.

1. Set the CD-R for installation.

Setting the CD-R starts the installation program automatically.

2. Select the language and click "Next".
Note) When the software has already been installed, the following message appears.
[In case this aplication is already installed, please be sure to un-install it.]

Un-install the software.

Chooze the language af the installation:

& Ergish
i~ Japanese

< Back I Hext » I Cancel |

3. The screen for user registration is displayed. Input your name and department. Click [OK]
after inputting is finished.

4. Check the user information. Click [OK] if the contents are correct.
5. Specify a folder for setup.

6. Click [TO NEXT] to start installation.

Installing Brother Embroidery Software

7. After setup is properly finished, a message is displayed.

8. Click [OK] to complete installation.
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3. Preparation for Embroidering

A CAUTION

Turn off the power switch before starting preparation.
Failure to do so may start the machine unintentionally through an accidental activation of the START switch,

resulting in bodily injuries.

3-1 Upper Threading

l BES-962BC
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OThread guide

@Thread guide A
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@Thread guide A ©Lower thread

guide

S

OLower thread
guide

ONeedle bar
thread guide

Pass an upper thread from the cotton stand through the hole of the thread guide right above
each cotton stand bar. Pass the thread from the back to the front hole.

Pass the thread through the upper hole of the pretension. Push up the thread guide tension
disc @ with your finger, and pass it from the left to the lower hole.
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Pass the thread through the upper hole of the 2nd pretension. Push up the thread guide
tension disc with your finger, and pass it from the left to the lower hole. Wind the thread
clockwise twice around thread breakage pulley ©.

Pass the thread through the hole of upper thread guide(upper) @. Wind the thread clockwise
once around the rotary tension disc and place it on the spring.

Pass the thread through each hole of upper thread guide(middle) @ and thread guide Q.
After passing the thread through the hole of thread guide @, insert the thread into the right
side of the inner thread guide and pass it through the hole of the thread take-up.

Bring the thread back to the inner thread guide. Insert the thread into the hole from the upper
section into thread guide A @.

Pass the thread through the hole of the needle bar thread guide @ and pass it through the
needle eye. Do not pass it through the presser foot. Pass it to presser spring at the front of
lower thread guide ©.

H BES-1262BC
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OUpper thread — o \

guide (upper) No.1,4,7,10

3

wiis
@u!llé[’l/;';/'f

.

@ Upper thread N\

guide (middle)

OThread guide

DAY, 22 N
YL =3
0 —

DAL AN A A A% Ll
@4: LY
\) ‘ko‘ )i <)

=
@Lower thread : \ ‘0/\0\ o

guide \\

\

N

@Thread guide A

J

@Thread
guide A

[*]

ONeedle bar
thread guide
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Chapter 2 Preparation of Embroidery Machine

1.

Pass an upper thread from the cotton stand through the hole of the thread guide right above
each cotton stand bar. Pass the thread from the back to the front hole.

The cotton stand (top view)

OO0O0O 01209 06 O3

O00O0 O11 08 05 02 Pass a thread in the order
indicated in the figure.

O0O0O0 010 07 04 O1

Front

Pass the thread through the upper hole of the pretension. Push up the thread guide tension
disc @ with your finger, and pass it from the left to the lower hole.

Pass the thread through the upper hole of the 2nd pretension. Push up the thread guide
tension disc with your finger, and pass it from the left to the lower hole. Wind the thread
clockwise twice around thread breakage pulley ©.

Pass the thread through the hole of upper thread guide(upper) @. Wind the thread clockwise
once around the rotary tension disc and place it on the spring.

Pass the thread through each hole of upper thread guide(middle) @ and thread guide Q.
After passing the thread through the hole of thread guide 6, insert the thread into the right
side of the inner thread guide and pass it through the hole of the thread take-up.

Bring the thread back to the inner thread guide. Insert the thread into the hole from the upper
section into thread guide A @.

Pass the thread through the hole of the needle bar thread guide @ and pass it through the
needle eye. Do not pass it through the presser foot. Pass it to presser spring at the front of
lower thread guide ©.
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3-2 Replacement of Bobbin

Note) Remove dust, lint and oil from the bobbin case before replacement.

H Removing bobbin case

H Replacing bobbin

Pull out by abou
50 mm

Open the rotary hook cover B @.

Hold the knob @ and take out the bobbin
case.

Close the knob and take out the bobbin ©.

Put a new bobbin in the bobbin case.
Check the winding direction.

Check that the bobbin is pushed out of the bobbin case
by about 0.5 mm. If not, the slip prevention spring of the
bobbin case does not work. Adjust the height of the
spring or replace it with a new one.

Bobbin

# 0.5mm

Slide the thread under the tension spring
O through the notch O.

Pull out the thread from the hole of the
tension spring ©.

Pull out the thread by about 50 mm.
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H Attaching bobbin case

* Relationship between materials and needles

Material Needle Needle thickness
Denim #14,
Leather #16, #18
Handkerchief DB x K5 #9, #10
Shirt #11,
Towel #12, #13

1. Hold the knob @ and attach the bobbin
case securely.

2. Close the rotary hook cover B ©.

H Removing needle

Loosen the set screw @ and remove the needle

H Attaching needle

With the flat side facing the front, insert the
needle all the way until it meets the end of the
needle bar. Tighten the set screw @ firmly.

Note) - Set the needle so that the notched part will
come on the rotary hook side.

- The needle should not be angled to the left
(when viewed from the front).

H Selecting needle

« When using special threads such as gold,
silver, and rame yarn, use a heavy-duty
needle (#11 ~ #16). For better finish, paste
the waxed paper on the back of the
material.

 In general, use DBxK5 #11 ~ #18 according
to the material thickness. For knitted
materials, use DBxK23 #11 because its
rounded point prevents the knit thread from
breaking.
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3-4 Attachment of Embroidery Hoop and Frame

M Tubular square hoop

1. Insert the fixing pins of the tubular round arms R @ and L @ into the notches of the X-axis
feed frame @. Slide the arm to the right and left and lower the fixing lever O to fix them.

2. Set the right and left fixtures of the tubular square hoop @ while sliding them under the flat
spring @ upward. Then fit the frame projecting part @ into the hole of the tubular square
hoop @ securely.
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Chapter 2 Preparation of Embroidery Machine

- By changing the tubular round arm mounting width, various sizes can be set.
Note) Change the width, referring to the pin position.

Note) If two pins cannot be inserted, remove one.

« If a tubular round arm has a backlash:
Follow these steps for adjustment:

1. Move the end of the tubular round arm to
the left.

0

|
<@ ]

2. If a clearance is left as shown in the figure,
loosen screw @ and adjust the tubular
round arm support so as to eliminate the
clearance between the support and the X-
feed frame. Tighten screw @.

Tubular round
arm support

* Follow the same steps when moving the

end face of a tubular round arm to the right.
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« If tubular round arms are not in a horizontal position:

Follow these steps for adjustment:

50

If the tubular round arms cannot be setin a
horizontal position (inclined) because of
the weight of fabrics, make an adjustment
using roller spacers in the following steps.
(Four roller spacers are inserted before
shipment.)

Loosen bolts @ of X roller base @ and
remove roller spacers ©.

Insert a proper number of roller spacers ©
between X roller base @ and X-feed frame
N O. Tighten bolts ©.

Note) When tightening bolts @, press X roller base
© against X-feed frame N @ and leave no
backlash in between.

For the other roller spacers, follow the
above steps.

Note) Use the same number of roller spacers in ev-
ery position.
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Chapter 2 Preparation of Embroidery Machine

H Holder base (optional)

Do not remove
these screws.

Attaching the holder base frame

1. Set the table. (Refer to "2-4 Mounting of Table" (Page 32) for details.)

2. Insert the frame connecting plate F @ into the holder base frame LN @, holder base frame CN
@, and holder base frame RN @, using bolts and washers.

3. Remove four bolts @ from the front of X-feed frame @. Attach one each of square nut M6 @
to the right and left sides at the front.
At the rear of the frame, attach three each of square nuts M6 @ to the right and left sides.

4. Put frame connecting plates RN @ and LN © on X-feed frame @. Fix them with bolts and
washers.

5. Check that the clearance between the table and the mounted holder base frame C assembly
@ is even when viewed from the machine front.

[Adjustment] Loosen three bolts of the F table support F 0 and move it in the direction of the arrow for adjust-
ment.
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Check that the clearance between the Y-axis cover ® and the mounted holder base frames
LN @ and RN © is even when viewed from the right and left sides.

[Adjustment] Loosen the right and left bolts of the F table guide UN (B and move it in the direction of arrow for
adjustment.

Tighten each bolt securely after adjustment is finished.

If removing a holder base frame for frame replacement, etc., remove screw ®.

Keep the frame connecting plate attached to the X-feed frame.

Attaching the holder base

Mount the holder base mounting frame @ on the X-axis feed frame @ and holder base frame
C 0, using three clamp screws.

When the mounting pitch of the holder base is 370 mm, mount the holder base horizontally to
the holder base mounting frames € using the thumb bolts ©.

52
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3. When the mounting pitch of the holder base is 550 mm, mount the holder base vertically to
the X-axis feed frame @ and holder base frame C @ using the thumb bolts @.

\ o

|
"
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H Sash frame (optional)

Attaching the sash frame

1. Set the table. (Refer to "2-4 Mounting of Table" (Page 32) for details.)

2. Mount two vertical sash frames @ on the holder base frames L and R, and two horizontal
sash frames @ on the X-axis feed frame @ and the holder base frame C @, using the screws.

3. Set the material. Then, set sixteen sash clips 290 @ horizontally on the upper and lower
sides, four sash clips 220 @ vertically on the left and right sides.
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3-5 Adjustment of Thread Tension

B Adjustment of upper thread
Adjust upper thread tension to 0.7~1.3N when
the thread is pulled at the needle bar thread
guide.
Upper stitch * Correct adjustment
width Turn the upper thread tension dial so that the
| ~— Upper needle thread can be pulled to the back of the
thread material and that the lower stitch width will be
U/ 72227 about 1/3 of the upper stitch width.
Lower
thread
= Lower
stitch
width

H Adjustment of tension spring

/
o
o
&
—
0.07~0.12N

1. The tension spring should be adjusted to 6~8 mm in height and 0.07~0.12 N in force.
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2. For adjusting the height, loosen the screw @ and turn the tension spring bracket ©.

3. For adjusting the tension spring force, insert a driver tip in the groove of the thread tension
bar © and turn it.

M Lower thread tension

The standard tension of the lower thread is
0.15~ 0.3N.

This tension may vary depending on the used
thread. In general, press the bobbin case to a
\ - smooth vertical surface and hang the
designated number of coins. Turn the thread
tension screw so that the lower thread will come
out smoothly.

Note) Check that the bobbin is pushed out of the

g rans

“ bobbin case by about 0.5 mm. If not, the slip
%% prevention spring of the bobbin case does not
— work. Adjust the spring in height or replace it
with a new one. (Refer to “Replacing Bob-

To tighten bin” on page 46.)

To loosen
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Chapter 3
Embroidering Procedures

After installation of machine and setting-up
of the personal computer (PC), start embroi-
dering. This chapter explains about the op-
eration panel on the machine as well as pre-
cautions for the actual embroidering process.
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Functions of Operation Panel

Operation Panel

BROTHER
EMBROIDERY
SYSTEM brother Bes-1262BC

(OPOWER

(O READY < ET’

i3

START

Starts embroidering.

Restarts after moving the carriage to embroidering start position by using the jog switch.

Restarts embroidering after a suspension.

\B\t‘

STOP

Cancels errors during embroidering.

Exits from the embroidering mode. Hold down switch and press LN switch.

sToP

Suspends embroidering.

Trims thread during suspension.
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=

Checks the embroidering area.

Exits from embroidering mode. Press this switch while holding down ;!:33 switch
simultaneously to stop embroidering.

Moves the hoop automatically when embroidering position is out of the embroidering area.

Sets the machine to the inching mode when this switch is pressed during suspension.

Moves the hoop to software-set position. When this switch is pressed again, the hoop
returns to the previous position.

=intd

Moves the needle bar. The needle moves by the diameter every time this switch is pressed.

<1 D
V

\ J

Moves the hoop.

Step-back or forward is available during suspension, by one stitch every time the switch
is pressed (Use <][> switches only.)

Changes the speed range during embroidering (Use A/ switches only).

Carries out inching of the hoop when the switch is pressed in the inching mode (
appears on the panel).

H Canceling errors

Ly switch.

STOP

When an error message appears, it is canceled by pressing
Pressing other switches can stop alarm sound.

When thread breakage or wiper out error has occurred, step-back or forward
switch can be used to cancel errors.
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Switches at Machine Heads

BES-962BC

STOP

[==oN

ﬁ@‘%ﬁ

H Stop switch

Stops embroidering operation. When embroidering is stopped,

Start switch

Stop switch

BES-1262BC

Between head No.1 and No.2
Between head No.3 and No.4
Between head No.5 and No.6

STOP
(=

é;e\@(%} —— Stop switch

Between head No.2 and No.3
Between head No.4 and No.5

Start switch

5 /: I} /3 flashes.

Refer to "Resetting Machine Stop" (— page 191) to stop flashing.

B Start switch

Starts embroidering. Holding down this button executes embroidering at a low speed.
When resuming embroidering after stop switch, release machine stop before
pressing this button. Refer to "Resetting Machine Stop" (— page 191) for details.

Switches on Tension Plate

60
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BES-962BC

THREAD SENSOR lamp

HEAD switch
MENDING lamp

MENDING switch

STEP BACK/FWD switch
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l THREAD SENSOR lamp
When red light is on, thread breakage sensor is functioning. When the light is off,
the sensor is not effective. When the embroidery machine stops due to thread
breakage, the lamp flashes.

H HEAD switch
When it is set to ON, needle bar on the head moves for embroidering. When it is
set to OFF, the needle bar does not move for embroidering.

Hl MENDING lamp
This lamp lights up when the embroidery machine is in the mending mode.

l MENDING switch
This switch is set to ON to drive or to suspend the machine head during
embroidering for a designated period of time.

l STEP BACK/FWD switch

When it is turned to BACK, the machine steps back. When it is turned to FWD,
the machine steps forward. If you keep the switch turned for a while, the machine
will continue stepping even after you let the switch alone. When it is turned to the
opposite side, the machine stops.

During timing adjustment of the rotary hook in the test mode, the rotary hook
slightly rotates to the left/right when this switch is turned to left/right respectively.
Refer to "Adjustment of timing Between Needle and Rotary Hook" (— page 238)
for further details.
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Flowchart of Preparation for Embroidering

62

Run PC.

v

Run software (— page 63).

v

Turn on the machine power. (— page 63).

Register the machine name for initial start-up (— page 64).

v

Retrieve the embroidery data by using explorer (— page 64).

"Chapter 4 Selecting and Transferring Embroidery Data" (— page 67)

Edit the retrieved embroidery data.

v

"Chapter 5 Editing Embroidery Data" (— page 93)

Click Ui of the machine controller.

v

Press on the operation panel.

v

Press|!? | on the operation panel.

START
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Run the Software

1. Select [Program] - [Brother Embroidery System] - [Ecsc] from the Start

menu.
The software starts up.

Turn on the Machine Power

1. Turn on the power to the machine.

t
e

®

Reset the emergency stop button.

@

3. Turn on the power switch.

4. The computer screen changes when the machine is turned on.

Mockie fpwaton S Jool Sutigs Bk B
0 ' A

Fabbpamft st [ [ [
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Register the Machine Name

Enter the machine name if the software is run for the first time or when a new
machine is connected.

1. Enter a machine name.

Mew Machine Mame Setting

Enter a new name for embroidery machine Select an identifying color for the

(50 characters max) machine.
== This color is shown on the title
Brother MNe.1 | vl )
rother 1o - bar for a while when the arrow

pointer is moved to the title bar
of a machine window.

2. Click [OK].

Retrieve the Embroidery Data

1. Click .

The embroidery data explorer starts up.

2. Double-click the desired data or click %l after clicking the desired data.

2 > = Embroidery Data Explorer
File Edit “iew Tool Help

ok|X| B3|

---aSend
= o
+- =) D¥
EE=1="

4. Click f .

The data is transferred to the machine for preparation of embroidering.
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Start Embroidering
1. Check that the READY lamp on the machine operation panel is on.

(OPOWER

Y

@ READY

Y
2. Press to check the embroidering area.

3. Press ssTAﬁT to start embroidering.
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Chapter 4
Selecting and Transferring
Embroidery Data

Clicking 8 on the machine controller brings
up a screen which allows selecting or trans-
ference of registered embroidery data. Mov-
ing, copying, and deleting of embroidery data
can also be carried out on this screen.
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Functions (Command Reference)

File menu

New

Creates a new directory. (— page 70)

Exit of Selection

Transfers embroidery data to the machine controller. (— page 71)

X|I=

Exit Exits from embroidery data explorer.

Edit menu

Copy Copies the selected embroidery data. (— page 73)

Move Moves the selected embroidery data to a different directory. (— page 74)
Delete E Deletes the selected embroidery data. (— page 75)

Rename Renames the selected embroidery data. (— page 78)

A—B

Recreate an icon

Creates an icon of data for other models. (— page 76)

Select all Selects all the data. (— page 77)

View menu

Tool Bar Displays the tool bar.

Status Bar Displays the status bar.

List Displays embroidery data in the text form. (— page 81)
Image Displays the image of embroidery data. (— page 81)

Sort by Name

Soz IO
oIo

Sorts embroidery data by name (in the reverse order). (— page 81)

Sort by Stitches

G

Sorts embroidery data by the number of stitches in ascending order (in descending
order). (— page 81)

Sort by Colors

>
FTTT
mmm
=

Sorts embroidery data by the number of colors in ascending order (in descending
order). (— page 81)

Sort by Date

\u‘i’:

Sorts embroidery data by date in descending order (in ascending order). (— page 81)

Refresh Displays the latest data by updating the screen. (— page 81)
Tool menu
Find Files Retrieves files. (— page 79)

DST/DSB/DSZ — ECS Conversion

Reads DOS format data. (— page 82)

Non DOS (Barudan, ZSK...) Conversion

Reads non-DOS format data. (— page 84)

Tape — ECS Conversion

Reads data in paper tape. (— page 88)

ECS — DST Conversion

Converts ECS data to DST data. (— page 91)

Setup

Defines settings of data reading. (— page 90)

68
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Description of Screen

Sort by Stitches

Sort by Name

Copy Rename

Exit of Selection

Sort by Colors

Sort by Date Help

Information

X

|
E—E

X| BB

= I
OK

Tool bar

H-E A
=N
= RNR
== E¥
"{:I Temp
=00 brother BES-960BC
=0 APPS
{2 DATA

£
B
B
E

00o00002.ECS

BASKET.ECS

| v

Capfc.ecs

- dosdata
B MISC -
[ RECYCLED
-85 FY¥
B Q¥
ETHNIC.DST G001.03B G002.037
(ETHNIC) (ROSE) {HGteam)

Press F1 for He

}

=
[ [ [wom —71— Status bar

To display hierarchy of directories in PC
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of the data registered in the
selected directory
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Creating a Directory

Creates a new directory. A directory can be created within another directory.

1. Click and select a parent directory in the window on the left.

e -
T

ok| x| Bl ] e IR m B | R Ne

s AN =
5 & o
=N
S EEY
e Tamp
= EEEEEENE,
% ) AFPE g
= 01 DATA

£ BAMFLES
£0 sraiskiea

Tl Hab

Dt
) doscra

B IMIES
Y RECYCLED p
@ FY
= oy

Frazs Fi dr Hak Wi

2. Select [New] - [Folder] from File menu.

B8\ Untitled - Embroidery Data Explorer
RN Edit  “iew Tool Help

Exit off S=lection

Exit |
| --Q C¥ |—

3. Enter a new folder name.

Create a new folder in current

Current Folder: E¥brother BES-360BC¥

Falder Mame: ITESTI

0K I Cancel

4. Click [OK].

5. A new directory is added to the window.

B Bk Yan Tl tab

ok|X| BelEs| R e e i lmldin | 2l e

=@ AN =
5 CY
e
S S EF
e () Tamp
=0

[ [O1=]

% L0 AFPE
[ DATA
£3 saMPLES
£ meiktn

Fruas Fl 4 M
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Transferring data

Transfer registered embroidery data to the machine controller or Embroidery data editor.

1. Double-click data, or click data and OK| .
The explorer exits automatically after transferring the selected data.

kg

ok|X| B2|Ex

=]

= 0¥

-3 DY

EE=T1-

= Temp

=L brother BES-280BC
=0 APPS
w00 DATA
" TesT 00000002.£CS BASKET.ECS Capte.acs
:-£3 SAMPLES
(11 specialdata

-1 dosdata

- MISC

= |DST DSB

- Q¥

| B
Eom | ====} (][]

X

vaLYe

18 | w2

7

|+

1
2

BT BAG-I0

ETHNIC.DST G001.0SB G002.082
(ETHNIC) (ROSE) (HGrteam)

f; e . - =l
Press F1 for Help [ [uom 7

Transferring DST and DSB data

1. Double click DST or DSB data or click the data and click % .

2. The pattern image is displayed. To read the data, click [OK].

Create lcon

Cancel |
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3. Set the number of feeds for trim. Select the number of feeds or specify

the feed length for trimming and click [OK].
The data is transferred and the explorer ends automatically.

Ma. of times feed is performed befare thread trimming E

How many tirmes iz feed required to be performed
before thread trimming?

(N
12
¢ 8
4
15
L
»
L

¢ No thread trirmming

[~ Feed lenath for trimming

|20 3: i
Ok I Cancel

Transferring data on a network
1. Before starting the software, click [START] - [PROGRAM] - [EXPLORER].

N

Select [Map Network Drive] from Tool menu.
3. Select the desired drive and enter the path, and click [OK].

4. Exit from the explorer.

If no image appears:

If no image of embroidery data appears, select "Display Detail" on "Screen" of
the control panel to adjust display color.
Choose one of the following options, then restart PC.

* 256 colors

« High color (16 bits) Color paletts

. Select the display
* Full-color (24 bits)

color using "Color
Pallet".
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Copy

Copies embroidery data.

M Select from the menu or drag the data icon to the destination.

Select from Menu
1. Click data for selection.

2. Select [Copy] from Edit menu or click E3)|.

—
[FR view Tool Help

e ——

= Delete

. Eename
{ leon is made sgsin.
i | SalestALL

3. Select destination directory. Name copy data.

Save As n
Save in Iaecs j gl i

Data

demo

Log

temp
File name IBrDther BCS Save I
Sawe as fype IECS file (*ecs) LI Cancel |

4. Click [Savel.

Drag Data

1. Click data for selection.

2. Drag data to destination directory while pressing [Ctrl] key.

7

The pointer turns into . Release the mouse button when the directory name is inverted.

T Edh Yo

Teol Hab

i~ = = A 1% e
ok|X¢| BEs| mEE| 5 e 1alm e | 2R
@ A =
w @DV | e '.H’!
SEEV oo
o 0
= brothar BEE-Sa08C
® L) AFFE
# L DaTA
£3 SAMPLES 0onnonnz.Ecs BASKET.ECS Capfr.acs
2 spaciaickta
B
b sk s
CAMIEC
(2 RECYCLED
@ FY
) o
ETHNIC, DST HO01.05E GOECED
GETHNIC) [ROE) {H@rtaam]
DIAMT | SRR g
Fraaz Fi for Halp CIT')

3. Check that the copy destination directory is correct, then click [Yes].

Embroidery Data Explorer B

& OK to copy Diecs\DatalB_BASYAZ ecs to Dipictures\B_BASYAZ ecs?

Na |
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Moving Data

Moves embroidery data to a different directory.

M Select from the menu or drag the data icon to the destination.

Select from Menu

1. Click data for selection.

2. Select [Move] from Edit menu or click ‘3.

VRUBONTeSRT Mt Tt E a Si
: WERW View Tool Help

Copy

e —

| Bename
| lcon is made again
| Select ALL

3. Select the destination directory and click [Save].

Save As [ 7] x]

Savein Ia Becs j gl

Data

demo

Log

temp
File name: IErDther ecs Save |
Save as type: IECS file (* ecs) LI Cancel

Drag Data

1. Click data for selection.

2. Drag data to the destination directory.
The arrow pointer turns into @ . Release the mouse button when the directory name is inverted.

T Edh Yo

Teol Hab

A [ EEH A A e
ok| | BalEs| R EfeE 1 s dB | 219N
@ A =
=T brother =
w B 0¥ 1 e
= B EV - _H—
LA |
£ brothar BEE-SG0EC
5 2 APP!
pata
S SAMPLES WOOIZECS  BASKETECS Capfr.acs
2 spanisita
Qi
(2 cosckta
QMES
(2 RECYCLED
@ Fy
) o
ETHMIC, DST 001,096 BIZDST
(ETHHIC) [ROSE) {Hatean]

i Sl ﬂ

Wi

Fraas F1 b Wl

3. Check that the copy destination directory is correct, then click [Yes].

Embroidery Data Explorer m

& Ok to move Dhecs\Data\B_BASYAZ ecs to Dipicturesi\B_BASYAZ ecs?

[ila] |
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Deleting Data

Deletes embroidery data.

1. Click data for selection.
The frame of selected data becomes red.

2. Select [Delete] from Edit menu or click E .

[0l Wiew Tool Help

Bename %

i lpon is made again.
i Select ALL

3. Click [Yes] to delete the selected data.
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Recreate an icon

Creates an icon of data for other models.

Ml Icons of the data created by the following models can be recreated.
*BES-941BC
*BES-961BC
*BES-1241BC
*BES-1261BC
*BES-963BC
*BES-1263BC

B When ECS data saved on a machine such as the BES-963BC is read the by the
embroidering data explorer, some information (No. of repetitions, etc.) cannot be

restored.

1. Click and select the data displayed as "lcon is not completed™.
The frame of the data selected is displayed in red.

RNl

: ﬁ @ Icon is not

completed

=5
3

=) E¥
L Temp
[ brother BES=860BC
w2 APPS
O DATA
LA TEST
4 SAMPLES
) specialdata
R
20 doscata
L MISC -
() REGYOLED Hornon. ecs REnjoy93.ecs Satesl.ecs
0-E F¥ 3u2

2. Select [Icon is made again.] from the Edit menu.

3. The pattern image is displayed.

4. Click [OK].
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Select all

Selects all the data in the folder displayed.

Hl Only copying, movement, and deletion by drag & drop are enabled when multiple
patterns are selected simultaneously. Transfer to the machine controller is

disabled.

Select [Select all] from the Edit menu.

The frame of the data selected is displayed in red.

B C¥Program Filest

File  Edit  Wiew

ool & x\, =
)(|\ B ®|oo|[E= 820 vk i B | 421282
5[ APPS 2] [Basket.ecs 8303 Stitches 5 Color 12/15/97 [
A DATA BrofBcol.ecs T804 Stitches 7 Color 037217971
R CAT et 71936 Sfiches 11 Color 06125799 C
(0 =pecialdata emblem.ecs 19874 Stifches 13 Color 02701799 [

B8 C¥Program Files¥Bes—080¥Data¥ - Embroidery Data Explorer

In the text display mode

File Edit Wiew Toal Help

ok | B2EE

I
JW
.wv

I 4] 2w

=28 E¥
- Temp
(=[] brother BES-8608C
L APPS
[ADATA
LA TEST
4 SAMPLES
L) specialdata
LAt
[0 dosdata
L MISC
) RECYCLED
=83 F¥

Nonnon.ecs
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In the image display mode
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Renaming Data

Renames the registered embroidery data.

Bl Data name consists of the name area and three characters called "extension"
which indicates data type. Enter ".ECS" at the end of the data name.

Basket.e_clzs

'_| -
extension

B Upper and lower cases are not distinguished in the data name.

1. Click data for selection.
The frame of selected data turns red.

2. Select [Rename] from Edit menu or click 5/ .

3. Enter a new data name.
Enter a data name including extension.

Gurrent Narne: broBcol.ecs

MNew Narne: IIogo.ecs|

Ok I Cancel

4. Click [OK].
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Finding Data

Retrieves and views embroidery data.

1. Select [Find Files] from Tool menu.

2. Enter the file name of embroidery data for search.
Enter the file name correctly.

Marme:

I*.ecs

Look in: IE:¥brnther BES-060BC¥SAMPLES¥

M Include subfolders Find S

ks | T Gancel

3. Click [Find].

Marme:

Iethnic.ecs|

Look in: IE:¥brnther BES-060BC¥SAMPLES¥

M Include subfolders Find S

s Cancel
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80

If the specified embroidery data is found, the data is displayed.

Hame: Iethnic.ecs
Loak in: I E¥brother BES-060BC¥SAMPLES¥

¥ Include subfolders Find I S

E¥brother BES-960BC¥5AMPLES¥Ethhic.ecs

1 filele) were found.

1o Cancel

Finding Files With Wildcard Characters

Wildcard characters can be used as a substitute of a single character or
multiple characters. Characters "?" and "*" can be used as wildcard
characters for search.

H Using "?"
The wildcard character "?" represents any single character. For instance,
if "Basket?.ecs" is entered to the file name box, the search will find any file
name including 'Basket' and a following character. Any number of wild
characters can be used to replace other characters.

M Using ™"
The wildcard character "*" represents a character or combination of
characters. For instance, if "*.ecs" is entered to the file name box, the
search will find all files with extension "ecs".
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Adjusting Screen Display

Selects the information type to display on the screen.

H Tool bar
If it is checked, the tool bar appears.

Ml Status bar
If it is checked, the status bar appears.

H File display format
Choose either option.

List Displays a list of all embroidery data names and details in the directory in
text format.

Image Displays a list of all embroidery data names and images in the directory.

H File sorting order
Choose one of the following options. Clicking the icon will switch between
ascending order and descending order.

Sort by Name Sorts files by name.

Sort by Stitches  Sorts files by the number of stitches in ascending order (in descending
order).

Sort by Colors Sorts files by the number of colors in ascending order (in descending
order).

Sort by Date Sorts embroidery data by date in descending order (in ascending
order).

H Updating to the latest information
Displays the latest information.

1. Select [Refresh] from View menu.
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Reading Data in Floppy Disk

Reads data in a floppy disk and registers it as embroidery data.

H The following data formats can be registered.

*DOS format data
Tajima Data with file name "xxxx.DST"
Barudan Data with file name "xxxx.DSB"
Zanks Data with file name "xxxx.DSZ"

*Non DOS format data

Barudan FDR

Barudan FMC

Zanks ZSK

Reading DOS Format Data
1. Select [DST/DSB/DSZ — ECS Conversion] from Tool menu.

2. Select data to read and click [Open].
Open m
Laak in: Iaecs j gl |_§

|_1Data
121 demo
) Log

D temp

File name: I*.ds? Cpen

Files oftype:  |Embraidary File(*ds?) =] |

Cancel

3. The image of the selected pattern appears.
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4. Set feed counts for thread breakage. Select the number of feeds or
specify the feed length for trimming and click [OK].

Mo, of times feed is performed before thread trimming

How rmany times is feed required to be performed
before thread trimming’

1

2
e
ra
5
o
o
a:

" No thread trirming

[T Feed leneth for trirming
|2O 3: rrn
Gancel |

5. Select the directory to save and name the file.
Do not change extension ".ECS".

Save As m
Save in; Iaecs j ﬁl I

|1 Data
122 demo
) Log

D temp

File name: IElrother.ecs Save

Sawve as type: IECS file (*ecs) LI Cancel |

6. Click [Save].
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Converting the Non DOS format data
Change ECS data into DST data and save.

Viewing Files

To view files of FDR, FMC and ZSK data, carry out the following steps:

H Viewing Detailes

Names, types, Numbers, sizes, number of stitches of FDR data are displayed.
Names, sizes, number of stitches of FMC data are displayed.
Names, Numbers, sizes, number of stitches of ZSK data are displayed.

File List
Drive A - <A
Nams [ Tvpe[ Mo | Size [ No. of stiches |
FArBASIKTELW U m 25162 8302
fir CAT U 02 70654 23466
fdr COLOMBS1 U 03 20138 67021
fir DRAGCAR U 04 183757 61167
fdr FCBROTHE U 03 26308 8684
File Marme: I OK
Data Type: | = Cancel

‘F‘ress F1 for Help

| Sfiles(1332E fres space

File List

Drive A - <A
Nams [ Size [ No. of stiches
fine AO1 25162
e AO2 70654 23466
fine AO3 201319 67021
e A0S 183757 61167
fine AOT 26308 2624
File Marme: I Ok I
Data Type: I j

Cancel

‘Press F1 for Help

| Sfiles|1332B free space

Drive: Sl
MName Size | Mo, of stichesl
T5K1234 25182 8302
15K 1587 70654 23466
I3k 5678 201318 G7021
File Name I M
Data Type I j Cancel

‘F‘ress F1 for Help

| 3files(1332E fres space

84
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H Viewing Icon
Click /.

FDR FDR

BASKTFUA

FDR FDR

CAT COLOMBS1

FDR

File Marme: I

Data Type I

il

GCancel

‘F‘ress F1 for Help

| Sfiles|1332B fres space

M Preview and Refresh

The data image can be displayed before reading the data. Click the desired icon
or the name for display. Click %l to display the data image. On the detailed
display, "fdr" and "fmc" changes to image display. To cancel the preview, click

BASKTFLW

FDR FDR

COLOMBS1

FDR

File Marme: I
Data Type: I

u

OK |
Cancel

‘Press F1 for Help

| Sfiles/1332B free space

1. Set the floppy disk such as Barudan which is non-DOS format at the

floppy disk drive of the PC.

2. Select [Non DOS (Barudan, ZSK...) Conversion] from Tool menu.
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3. Select data to read and click [OK].

File List

Drive: . - s 14

Marme | Tvpel Mo, | SizelNo ofstichesl

fdr BASKTFLW U o 25162

CA U 02 70654 23466

fdr COLOMBS1 U 03 20t1a 67021

fir DRAGCAR U 04 183737 61167

fdr FCBROTHE U 03 26308 8684
File Marme: I
Data Type: | [ GCancel

‘F‘ress F1 for Help |

5fi\es‘1 3328 free space

BASKTFLW COLOMBS1

FDR FDR i
=
File Marme: I
Data Type: | [ GCancel

[Press F1 for Help | Sfiles|1332B fres space

4. The image of the selected pattern appears. To convert the selected data
into ECS data. Click [OK].

Ok, Cancel
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5. Set feed counts for thread breakage. Select the number of feeds or
specify the feed length for trimming and click [OK].

Mo, of times feed is performed before thread trimming

How rmany times iz feed required to be performed
before thread trimming?

i

2
i
4
(ol
(ol
7
(ol

™ No thread trirmming

I~ Feed leneth for trimming
IEO 3: !
Gancel |

6. Select the directory to save the file and name the file.
Do not change extension ".ECS".

Save As m
Save in; Iaecs j ﬁl si EE

|1 Data
122 demo
) Log

D temp

File name: ICat.ecs Save

Sawve as type: IECS file (*ecs) LI Cancel |

7. Click [Save].
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Reading Data in Paper Tape

Saves data in paper tape as embroidery data.

l An optional paper taper reader is required for reading data.

Hl Before saving any data, check that the paper tape reader (optional) is connected
to PC correctly.

H Available interfaces are as follows:

« COM1

« COM2

H Readable data formats of paper tape are as follows:

* Tajima

» Barudan

» Zanks (ZSK)

1.  Turn on the power to the paper tape reader.

2. Set paper tape after the LED of READ button light up.

Power switch
READ button

Paper tape

3. Select [Tape — ECS Conversion] from Tool menu.

4. Select data format and click [OK].
The paper tape reader (optional) starts reading data.

Tape Read Preparation

Select format, click 0K, and =tart
tape reader

£+ Tajima
| Barudan
75K

Cancel

88 BES-962BC + BES-1262BC



Chapter 4 Selecting and Transferring Embroidery Data

5. The image of the selected pattern appears.

6. Select the directory to save and name the file.
Do not change extension ".ECS".

Save As m
Sawve in: Ia TEST j gl l_

File name: IElrother.ecs Save |
Sawve as type: IECS file (*ecs) LI Cancel |

7. Click [Save].
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Settings for Data Reading

Sets up the interface and data transfer speed of the paper tape reader or external disk drive.

1. Select [Setup] from Tool menu.

2. Select port and speed.

Port and Speed

Punched tape

Port ICOM2 j

S [ag00 =l

Cancel |

3. Click [OK].
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Writing Data in DST Format

Convert the ECS data into DST data for saving.

1. Click the desired ECS data to convert into DST data.
2. Select [ECS to DST conversion] from Tool menu.

3. Select the directory to save and name the file.
Do not change extension ".dst".
Save As HE
Saveim |3 TEST = &l & ==

Filename:  |BASKET.dst Save |
Sawve as type: IEmbIDidaryFiIefiIe (*.clst) LI Cancel |

4. Click [Savel.

5. Set feed counts for thread breakage.Select the count and click [OK].

Ma. of times feed is performed before thread trimming

How mary times iz feed reguired to be performed
before thread trimiming?

1

2
o
4
5
ol
3
o

" Mo thread trimming

[ Feedlenath for trimmine
|2Cl 3: mim
Cancel |
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Viewing Pattern Information

Detail information of embroidery data can be checked.

92

B The following items can be checked.

Pattern name File name and path of embroidery data

File Version Version number of the file

No. of stitches The number of stitches in embroidery data
No. of colors The number of colors used in embroidery data
Mask Size Size of masking

Start of Embroidering Coordinates of embroidering start position

End of Embroidering Coordinates of embroidering end position

Last modified Date of last revision of data

1. Click data for selection.
The frame of the selected data turns red.

2. Select [Design Information] from Help menu or click

3. After checking, click [OK].
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Chapter 5
Editing Embroidery Data

Clicking of the machine controller brings
up a screen which allows editing of embroi-
dery data. This screen allows simple pro-
cessing of embroidery data and display set-
ting of display.

BES-962BC « BES-1262BC
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Functions (Command Reference)

File menu

Open El Selects embroidery data. (— page 97)

Merge Add other pattern to the pattern in editing. (— page 119)

Save ﬂl Saves the edited embroidery data over the current file. (— page 121)
Save as Saves the edited embroidery data as a separate file. (— page 122)
Print = Prints embroidery data. (— page 124)

Print Preview

Views printing condition of embroidery data.

Print Setup Designates printer settings.
Exit Editing Exits from editing of embroidery data.
Edit menu
Undo ﬁl Returns to the previous step. (— page 107)
Redo gl Repeats the step of "Undo". (— page 107)
Rotate @l Rotates the image. (— page 108)

~

Horizontal Flip

Flips the image horizontally. (— page 109)

Vertical Flip El Flips the image vertically. (— page 109)

Point Symmetry i)l Rotates the image 180 degrees about the center. (— page 109)
Repeat ﬁl Repeats copying of the image. (— page 109)

Resize ﬁl Resizes the image. (— page 111)

Delete Stitch

Delete a stitch whose length is the designated length or less. (— page 111)

Insert or delete code

Insert or delete the code for trim, pause and color change. (— page 112)

Insert lock stitch

Insert a lock stitch before and after thread trimming. (— page 113)

Change menu

Start Changes the start position of embroidery data. (— page 114)
End Changes the end position of embroidery data. (— page 115)
Mask Changes the mask of embroidery data. (— page 116)

Group Group the patterns created in "Repeat” into one. (— page 117)
View menu

Centering Centers embroidery data. (— page 98)

Zoom El

Zooms in or out. (— page 98)

Needle Penetration

Displays the needle penetration positions. (— page 100)

94
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Embroidering Start/End

Displays the start/end positions of embroidering. (— page 100)

Trim and pause

Displays the code insertion position for trim and pause. (— page 100)

Microstitch

Displays the position of the stitch whose length is the designated length or less. (— page 101)

Needle bar and speed range E

Displays the setting screen for needle bar and speed range. (— page 101)

Thread color E

Displays the pattern in thread color. (— page 105)

Tool Bar

Shows/hides the tool bar. (— page 106)

Status Bar

Shows/hides the status bar. (— page 106)
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Description of Screen

Fit to Window Needle bar and Vertical Flip Design Information
) Speed Range . . . L
Display Range Horizontal | Point Symmentry About This Application
Flip
Save Zoom Out Thnlaad Redo Repeat Print Help
color
Open | Zoom In Undo Rotate Resize

Tool Bar
Kl L _’l_l
For Help, press F1 ’_’W ——1— Status Bar
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Opening Embroidery Data

This function is available with embroidery data editor.

1.

2.

Select [Open] from File menu or click il .

Double-click the data or click the data and 0K| .

Click a file for selection and click [Open].

S—-960EC - Embroidery Data Explarer

oK ><| Ba x|n|

Flle Edit  “iew Tool Help

1o
1o
e
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Setting Display

Sets the condition of the display screen. Items with check marks to the left are selected.

Centering

Brings the image to the center of the screen.

P E I A E
EI- e

E@la@ _J_Iﬁlgl @\ Bl D3 08] BhE] 2 K2 | @/Q[T 8l 0|ox| @1H Ea| D305 BI@I‘?IR’?I

s L

Fer P prace F1

Fer P prace F1

Before selecting

After selecting

1. Select [Centering] from View menu.

Zoom

Zooms in/out the pattern.

H The following four types of zooming are available.

Zoom In Enlarges the image to 125%.
Zoom Out Reduces the image to 80%.
Range Magnifies the range defined by the mouse to the full window size.

Full Window  Displays the whole image to the size of the window.

Zoom In

1. Select [Zoom] - [Zoom In] from View menu or click Q| .
Repeats zooming of the image by the number of clicks.

m i E ' P
Dhskg-uﬁwlbb Ehskg-—ﬁ-w)bb

Zlid| QAT+ Bl=d ol ox| @ 52 i |15) Sl 9 K2 Sl @G Bl o0 61 52 D 3|5 EIGEI‘?IR”I

I

For rea prace 11 Fox i prace 11

Before selecting

After selecting
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Zoom Out

Select [Zoom] - [Zoom Out] from View menu or click gl .

Repeats zooming of the image by the number of clicks.

] - : o
eu e 1

v
aplnge 4 ket dais 4 gy o A s

Before selecting After selecting

Range

1. Select [Zoom] - [Range] from View menu or click E' .

Drag and define the range to zoom in with the mouse.
_J_|0.ema Bl /o] @[ B0l D] 122 Bl 2 2 D_j'_|°"i”éf€a 2 Bl 0]o) @lalB D) 2] @7 e
=] H

A_‘
inge kb dais 13000 $a Al s

o _ o
ex P s 1

Before selecting After selecting

Fit to window

1. Select [Zoom] - [Fit to window] from View menu or click ﬂ .

Ehskm——!ﬁnn’b

B Q0T Blad 0 0] @il 9z SL T T aak

Sid| QQ ) Bl || @IKH 5 D)5 || EIQI?J\"\

S— _vl_‘
Diplags osbr dua 0y o il e

Fon e prace 11

Before selecting

After selecting
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Displays the position of the trim code and the pause code.

Trim is displayed by X and pause is displayed by [¥] .
1.

Chapter 5 Editing Embroidery Data

Needle Penetration

1.

Sk @eJGk Bl=l ol @l D[]8 &l 2K
|

Select [Needle Penetration] from View menu.

Pl E E

Chooses whether or not the needle pevetration positions are displayed.

L]

Before selecting

Embroidering Start/End

T Git Ghres e th

i E

%H‘éj’é]%m Bl 2| @35 D)1 S 7N

Displays start and end points as "S" and "E" on the screen respectively.
If points "S" and "E" are identical, "E" has priority over "S".
1.

Select [Embroidering Start/End] from View menu.
Z | QT Bl o] @IaH B DI:E12F| S P N2)

After selecting

L]

=

o i prase

Before selecting

Trim and pause

For Hok prass

Select [Trim and pause] from the View menu.

S Qe 8l olc) wlalp vl SE v
'
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Microstitch

Displays the position of the stitch whose length is the designated length or less with |l .

Length can be designated from 0.0 to 1.0 mm in units of 0.1 mm, or from 0.00' to
0.04' in units of 0.01".

1. Select [Microstitch] from the View menu.

2. Designate the length of the stitch to be viewed. Select [View] and
designate the length of the microstitch.

& Display
= Man display Cemea |
Length of micra stitch
03mm ﬂ
Microstitch

3. Click [OK].

T

Sl Ok Bl 0]

Before selecting After selecting

Needle Bar and Speed Range

Displays status of the needle bar and speed range.

1. Select the [Needle bar and speed range] from the View menu or click @l .

-

| v

[0s
w2l olal7|eals]4]3]z2] 1]z
Indicates the needle Indicates the stitching Pause is set when the Indicates the range of
number and the color. order and the color. range shows S marking. each needle bar.

Change of display color

Il When the color of the embroidering sequence is changed, the color displayed on
the screen is changed. When ending embroidering or reading other data, the
confirmation screen for saving the setting appears.
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M A display color can be selected from among the following four items.

Basic color which can be selected screen Refer to steps 1 and 2.
on the "Color selection”

Color sample supplied by a manufacturer Refer to steps 1 and 3.
Color sample created by a user Refer to steps 1 and 3.
Adjustment of an intermediate color from the Refer to steps 1 to 7.

color sample supplied by a manufacturer or
naming and registration of a newly created color

H The following screen is displayed when colors to be displayed are set to 256 in
[Display Properties] and the color sample supplied by a manufacturer cannot be
selected or an intermediate color cannot be created.

it is not available of medium colar in 256 colars system

Mumber of sewing sequence |3 _I:j' - Wedium calar |

It is not available to designate the color name of maker in 256 colors system.

Maker name Color

MADEIRA

User

Addition |

e letion

Cancel

1. Double click the desired embroidering sequence to change the color.

12000 10] o [FeRR ¢ | 5 Pepahe w2l olal7|eals]4]3]z] 1]z
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2. Select a new color on the [Color selection] screen.

Color selection

Meedle bar numbe: |5 _I;

- Medium color |

Maker name Color
MADEIRS
User
Addition |
e letion |
Cancel |

The needle bar number can
be changed.

3. When selecting a color from a color sample, click maker name or [User]

and double click [Color].

Mumber of sewing sequence |4 _I;

Maker name

User

Color

- Medium color |

Dhst Mawy 1244
Dark Mawy 1044

Med Mawy 1043
Mawy 1243

Lt Mawy 1242

Dark Delft Blue 1167

4
Addition |
[ozren |

e letion

Lt. Delft Blue 1030

o]4 I Cancel |

)

4. When finely adjusting the selected color, click [Medium color].
Click [User] to crate a new color, then click [Addition].

Meedle bar number |5 _I;

Maker name

Color

- Medium color |

|MADERA |
o]4 I

Cancel

Addition |
e letion |

BES-962BC « BES-1262BC
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5. Select an arbitrary color from basic colors.
Click [Define Custom Colors] to create a medium color.
Color m

Basic colors:

Define Custarn Colors >> |

oK I Cancel |
6. Select a color by clicking on the color chart or by inputting a value, and
click [OK].
Color m

Basic colors:

— Drag here to adjust

brightness.
Hug: |1DD Bed: ID
Sat: |24D Green: |255 display d .
- " To display data o
| DefineCustarm CalErs>> I 0 Lurr: |1 20 Elue: |1 28 the seIF:'-,\ciled color
(0] I Cancel | Add to Custom Colors |

7. Input the name of the color and click [OK] when [User] is selected in step 4.

Inputting a line of characters |

Input color namefwithin 265 characters)

Cancel |
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Changing needle bar allocation

1. Drag the embroidering sequence on the needle bar number.

Dragged embroidering sequence

Setting the range

1. Double click the desired needle bar range to change.

2. Click the desired range.

Speed Range

C

e

i3

4

5

e
Click here to put a check
mark for pause before

I~ Pause ) .
starting the designated
embroidering sequence.
’TI Cancel |

3. Click [OK].

Thread Color

The embroidery data is displayed in thread color.

M This functions is available only when the embroidery data edit is started from the
machine controller.

1. Select [Thread color] from the View menu or click &'

D B ED

B QAT B 00| @l iID | GLN | Sl QIO Bl o|o] @lis5 Dlicr| @17 A

W £

i £

Before selecting After selecting
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Tool bar

Shows/hides the tool bar. The tool bar contains icons with the same functions as
the menu.

1. Select [Tool Bar] from View menu.

B 3 Pl 3] 5 Pl E3|
Eh Eh e e e

S i Ok Bl olc| @llgl o)k 7
=

For Hoka prace 1 i For Hola prace 11

Before selecting After selecting

Status Bar

Shows/hides the tool status. The status bar provides information on the current
status and advice for operation.

1. Select [Status Bar] from View menu.

I i 3 i 3}

ik Edt Ghaes den tab

S Qe Rk blal o|c] @R DS SEIN Sk 0.QRE Bl o] @ik @7
Al Al

o

E

Before selecting After selecting
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Back to Previous Status

Undo

Makes the edit or change invalid. The screen returns to the state before the change.

M The screen can return to 3 steps maximum.

1. Select [Undo] from the Edit menu or click 2'

Redo

Repeats the canceled step of "Undo".

H The screen can return to 3 steps maximum.

1. Select [Redo] from the Edit menu or click gl
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Editing

Rotate

H Available range of rotation is -359 to 359 degrees.
l When the patterns to be repeated are grouped, the whole pattern rotates. When
they are not grouped, each pattern rotates in each hoop.

When the patterns are grouped When the patterns are not grouped

1. Select [Rotate] from View menu or click @I .

2. Select angle.
If [Free] is selected, specify the angle.

Angle (degrees)

i+ a0 Cancel |
180
To select angle.
270
CoFree 0[5 Click here to increase/decrease

the value.

The value can be directly entered.

3. Click [OK].
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Horizontal Flip

Flips the image horizontally.

1. Select [Horizontal Flip] from Edit menu or click R_’EI .

Vertical Flip

Flips the image vertically.

1. Select [Vertical Flip] from Edit menu or click Bl .

Point Symmetry

Flips the image 180 degrees to the center position of the image.

1. Select [Point Symmetry] from Edit menu or click i)' .

Repeat

Repeats copying of the image by the specified number.
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B The number for repetition is 1 to 100 for both vertical (Row) and horizontal (Column)
directions.

M The unit for repetition can be set in inches. To use the inch unit, set the length to
[inch] on the [Configuration] of Tool menu of the machine controller. (— page 148)

l The pattern connection can be set in "Direction" as follows:

S S
E E
From top left,alternating directions From top left,left to right direction
E E
s S
From bottom left,alternating directions From bottom left,left to right direction

1. Select [Repeat] from Edit menu or click ﬁ' .

2. Specify the number, interval and direction of repetition.

—— Repeat count in the
longitudinal direction —— The value can be directly entered.

Repeat count in the
lateral direction

Click here to increase/decrease the value.

—Ma. of repetitions — Direction
L Col |2___l_ ' From top left, alternating directions . . .
e = e Select the direction of repetition.
= From tap left, left ta right direction
Rowy lq_ o
= " From bottam left, alternating directions
" From bottam left, left to right direction

—Spacing —_l —Datum———
Col 20mm = ..
s = " Center of pattem Select the reference position for
Row 20mm ﬂ {* Clearance between patterns SpaCing.

QK I Cancel |

L All patterns created in repetition are grouped as a single pattern.

L Longitudinal distance (Unit: 0.1 mm or 0.01")
—— Lateral distance (Unit: 0.1 mm or 0.01")

3. Click [OK].
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Resize

Resizes the image.

H The available range of resizing is 50 to 200% in both the X and Y directions.
M Resizing changes the thread density along with the percentage.

1. Select [Resize] from Edit menu or click QI .
2. Specify the percentage of resizing.
Size ()
- W?I Cancel | . .
. Wﬂ Click here to increase/decrease the value.
The value can be directly entered.
3. Click [OK].
Delete Stitch

Delete a stitch whose length is the designated length or less. Length can be
designated from 0.0 to 1.0 mm in units of 0.1 mm, or from 0.00' to 0.04" in units of
0.01'.

1.

Select [Stitch deletion] from Edit menu.

Designate the length of the stitch to be deleted.

Stitch deletion

Deleting stitch length SHCE |

03mm =l

|

Click [OK].

Deleted result is displayed. Click [OK].

Embraidery Data Editar

& 51 pointl=) of stitch were deleted.
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Insert or Delete Code

Codes of trim, pause and color change can be inserted or deleted by moving the
needle to the desired position.

1. Select [Insert or delete code] from the Edit menu.
Needle movement tool bar is displayed.

1 [10 100] A/ | A8IFA] o] o] w [um v | 0l X

1 step— —
10 step — — Insert (delete) change
100 step— color code
Next (previous) color change point — — Insert (delete) pause code
Next (previous) feed point— — Insert (delete) trim code
Next (previous) trim code — — Consecutive step forward specified
Next (previous) pause code — — Step forward specified
— Stop

— Step backward specified
— Consecutive step backward specified

2. Select the movement method of needle position.
Click either of the following buttons:

1 step Ll Moves the needle position by 1 step each.
10 step ﬂl Moves the needle position by 10 step each.
100 step 100/ Moves the needle position by 100 step each.

Next (previous) color change point Al Moves the needle position to the next (previous) color change point.

Next (previous) feed point /_l Moves the needle position to the next (previous) feed point.

Next (previous) trim code A‘ Moves the needle position to the next (previous) trim code.

Next (previous) pause code &l Moves the needle position to the next (previous) pause code.

3. Move the needle position to the desired position.
Click either of the following buttons:

Consecutive step backward specified 1‘ The needle position returns consecutively until the "Stop" button is pressed.

Step backward specified | The needle position returns for the specified length.

Stop Ll The needle position stops movement.

Step forward specified M The needle position moves forward for the specified length.

Consecutive step forward specified :l The needle position moves forward consecutively until the "Stop" button is pressed.

4. Insert or delete the code.
Click either of the following buttons:

Insert (delete) trim code }:}é Insert (or delete) the trim code at the current needle position.

Insert (delete) pause code ::_@l Insert (or delete) the pause code at the current needle position.

Insert (delete) change color code E:E Insert (or delete) the change color code at the current needle position.

5. To end code insertion or deletion, click ll .
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Insert Lock Stitch

Find the pattern of [Stitch] - [Trim] for [Before Trimming] and find the pattern of
[Trim] - [Feed] - [Stitch] - [Stitch] for [After Trimming], then insert a lock stitch.

B Insertion method of lock stitch depends on the length of the second stitch as
follows:

Stitch length Method of lock stitch

1.2 mm or more Insert 3 stitches of 0.3 mm stitch.
From 0.9 mm to less than 1.2 mm Insert 2 stitches of 0.3 mm stitch.
From 0.6 mm to less than 0.9 mm Insert 1 stitch of 0.3 mm stitch.
Less than 0.6 mm Do not insert the lock stitch.

Bl The inserted lock stitch cannot be deleted. However, use [Undo] in the Edit menu
to return to the status before inserting the lock stitch just after the lock stitch is
inserted.

1. Select [Insert lock stitch] from the Edit menu.

2. Designate the position to insert the lock stitch and click [OK].

Insart Lock Stitch

¥ Bafore Trimming Cancel I

V¥ &fter Trimming

3. If the lock stitch can be inserted, click [Yes].

Embraidery Data Editor

@ Inserted Lock Stitch cannot be deleted.
Are you OK?
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Changing Data

114

Changing Start

Changes the start position of embroidering.

1.

Options

Functions

Center, upper left corner, middle left corner,

lower left corner, middle top edge,
middle bottom edge, upper right corner,
middle right corner, or lower right corner
of the mask

Starts embroidering at the specified
position.

Specify using mouse

Starts embroidering at the position
clicked with the mouse.

Cancel Cancels the specified position.
Middle top edge
Upper left Upper right
corner corner
Middle left Middle right
corner corner
Lower left = il Lower right
corner corner

Middle bottom edge

Select [Start] from Change menu.

¢ Data Editor

File Edit Help

Center of mask

= Start
. E Fd 0| Ussey (55 cemey o meak

Mazk *  Middle left edge of mask
el e} Lower left corner of mask

==

Middle top edge of mask k
Middle bottom edge of mask
Upper right carner of mask
Middle right edge of mask
Lower right caorner of mask

Specify using mouse

Cancel

Center

Click the start position if [Specify using mouse] is selected.

BES-962BC « BES-1262BC



Chapter 5 Editing Embroidery Data

Changing End

Changes the end position of embroidering.

1.

Options

Functions

Center, upper left corner, middle left corner,

lower left corner, middle top edge,
middle bottom edge, upper right corner,
middle right corner, or lower right corner
of mask.

Ends embroidering at the specified
position.

Specify using mouse

Ends embroidering at the position
clicked with the mouse.

End at start position

Ends embroidering at the end position.

Cancel Cancels the specified position.
Middle top edge
Upper left e Upper right
corner corner
Middle left . Middle right
corner corner
Lower left 4 Lower right
corner O O corner

Middle bottom edge

Select [End] from Change menu.

¢ Data Editor

File  Edit “iew  Help

Start ¥ L= I |

= = —
. E Center of mask 3

Mazk *  Upper left corner of mask
el e} Middle left edge of mask
Lower left corner of mask

Middle top edge of mask k
Middle bottom edge of mask
Upper right carner of mask
Middle right edge of mask

Lower right caorner of mask

Specify using mouse
Same as start of embroidering

Cancel

Center

Click an end position if [Specify using mouse] is selected.
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Mask

Changes the mask that represents the periphery of embroidery data. Since the
automatic mask is a rectangle, the pattern within the hoop may be displayed as an
error. In this case, set masking in manual mode.

M Mask is displayed in a khaki line.

H There are two types of mask setting as follows:

Automatic The system measures the image size to create a mask automatically.

Manual After selecting this mode, specify the mask area using the mouse.

1. Select [Mask] from Change menu. Select automatic or manual mode.

If [Automatic] is selected, a mask is created automatically.
If [Manual] is selected, drag the area with the mouse to specify the mask.

(i o) Marual

116 BES-962BC « BES-1262BC



Chapter 5 Editing Embroidery Data

Group

All patterns created in repetition are grouped as a single pattern.

H The difference between the grouped pattern and the non-grouped pattern is as
follows:

B 5606  Ertrovhry Lt i il 3
Bl Edr Chergn aen Hab

=i QQ[TE | 8l || @I 82 D3 5| Sl 2 W)

K]
Fer Hol. prazs Fi ]

When the patterns are grouped
«Each pattern is displayed in each mask.
» The whole grouped pattern rotates. (— page 108)

B 5606  Ertrovhry Lt i il 3
Bl Edr Chergn aen Hab

=i QQ[E | 8l 00| @I 82 D3 15| Sl 2 W)

K]
Fer Hol. prazs Fi ]

When the patterns are not grouped
* The pattern is displayed only in the original copy source. Figures in other masks
represent the embroidering sequence.
e Each pattern in the mask rotates individually. (— page 108)
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Setting Group for Repetition
1. Select [Repeat] in the Edit menu or click ﬁ' .

2. Click the checkbox of [Group] to put a check mark.

—Ma. of repetitions — Direction
Calumn |2 _IZ ¥ From top left, alternating directions
5 = From tap left, left ta right direction
o |4 = . S
== " From bottam left, alternating directions
" From bottam left, left to right direction
—Spacing —_l — Datum
20 =
Crlturm mm = = Center of pattern
Row 20mm jl {* Clearance between patterns

QK I Cancel

Selecting from Menu

1. Select [Group] from Change menu.

Eie Eis Chege S b

S @Ak Al vlo| @3B D328 B 2 |
5
4 3
|
5 []
]
E
‘Ju“w”“ —| — J—‘
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Merge other patterns to the pattern in editing

1.

M If the pattern to be merged is repetition data, it is automatically grouped and
merged.

5 Bir G o b

= @O | Bl=] ©|c| @l § D] @w’

o g prass 11

M If the pattern to be merged is non-grouped repetition data, it is merged to each
pattern If the pattern does not fit the mask, the mask is automatically adjusted

EJEIQGNEBBAIEEM

5 Bir Chwyn et

Elll| QT B el | @] 52 D|:E 28] S @@k"

M If the pattern to be merged is grouped repetition data, it is merged at the specified
position.

Fer Pt pace 1

_J_IGIQE A=l ol @l B9

Hi @@k”

For ok race 11

Select [Merge] from the File menu

Select the pattern to be merged

Ehskﬁn]wl}bb

rJ<I><|W“'tl“| | Efee e 1 o Il§| vl@l'f’l

¥
SENEY
w20 Tamp
=) becthar BEE-S008C
% [ AFPE
=0 D-\u

0000000z.Ec5 BASRETECS Capfeacs
a am-auxa
) csckta

DST DSB

ETHNIZ, DET

G01L.CSE GIE.CET
(ETHHIC)

Frozs Fi br Bl

[ROZEY (HEteam]

iRl
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3. The pattern mask is displayed in a broken line. Move the mask to the

desired position for merging. Click the mouse.
Move the mouse while pressing the shift key. The mask moves horizontally and vertically.

5] QIO Bl 5[] I35 D5 B2 2

?
=

4. If the position is acceptable, click [Yes].
When [No] is clicked, repeat the steps from 3.

Merging position

Iz it OK to merge data in this
position?

o Cancel

5. The pattern is merged.

B 5606  Ertrovhry Lt i Pl E3
Bl Edr Chergn aen Hab

S @) Bl || @3 B ik 25 Sl 28

|

For Halg, prace 11
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Saving Data

Saves the edited data. The edited data can be saved over the current file or renamed as a separate file.

Save

Saves the edited data over the current file. The original data is deleted.

1. Select [Save] from File menu or click El )

2. If the edited data is larger than the mask, choose whether to carry out
automatic masking or not.

Auto mask confirmation

Embroidery data exceeds mask size. Do wou want to
set it to maximum mask size? (Auto mashk)

Ma Cancel

To cancel saving
— To save mask without changing

— To set and save mask automatically

3. If color etc. has been is changed, the pattern image appears.
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Save As...

Renames and saves the edited data as a new file.

1. Select [Save as...] from File menu.

2. Select the directory to save the new file. Enter a new file name.

Save As d E3
Sawve in: IaSamples j ek
: ¥ Goodecs
¥ broBcolecs ¥ MOMNKEYS.ecs
¥ broBcol2.ecs ¥ Monnon.ecs
¥ Enjoy—83.ecs
¥ Ethnic.ecs
¥ Fishing.ecs
¥ Golf-93.ecs

File name: IElaSket.ecS.EOS Save |
Sawve as type: I*.ecs LI Cancel |

3. Click [Save].

4. If the edited data is larger than the mask, choose whether to carry out
automatic masking or not.

onfirmation

Embroidery data exceeds mask size. Do wou want to
set it to maximum mask size? (Auto mashk)

Ma Cancel

To cancel saving

— To save mask without changing

— To set and save mask automatically

5. If color etc. has been is changed, the pattern image appears.

Creating lcon
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Viewing Pattern Information

Detail information of embroidery data can be checked.

H The following items can be checked.

No. of stitches The number of stitches in embroidery data
No. of colors The number of colors used in embroidery data
Mask Size Size of masking

Start of Embroidering Coordinates of embroidering start position
End of Embroidering Coordinates of embroidering end position

1. Select [Design Information] from Help menu or click %, 1.

2. After checking, click [OK].
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Printing Data

Prints data in editing.

1. Select [Print] from File menu or click £&9|.
Specify the number of copies and other conditions. Click [OK].
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Chapter 6 Embroidering

The PC controls the machine operation as
well as settings of the machine. Note that
the menu which appears on the screen de-
pends on whether the power to the machine
is turned on or off.
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Functions (Command Reference)

When the Power to the Machine is Off

File menu

Exit Exits the machine controller.

View menu

Tool Bar Displays the tool bar. (— page 130)
Status bar Displays the status bar. (— page 131)
Tool menu

Edit Embroidery Data

Runs the embroidery data editor.

Embroidery Data Explorer

Runs the embroidery data explorer.

Production Report

Runs the production report.

Upgrade Interface Board

(— page 131)

Reset Interface Board

(— page 131)

Configuration menu

Communication Port

Sets the communication port between the PC and machine. (— page 131)

Language

Changes display language. (— page 132)

When the Power to the Machine is On

Machine menu

Save

The machine data is overwritten for saving. (— page 186)

Save As

The machine data is saved as a different name. (— page 186)

Minimize Window Size

Minimizes the size of display screen on the machine. (— page 145)

Rename Machine

Renames the machine. (— page 143)

Machine Information

Displays machine information. (— page 144)

Exit

Exits from the machine controller.

126
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Operation menu

Start Enbroidering

Starts embroidering. (— page 177)

Stop Machine

Suspends embroidering. (— page 178)

Cancel Embroidering

Cancels embroidering. (— page 178)

Home Position

Moves the home position. (— page 179)

Step F/B

Carries out step-forward or step-back. (— page 180)

Move Embroidery Position

Moves embroidering position. (— page 184)

Centering Pattern

Moves pattern to the center. (— page 185)

Test Tests the machine. (— page 187)

View menu

Tool Bar Displays the tool bar. (— page 133)

Status Bar Displays the status bar. (— page 133)

Zoom In Zooms in the embroidery data. (— page 133)
Zoom Out Zooms out the embroidery data. (— page 133)

Zoom In Specified Range

Zooms in the specified range. (— page 134)

Fit to Window

Displays the whole embroidery area. (— page 134)

B2 |3 | &7 |2 ||

Whole Pattern

Displays the whole embroidery data. (— page 134)

Grid

Displays 1 x 1 cm square grids on the background. (— page 135)

Hoop

Displays the outline of embroidery hoop. (— page 135)

Hoop position fine adjustment

Adjusts the view position of the embroidery hoop. (— page 135)

Needle Penetration

Displays the position of needle penetration. (— page 136)

&= |if

Thread Color

Adjusts the color of the embroidery data to the thread spool. (— page 137)

Needle Bar and Speed Range

Displays needle bar and speed range. (— page 137)

Grid Setting

Sets the color and the pitch of grid. (— page 142)

Background color

Changes the background color of the data. (— page 142)

Tool menu
Language Changes display language. (— page 132)
Edit Allows editing of embroidery data.

Embroidery Data Explorer

Allows selection of embroidery data.

Production Report

Creates production report.

Run Embroidery Data Editor independently

Runs the embroidery data editor. (— page 188)

Run Embroidery Data Explorer independently

Runs the embroidery data explorer. (— page 188)

Copy to Another Machine

Copies embroidery data to other machines. (— page 147)

Configuration

Sets configuration for embroidering. (— page 148)

Version Upgrades

Upgrades the version of the machine parts. (— page 148)
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Settings menu

Needle Bar

Uses the same needle bar for all embroidering. (— page 149)

Same Speed Range

Sets the head. (— page 150)

Pause

Sets whether to stop the needle bars temporarily when changing all the needle bars. (— page 150)

Speed Range

Defines the speed range. (— page 151)

Head Operation Suspend

Cancels the head operation which is not halted on the machine side. (— page 151)

Hoop Feed Position

Sets the hoop feed position. (— page 152)

Embroidery Area

Sets the area for embroidering. (— page 152)

Embroidery Hoop

Sets the type of embroidery hoop. (— page 153)

Thread Trimming

Sets the inching and thread removal amount. (— page 156)

Boring

Sets boring. (— page 157)

Thread Breakage Sensor

Sets operation of thread breakage sensor. (— page 158)

Automatic Step Back

Sets automatic step back count for thread breakage. (— page 159)

Automatic Hoop Feed

Feeds hoop to the hoop feed position automatically after embroidering. (— page 159)

Embroidery end setting

Sets if the machine returns to the start point after end of embroidery. (— page 160)

Mending

Sets details of mending. (— page 161)

Adjust

Sets the adjusting value. (— page 162)

Speeding up of main shaft startup

Speeds up the startup speed of the main shaft. (— page 163)

Hoop feed during temporary stop for color change

Sets whether to feed the hoop during temporary stop of the needle bars to change colors. (— page 163)

Reducing speed in a short stitch

Reduces speed when stitching in a designated small pitch. (— page 164)

Thin material or thick material

Adjusts the timing of needle drop and hoop movement. (— page 165)

Area tracing

Select the outside shape of area tracing before starting sewing. (— page 166)

Default Settings

Resets changes of the machine setting to the default at the factory shipment. (— page 167)

Show Setting

Shows the contents of settings. (— page 168)

Load Setting

Loads the setting details. (— page 170)

Save Setting

Saves the changed setting. (— page 171)

Load Hoop

Selects the hoop type. (— page 172)

Window menu

Cascade

Cascades windows. (— page 144)

Tile

Tiles windows. (— page 144)

Arrange Icons

Alignicons. (— page 146)

128

BES-962BC « BES-1262BC



Chapter 6 Embroidering

Description of Screen

Needle bar and speed range — — Cancel embroidering

Thread color — —— Suspend embroidering

Needle penetration —
Whole pattern
Fit to window

Zoom in specified range
Zoom out

—— Home position
Step-back/step-forward
Move pattern
Information
About This Application

Zoom in

Help

Tool bar

Stlt:hes 0/8303r

Basketecs Tubular (All)
Orpm 110des.

al ogeration
£e 1400-10007  Speed

Open explorer—

Open editor

Copy data to
other machine

Start embroidering

Suspend
embroidering

Mormal aperation

[
[For Help, prass F1 DISCONNECT | | |—F— Status bar
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Settings before Turning On the Machine

Describes settings available before the machine is turned on.

H The following items can be set.

Displaying the tool bar

Displaying the status bar

Upgrading the version of interface board (*)

Resetting the interface board (*)

e Communication port

* Language

(*) Dealer engineers carries out version upgrading and resetting of the interface
board.

Displaying the Tool Bar

Shows/hides the tool bar. The tool bar contains icons with the same functions as
the menu.

M There are two kinds of tool bars as follows:

Main Main menu items are displayed on this tool bar.

Step Back This tool bar appears during step-back/forward.

1. Select [Tool Bar] from View menu and put the check mark.
Click here again to remove the check mark. Then the tool bar disappears.

% Embraoidery Machine Con

Fila m Tool  Config

e ¥ Status Bar Eg E:'
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Displaying the Status Bar
Shows/hides the status bar. The status bar provides information on the current

status and advice for operation.

1. Select [Status Bar] from View menu and put the check mark.
Click here again to remove the check mark. Then the status bar disappears.

% Embraoidery Machine Con

Fila m Tool  Config

e ¥ Tool Bar E

Upgrading the Version of Interface Board

Upgrades the version of interface board program connected to PC. This function is
protected by a password. A dealer engineer will use this function if required.

Reset Interface Board

Resets the CPU on the interface board connected to PC to give the same effect as
restart.

This function is protected by a password. A dealer engineer will use this function if
required.

Communication Port

Sets communication port between PC and machine.

1. Select [Communication Port] from Configuration menu.

2. Select communication port for use.

Communication

Baud rate

|1 15200 'l
Cancel |

If the required port name
does not appear, key-in
the name.

3. Click [OK].
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Language

Changes display language.

l The following three languages are displayed as "Available Languages".

English Displays English.
Languages system uses Displays the system language of PC.
Each respective language Displays the local language.

1. Select [Language] from Configuration menu (Tool menu when the power
to machine is on).

2. Select display language among "Available Languages".

Select Language

Auvailable Laneuaeges

Enelizh - Linited States

French - France Cancel |
Japaneze - Japan

Spanish - Mexico

- Indication in
¥ Enelish

" Laneuzee systern uses

~ Each rezpective language

Select display language among
"Available Languages".

Chanege will be made after application is restarted.

When "Each respective language" is selected, the list for "Available Languages" may not be
displayed properly.

3. Click [OK].

4. Exit and rerun the software.
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Settings after Turning Power On

Describes settings available after turning power on to the machine.

Tool Bar

Shows/hides the tool bar. The tool bar contains icons with the same functions as
the menu.

Refer to page 130.

Status Bar

Shows/hides the status bar. The status bar provides information on the current
status and advice for operation.

Refer to page 131.

Zoom In
Enlarges the image to 125%.

1. Select [Zoom In] from Display menu or click gl .

Repeats zooming of the image by the number of clicks.

o)
gy gy aalx

Before selecting After selecting

Zoom Out

Reduces the image to 80%.

1. Select [Zoom Out] from Display menu or click gl .

Repeats zooming of the image by the number of clicks.

EiC) 0]
T ET iz P ) sz

Qi =Bl XIS 1 W QafE = Al XIS @ 2]
T HE L™ - T

o T —

Before selecting After selecting
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Zoom In Specified Range

Enlarges the range specified with the mouse to the full window size.

1. Select [Zoom In Specified Range] from Display menu or click E' .
The arrow pointer turns into & .

2. Drag and specify the range to zoom in with the mouse.

| T v
Wit i b [ Gmrer et don i

QEU};E@N‘?

AL [

=
(= L]

Before selecting After selecting

Fit to Window

Displays the whole embroidery area.

1. Select [Fit to Window] from View menu or click @l .

R — 211 T —
= = =T

QEQ];ET?&?

3]

A o

i g W e
ST L] (o= T

Before selecting After selecting

Whole Pattern

Displays the whole pattern.

1. Select [Whole Pattern] from View menu or click @l .

| T v 10|
Wit i b [ Gmrer et don P

?f?—f}‘ftﬁi\aﬁ‘f

= s
(= L] (o= T

Before selecting After selecting
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Grid
Displays 1 x 1 cm square grids on the background.

1.

b

Before selecting After selecting

Hoop

Displays the outline of embroidery hoop. The type of embroidery hoop can be
changed in [Load Hoop] of Settings menu.

M Embroidering is allowed within the green guide in the hoop.
1. Select [Hoop] from the View menu and put a check mark.

If the hoop is not displayed, carry out the step to read the hoop. For details, refer to [Load Hoop]
(— page 172).

| e 10| cio|
Dt i b Dt Gmrar i S i iz

QlafElHH=Bl XIQEI QDN
gordit b

Before selecting After selecting

Hoop position fine adjustment

Adjusts the view position of embroidery hoop.

H The position can be adjusted in the range of £20 mm in both the X and Y directions.

1. Select [Hoop position] from the View menu.

The hoop view position is stored in the hoop data. If you reinstall the program, the hoop view
position is initialized because it is overwritten.
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2. Designate the adjusting position and click [OK].
The hoop is displayed in a displaced position.

¥ direction (=20 - +20mm} Y direction (=20 - +20mm)

Before selecting After selecting

Needle Penetration

Chooses whether or not the needle penetration positions are displayed.
Clicking E| also provides the same function.

1. Select [Needle Penetration] from View menu and put the check mark.

Before selecting After selecting
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Thread Color

Displays the pattern using colors currently set to the needle bar. Clicking El also
provides the same function.

1. Select [Thread Color] from View menu and put the check mark.
Display color of the image changes.

AT:]
]

AT:]
Py ]

=18 =l XIS S o

Before selecting After selecting

Needle Bar and Speed Range

Displays the needle bar and speed range.

1. Select [Needle Bar and Speed Range] from View menu and put the check
mark or click @' .

Lontroller = [ECM3]

m Tool Settings  Window

= v Tool Bar
b v Status Bar

= Zoomn
‘ Zoom Qut
o Zrom In Specified Rarge
Fit to window
Whole Pattern

Grid
Hoop
Hoop Position
Meedle Penetration
¥ Thread Color

Meedle Bar and Speed Range
Grid Setting N
Back ground Color

Setting Needle Bar

Needle bar allocation and display color can be changed on this screen.

ﬁl § Ui ® Stitches 0/1608T
Standing by Mormal operation Bro8col.ecs Tubular (A1
Up | Down| Ranee 1(400-10003)  Speed Orpm 110dee.

()

I R 2o [e (6] 5]

To display needle bar |— To display embroidering
number and color sequence and color
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138

Changing display colors

l The color of needle bar changes to the actual color.

l Changing the thread spool also changes the display color. A confirmation screen
to save appears before exiting from embroidering or retrieving other data.

M A display color can be selected from among the following four items.

Basic color which can be selected screen Refer to steps 1 and 2.
on the "Color selection”

Color sample supplied by a manufacturer Refer to steps 1 and 3.
Color sample created by a user Refer to steps 1 and 3.
Adjustment of an intermediate color from the Refer to steps 1 to 7.

color sample supplied by a manufacturer or
naming and registration of a newly created color

H The following screen is displayed when colors to be displayed are set to 256 in
[Display properties] and the color sample supplied by a manufacturer cannot be

selected or an intermediate color cannot be created.

it is not available of medium calor in 256 colors system

MNumber of sewing sequence |3 _I::' - Ied it colar |

It is not available to designate the color name of maker in 256 calors system.

haker name Color

MADEIRA
User

Additier |
[Veletion |

Cancel

1. Double-click the thread spool or needle bar number.

§||§§T| | Ui | Q Stitches 071608
Standing by Marmal operation BroZcol.ecs Tubular (Al
p | Downl Range 16400-1000}  Speed Orpm 110dee.

(O

EIEEE T EEEEEE [0 ] [o]5]4]3]]
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Select a new color on the [Color selection] screen.

The needle bar number can

hanged.
Meedle bar numbe =1 - NT—— be changed

Maker name Calor

MADEIRA
User

Additicn |
D letion |

T Cancel |

When selecting a color from a color sample, click maker name or [User]
and double click [Color].

Mumber of sewing sequance |4 _I:j' - Medium calor

Maker name Calor

Dkst Mawy 1244 ﬂ
Diark Mavy 1044

Med Mawy 1043 Addition |

Mawy 1243

Lt Mawy 1242 [MelEtian |

Dark Delft Blue 1167
Lt Delft Blue 1030 |L|

oK | Carcel |

User

When finely adjusting the selected color, click [Medium color].
Click [User] to crate a new color, then click [Addition].

Meedle bar number |5 _I; - Medium calor

Maker name Color
MADEIRA
Addition |
[eletion |
Ok I Cancel
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5. Select an arbitrary color from basic colors.

Click [Define Custom Colors] to create a medium color.
Color m

Basic colors:

Define Custom Colors »> |

oK I Cancel |

6. Click the color chart or enter values to create a new color, and click [OK].
Color m

Basic colors:

4
Drag here to adjust
brightness.
Hug: IlDD BBdZIU
Sat |24n Green: |255 Displays data of the
| Define Custorm Colors > | coonSald |y [0 pweifize | selected color

(0] I Cancel | Add to Custom Colors |

7. Input the name of the color and click [OK] when [User] is selected in step 4.

Inputting a line of characters |

Input color namefwithin 265 characters)

Cancel |

Changing needle bar allocation

1. Drag a thread spool to the desired needle bar number.

This thread spool has been dragged
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Setting Ranges

There are two methods for setting ranges.

B

Standing by Mormal operation

L Down | Ranee

1{400-10003

0/ 1604r

Brofcol.ecs Tubular (Al
Orpm 110dee

DD
oo e 1 [o]o]2]3]2]

one

level.

one level.

I—AII ranges are reduced by

All ranges are increased by

Changing all ranges

Displays each thread
bar range.

L— When "S" is shown, it is under suspension.

1. Click [Up] to increase range. Click [Down] to reduce range.
One clicking changes the range by one level.

din Mormal operation

Up | Daown | Rangee

1{400-10003

016038

Brofcal.ecs Tubular (Al
Orpm 110deg.

12 1110 9 §d

000000¢

2[0[o]8]7[6[5]4]3]2]]

Changing individual range

1. Double-click the range display.

2. Click a speed range for selection.

Speed Range ECMI1

Speed range  Speed (rpm}

(el
(ol
(ol
@4
5
s

400-800
400-700
400-600
400-500
400-450
400-400

™ Pauze

GCancel

Click here to put a check mark for pause before starting
the designated embroidering sequence.

3. Click [OK].
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Grid Setting
Sets the pitch and the color of grid.

M The grid interval can be set at the increment of 1 mm (0.1 inch for inch unit).
H The value for setting is 1 - 100 mm (0.1 - 10 inches for inch unit).

1. Select [Grid setting] from the View menu.

Tool Settings  Window
* Tool Bar |
« Status Bar

Zoom In
Zoom Dut

= B TP

Zoom In Specified Rangs
Eit ta mindow
Whole Pattern

Grid
= e L
Haop Position

Meedle Peretration

Thread Color

T .

Back ground Color

2. Set the pitch.
Click the [color] to change the grid color. For setting, refer to steps 5 to 7 in page 140.

iteh |Ilil—d - Click this to increase or decrease
pite B mm (1-100) the value.
Color |

Ok | Cancel

Background color

Changes the background color of the data.

1. Select [Background color] from the [View] menu.

antrollar

Tool  Settings  Window E

* Tool Bar
* Status Bar

Zoom In
Zaom Dut

R T

Zoom In Specified Rangs
Eit to window
Whole Pattern

Girid

Hoop

Hgop Position
Meadle Penetrstion
Thread Color

Meadle Bar and Speed Range
Grid Setting
Back.

142 BES-962BC « BES-1262BC



Chapter 6 Embroidering

2. Select or create the background color. Refer to steps 5 to 7 on page 140

for details.

m—
QlefElFH=] el XSSV @ BN
2 S

............

Before changing the background color

Renaming Machine

Rename the registered machine.

After changing the background color

Il Up to 50 half-size (25 full-size) characters can be registered for a machine name.

1. Select [Rename Machine] from Machine menu.

2. Enter a new name.

Enter a new name for embroidery machine
(50 characters max)

[ECMd]

3. Click [OK].

Select an identifying color for the
machine.

This color is shown on the title bar
for a while when the arrow pointer is
moved to the title bar of a machine
window.

If the message "The entered name already exists" appears, enter another name.
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Viewing Machine Information

Detail specification of the machine can be displayed.

1. Select [Machine Information] from Machine menu.

2. Click [OK] after checking the information.

Machine Information

Maodzl: BES-1262BC
Main GPU ROM wersion: 98 W

Hoop contral data table version T

Lower shaft GPL ROM version: 82 H2

Upper shaft CPU ROM version 66

I¥F CPU ROM version 76

Na. of machine heads: fi

Mo. of stitches to be performed by each head 12
Max. hoop mavement after thread trirmming: 0

Max. rovable range of flat frame:

{when wide area) -300.1,-99.1 :193.9, 350 9mm

Max. movsble range of flat frame:

(when all heads are used) -210.1 . -99.1 : 200.9, 360 9mm

Itax. movable range of wide cap frame: -180.1, -35.1:179.9, 59.9mm

Max. movable range of semi wide cap frame =001, -361:89.9  B9.9mm

Design Information

Detail specification of the embroidery data can be checked.

Pattern name File name and path of embroidery data

No. of stitches The number of stitches in embroidery data
No. of colors The number of colors used in embroidery data
Mask Size Size of masking

Start of Embroidering Coordinates of embroidering start position

End of Embroidering Coordinates of embroidering end position

1. Select [Design Information] from Help menu or click % i\

2. After checking, click [OK].

Setting Window Display

Specifies the window that displays machine condition if multiple machines are
connected simultaneously.

H There are two types of window display as follows:

Cascade Windows are slightly offset.

Tile Windows are tiled.
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Select [Cascade] or [Tile] from Window menu.

T
iings M Help

Cascade
Tile
Arrange lcons

[l

1 ECh1
2 EChzZ

P

oy
L il

When [Cascade] is selected When [Tile] is selected

Minimizing and Aligning Windows

Windows on the screen can be minimized to the icon size and aligned.

Minimize Window Size

1.

Select [Minimize Window Size] from Machine menu or click =] on the
upper right corner of the screen.

|

eration  Wiew Tool S

Cirl+s n
<

Machine Information

Click here.

Bename Machine

Exit

The window is minimized.

Maching Cpardtion Ykw Iool Settings Wiedoe Hol

QA= 8 =] X/OERY[ | 21N

|For Hawy pegaer — |;oscommect| [ (|
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Arrange Icons

Minimized windows that are scattered can be aligned.
Bl This command is available for minimized windows.

1. Select [Arrange Icons] from Window menu.

Maching Cpardtion Ykw Iool Settings Wiedoe Hol

QA= 8 =] X/OERY[ | 21N

[For Holg gzt |oecownect| [ (e[

2. The minimized windows are aligned.

Maching Cpardtion Ykw Iool Settings Wiedoe Hol

QA= 8 =] X/OERY[ | 21N

|For Hawy pegaer — |;oscommect| [ (|

Changing window size

Several square buttons with figures are displayed at the right end of the title
bar. These buttons are used to change the window size.

If this button is clicked when running an ordinary software, it is displayed
on the task bar in the minimized size as a button.

|

If this button is clicked, the window size changes to a medium size.

g &

If this button is clicked, the window changes to the full size of the
desktop.

This button is used to end the software or to close the folder. This
button cannot be clicked when the machine window is displayed.

x
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Language

Changes display language.

Refer to page 132.

Copying Data to Other Machines
When multiple machines are connected, the embroidery data of a machine can be

copied to another machine.

1. Click the window of the machine displaying the copy source data.

ME E

QQIEFE=]8 ] XIQEEYR S22
R . | -]
= - —

eperatian Enmkatacs Tubular 0 Standne by Hhnmal cpsratian Tubnbr 1)
101000} Speed Orpen T1odee. W | Down] Reese 101000} Speed Orpen T1odee.

) | — _lJ

= _—

For Hulp, praxs Fi CAECONECT
2. Click .

e [ [O1=]
Eicl ra

Eackatacs Tubuar S0

ratiin
THOO-1000)  Spaed Drpen 11008

3. Click and select the machine name of the destination.

Copy Data

[ ECM2
M ECM3

[~ EChM4

Cancel |
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4. Click [OK].

I ECM3

I EChi4

et |

The data, is copied.

Wechs Gpwdion S Jool S M Hab

@afiEfH:-= 8 = XSEEIV:@__"? A?

) |
Hor ral opeiin T Har rad operaikn I

Fox Pk prams 1 CrCOEST

Configuration

Sets the environment of data reading and display.

1. Select [Configuration] from Tool menu.

2. Click and select the item for setting.

Configuration

Units of length

Woltage
(:. .
 AG2O0Y Select thle applicable
© AG220V power vo tage,
¥ Speed chanee (depends on ermbroidery rachine). ©AGTI0N
™ Golor palette {(depends on thread color).  AG240V

[™ Inzert pause code when the same needle is used for subsequent different colors

W When reading file, Micro Stitch is eliminated.
Leneth (0.0—1.0)'0.3 EZ mm
Ok I Gancel | Default |

I Click here to the default
setting.

[When reading file, Micro Stitch is eliminated.] is set to be deleted in default status (checked).

3. Click [OK].

Upgrading the Machine Program

Upgrades the programs at each part of the machine.

This function is protected by a password. A dealer engineer will use this function if
required.
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Setting the Machine

Performs the detail setting of the embroidering status. Items that can be selected in Setting menu are
explained here.

Needle Bar

Patterns are sewn by one needle.

1. Select the [Needle]-[Same Needle] from Settings menu.

2. Click the needle number for selection.

Select Needle Bar

Select a needle bar number, and click OK.

o | concer_|

3. Click [OK].

The embroidering sequence appears at all specified needle points.

I} Machine Operation Yiew Tool Settings Window Help =] x|

X Q7 &1 282

mal operation Basket.ecs Border (AllY
16400-500)  Speed QOrpm 110dee.
B
Y )
L A
~\\H
- =
| | _>l_I
Mormal operatian

[For Help. pres= F1 DISCONNECT | I | I

Default setting (equating the sewing order number and needle bar number)

1. Select [Needle] - [Default] from Settings menu.

BES-962BC « BES-1262BC 149



Chapter 6 Embroidering

Same Speed Range

Embroiders patterns at the specified speed range.

1. Select [Same Speed Range] from Settings menu.

2. Click a speed range for selection.

Speed Range ECMI

Speed range  Speed (rpm)
(O 400-1000

o2 400-900
(o} 400-800
4 400-700

5 400-600
6 400-500

¥ Pauze

GCancel |

3. Click [OK].

The speed range appears at the specified areas.

Q=8 XIOEvIH 2 —
E!.l‘ﬂ@':"' s

uuuuu

Pause

Sets whether to stop the needle bars temporarily when changing all the needle bars.

Stopping all the needle bars temporarily

1. Select [Pause] - [Add all] from Settings menu.

Resetting temporary stop of all the needle bars

1. Select [Pause] - [Delete all] from Settings menu.
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Speed Range

Specifies the maximum speeds for respective ranges suitable for the hoop type.

M Actual embroidering speed depends on the pitch.

Il Before shipment, "1" is set to the highest speed; "6" is set to the lowest speed.

1. Select [Speed Range] from Settings menu.

2. Specify the desired range.

Speed Range ECM1
Range  Minimum Maxirnurm  {rprad
1 [400 [1o00 {400-1000}
2 |400 | 000 {400-9007
3 [400 Jaoo {400-800)
4 [400 |00 (400700}
5y |400 | GO0 {A00-6003
f [400 |500 {400-500)

GCancel |

Indicates ranges of
the current setting.

When a value exceeding the above ranges is entered, it is automatically set to the min. or max.

speed.

3. Click [OK].

Head Operation Suspend

Sets the machine head for rest.

M Setting at the machine head has priority.

Hl When the HEAD switch at the machine head is set to ON and then to OFF, the

setting is canceled.

1. Select [Head Operation Suspend] from Settings menu.

2. Click the machine head that needs to be at rest and remove the check mark.

Head to Stop ECHI

Remove the check mark of machine head you do not want to

cancer_|

3. Click [OK].

BES-962BC « BES-1262BC

Head operation suspend

151



Chapter 6 Embroidering

Hoop Feed Position

Set the basic position of the hoop (hoop feed position) for cancellation of
embroidering.

Il The hoop feed position can be set only in the embroidering area surrounded by a
red frame.

1. Select [Hoop Feed Position] from Settings menu.

2. Click the point to feed the hoop.

Ditmiin eepiss o Dol emrar b i b=l

QO[T =] Blal XIQEI N & W2

Hood feed position

3. The gray cross appears and shows the hoop feed position.

=
aleizl

by
GleREF =] Al X Ol &7 ]
B EE .

T W

Embroidery Area

Sets the embroidery area.

1. Select [Embroidery Area] from Settings menu.

2. Drag the embroidery area using the mouse for designation.

The embroidery area is displayed in light blue.
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Embroidery Hoop
The type of specified embroidery hoop changes the display.

H The following selections are available:

Tubular (All)

Tubular (1, 3, 5)

Flat (All)

Flat (1, 3, 5)

Border (All)

Border (1, 3, 5)

Wide cap frame

Semi-wide cap frame (All)

1. Select [Embroidery Hoop] and the type from Settings menu.

Window Help

| Same Speed Range E V|%| &E
. Pause 3 -

-

Speed Range
Head Operation Suspend
Hoop Feed Position

Embroidery Area
Embroidery Hoop

[+ Tubular 10
Tubular ©1,35)

Thread Trimming
Boring

. Thread Breakage Sensor Flat £1,35)

Automatic Step Back Border (AID
Automatic Hoop Feed Border (1,35)
End of embroidery Wide Cap (A1)

Mending

Adjust

Activating speed up of driving shaft
Activate escape with pause.

Short stitch speed reduction.

Thin one ¢ thick one

Area Trace

Semi—wide Cap (A0

Default Settings
Show Setting
Load Setting
Sawe Setting
Load Hoop

The pattern direction and embroidering area may vary depending on the selected embroidery
hoop type. Make sure that the selection is correct.

M When "Tubular (All)" is selected

B Mo Gwaion o T Setrgs Bk

1] 0]
i
o oo

Farge | AHODWON Spesd  Orpmiloder

Q@E =0 = o= O oN

[rp
Fo i g 1
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B When "Tubular (1, 3, 5)" is selected

e
@ QfEFH=]8 = XIS & 7|
L Tufol™ ;

3

o i
For Pk razs F1 BOONNEET

l When "Flat (All)" is selected

W bt dpwatin S ol feega Bnie fnk

@e|EHH= =] XIS YN & 2K
2] s —

Esbeiace Fht (1}
am Farge Al Spaed irpm g

o o
For Pk razs 1 DECONNEET.

Hl When "Flat (1, 3, 5)" is selected

0 fhven fpmatin Yo Jool Gtngs i

=1B/=1 X/Slmvi/ S

ol o
For Pk reza i

Il When "Border (All)" is selected

D — . ] Frrl
gﬁﬁ@ﬁaaEAQEME@mw
BHBHE S =

ey by T eparain
o [l P R0 St

Estetacs Bortes
Urpm 10k

o i
For Pk raas 1
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Il When "Border (1, 3, 5)" is selected

S >
@ EF = 8= XIS & 7k

23|
o e T 00 et

Eahetate By 135
Orem 1o

e spien,
Fo ke 1 oecenrEST

Il When "Wide cap (All)" is selected

30 Mchina Gpwaton fen T Setngs Sdw Hab =lslx]|

QQ“EEEEQ == X QY% 6] 7 N2

£ [8[sf™ -
Tt i

e e it o
b 0Dt T S ot

@

@ . The image is displayed upside down.
| The speed is automatically adjusted to

800 rpm or less.

i pet = 1335 0 e
For Pt prams 1 T

l When "Semi-wide cap (All)" is selected

30 Mhckie Gwaton om Tl Getigs ok b =181 %]

QGWEEEEE E“?:‘_GEE'V;E: i P

[l [l
| e | Damn| Fore U050 Zpuacd rpen 16y
@ The image is displayed upside down.
| The speed is automatically adjusted to
800 rpm or less.
H
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Thread Trimming

H The following items can be set:

Enable inching

Sets inching motion for thread trimming.

Hoop movement after
thread trimming

Sets the needle penetration length for trimming.
The length can be set in inches. To set the length in inch
unit, select [Inch] from the [Configuration] of Tool menu.
The available values are as follows:
For mm 0-100 mm (The standard value is 15 mm.)
Forinch 0 -3.9inch (The standard value is 0.6 inch.)

Thread length
(1-10) for all machines

Sets the overall thread amount through the needle.
Value of 1 to 10 can be set. The smaller the value is, the
shorter the length is.

Thread length after
thread trimming

Sets the overall thread amount through the needle.
Value of 1 to 10 can be set. The smaller the value is,
the shorter the length is.

1. Select [Thread Trimming] from Settings menu.

2. Setinching, thread length, etc.

Trimming EC

Hoop movement after thread trimming

[15 = rom 1003

Thread leneth {1 - 10} for all needles
I |

— Thread length after thread trimming

10 9 8 7

F 25 = = = =f o = =

i ] 4 3 2 1

12 11

F s

GCancel

3. Click [OK].
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Boring

Turns on/off the machine boring mode.

H The following items can be set:

Boring Sets ON/OFF of boring.

Shift data Shifts data by 15 mm to needle number 1. The screen display remains unchanged.

l Boring can be set only for embroidery data which is prepared for boring. Make
sure that the data is correct before embroidering.

M Install the following optional parts on the machine before embroidering.
* Boring knife
* Needle plate for boring

M If the embroidery data for boring is zoomed in or out, or is rotated, embroidering
may not be correctly carried out.

1. Select [Boring] from Settings menu.
When the boring mode is on, the check mark (/) appears at the top of [Boring] in the menu.

1]

Settings DL

L Masde g
5| GemeiGpesd Range

- Pause 3
Speed Rang=
Haad Operation Suspend
Haop Ee=d Pasition

Enbroidery frea
Embraidery Hop »
Thread Trimming

Thread Breskags Sensor
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending
Adiust
Aetivating speed up of driving shaft
+ hotivate sscape with pause
Shart stitch speed reduction,
Thinane ¢ thisk ane
Ares Trace 3

Defaukt Settings
Shaw Setting
Lgad Setting
Sape Setting
Load Hoop

2. Click the setting item to put the check mark.

[ Boring
™ Shift data
Cancel
3. Click [OK].
V Boring
7 Shift data

Ok | Cancel
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Thread Breakage Sensor

The sensor for thread breakage can be turned ON/OFF or the sensor sensitivity for
each needle bar can be set.

H The sensitivity can be set within the range of 1 - 100. The smaller the value is,

1.

2.

3.

4.

the higher the sensitivity is.

Select [Thread Breakage Sensor] from Setting menu.

Click the head you want to disable the sensor and remove the check mark (v).

Thread Breakage S Setting ECM1

Remove the check mark of machine head for
which you want to deactivate the thread breakaege

Senzitivity 1 (High) - 100 (Law}

10 o g 7 & 5 4 3 2 1

e e e e e e e [ e
12 11
o =fc <

for all needles 2
10 ZI Ok | Gancel |

Adjust the sensor sensitivity.

Thread Break
Remove the check mark of machine head for
which you want to deactivate the thread breakaege

Senzitivity 1 (High) - 100 (Law}

10 o g 7 & 5 4 3 2 1

e e e e e e e [ e
12 11
o =fc <

for all needles 2
|10 ZI Ok | Gancel |

Click [OK].
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Automatic Step Back

Sets the number of stitches for automatic step back if thread breakage occurs.

H The number of stitches that can be set is from 0 to 255.
M Additional step-back can be made for sensitivity value of the thread breakage sensor.

1.

2.

Automatic Step Back

Enter the number of backward steps.

.

Select [Automatic Step Back] from Settings menu.

Enter the number of stitches for automatic step back.

|5 ,:‘te
|apree

V Add thread breakage sensor sensitivity stitchies ) —

Ok I GCancel

Click here, and the value decreases/increases.

— Click here to give additional step-back for the
sensing distance with the thread breakage sensor.

Automatic Hoop Feed

Click [OK].

Sets automatic hoop feed for a thread breakage.

1.

(v)-

Meedle 3
Same speed Range J
E

Pause 3
Speed Range

Head Cperation Suspend

Hoop Feed Position

Embraoidery Area

Embroidery Hoop 3
Thread Trimming

Boring

Thread Breakage Sensar

Automatic Step Back

Automatic Hoop Feed

End of embroidery k
Mending

Adjust

Activating speed up of driving shaft

Activate escape with pause.

Short stitch speed reduction.

Thin one £ thick one

Area Trace 3

Default Settings
Show Setting
Load Setting
Save Setting

Load Hoop
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End of embroidery

Sets if the machine returns to the start point after end of embroidery.

1. Select [End of embroidery] from Settings menu.

Same speed Range
Pause 3

=i

Speed Range
Head Cperation Suspend
Hoop Feed Position

e

Embraoidery Area

Embroidery Hoop 3
Thread Trimming

~  Boring

Thread Breakage Sensar

Automatic Step Back

Automatic Hoop Feed

Mending !

Adjust
Activating speed up of driving shaft
¥ Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one
Area Trace 3

Default Settings
Show Setting
Load Setting
Save Setting

Load Hoop

2. Click the checkbox to put a check mark (/) when the machine returns to
the start point after end of embroidery. Click [OK].

End of Embroidery

¥ Embroidery hoop will return to the start point after embroidering is completed.

Cancel |
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Mending

Sets the details of mending.

M Items and descriptions are as follows:

Automatically reset
breakage error

Error is automatically canceled when a thread
breakage occurs.

Thread entangled error
to rotary hook

Selects how to reset the rotary hook thread
entanglement error.

After the end of mending

Sets whether to stop or suspend the needle bar at
the mending end position.

Raise the presser foot when
clearing a thread trimming error

Raises the presser foot when resetting the thread
trimming error.

Stitches before mending

Sets the number of stitches for stopping before
mending. The values for setting are 1 - 10.

When the machine is stopped

Selects how the trimming is made during stopping.

Insert lock stitch at the beginning
of sewing after thread breakage

Automatically conducts lock stitch when trimming
thread.

1. Select [Mending] from Settings menu.

Pause 3

Meedle 3 v
Same speed Range
=

Speed Range

Head Cperation Suspend
Hoop Feed Position
Embraoidery Area
Embroidery Hoop 3
Thread Trimming

Boring

Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery

Adjust
Activating speed up of driving shaft
¥ Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one
Area Trace 3

Default Settings
Show Setting
Load Setting
Save Setting

Load Hoop
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2. Click [OK] when the items are set.

 Thread entaneled error ta ratary hook

& Manual cancellation of error
 Autornatic cancellation of error
{~ Automatic retry {only when beginning to sew)

—After the end of mending
* Pauze

~ After pause ctart autoratic
" Non stop

¥ Raize the preszer foot when clearing a thread breakaze error.

IT ﬂ Stitches before mending ©-10)

When the machine iz stopped

@ Mo trim

" Trim upper and lower threads

= Tritn lower thread only

[ Insert lock stitch at the besinning of sewing fter thread breakaze

Manually trim the lower thread immediately after resetting a thread breakage error if feeding by
stitch back is long (i.e., 40 to 50 mm or more) when "After the end of mending" is set to "Non
stop”.

Set "When the machine is stopped" to "Trim lower theread only".

Adjust
Adjustment value of the needle is set.
H The adjustment value is set at the increment of 0.1 mm.

H The setting range is —0.5 ~2 mm in X and Y directions.

1. Select [Adjust] from Settings menu.

-

Pause

B L
= 2ame sSpeed|Hanee
k=3

Speed Range

Head Cperation Suspend

Hoop Feed Position
1t Embroidery frea
Embroidery Hoop 3
Thread Trimming
Boring
Thread Brezskage Sensor
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending

Activating speed up of drwang shaft

Botivate escape with pause.
Short stitch speed reduction.
Thin one ¢ thick ane

Area Trace »

LDefault Settings
Show Setting
Load Setting
Save Setting

Load Hoop

2. When setting is complete, click [OK].

Width

¥ direction (-0.5 - +2.0) Y direction (-0.5 - +2.0)

L O -

Ok I Gancel |
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Activating speed up of driving shaft

Speeds up the startup of the main shaft. Select this function when sewing thick
material.

check it.

ol Window Help

Same speed Range
Pause

Speed Range

Head Cperation Suspend
Hoop Feed Position
Embraoidery Area
Embroidery Hoop
Thread Trimming

Boring

Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending

Adjust

Activating speed up of driving shaft k

Activate escape with pause.
Short stitch speed reduction.

Thin one £ thick one
Area Trace

Default Settings
Show Setting
Load Setting
Save Setting
Load Hoop

Activate escape with pause

Select [Activating speed up of driving shaft] from Settings menu and

Sets whether to feed the hoop during temporary stop of the needle bars to change

colors. Select this function when embroidering applique.

1.

L - -

[LEEl Window Help
Meedle
Same speed Range
Pause
Speed Range
Head Cperation Suspend
Hoop Feed Position
Embraoidery Area
Embroidery Hoop
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending
Adjust

Activating speed up of driving shaft
L with pause. \
Short stitch speed reduction.

Thin one £ thick one
Area Trace

Default Settings
Show Setting
Load Setting
Save Setting
Load Hoop
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Short stitch speed reduction

Reduces speed when stitching in a designated pitch.

H The pitch can be designated between 0.0 and 2.0 mm in units of 0.1 mm.
l The speed can be set between 400 rpm and the maximum speed of the current
hoop in units of 10 rpm.

1. Select [Short stitch speed reduction] from Settings menu.

| s

B F
o =ame zpeed Hange

=3

Pause 3

Speed Range
Head Cperation Suspend
Hoop Feed Position
Of Embraidery &rea
Embroidery Hoop 3
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery

Mending
Adjust
Activating speed up of driving shaft

Area Trace 3

Default Settings
Show Setting
Load Setting
Save Setting
Load Hoop

2. Click [Reducing speed] to check it and click [OK] when items are set.

Short stitch speed reduction.

10 ~ mimiQ-2.00 200 = rpmid 00 - 800

ok | GANGEL |
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Thin Material or Thick Material

Adjusts the timing of needle drop and hoop movement.

H The value can be designated between 95 and 125 degrees in units of 1 degree.

2.

The smaller values are suitable for thick material and the larger ones are suitable
for thin material.

Select [Thin material or thick material] from Settings menu.

Meedle
Same speed Range

Pause

Speed Range

Head Cperation Suspend
Hoop Feed Position

Of Embraidery &rea
Embroidery Hoop
Thread Trimming

Boring

Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed

End of embroidery
Mending
Adjust

Activating speed up of driving shaft
Activate escape with pause.
Short stitch speed reduction.

Thin one / thick one

Area Trace

Default Settings
Show Setting
Load Setting
Save Setting
Load Hoop

Adjust the value by moving the slide bar control. Click [OK] when it is set.

Thin ane / thick one

thick

The selected value
is displayed.

Clicking this button

default walue ]

Cancel |
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will reset the value to
the standard one
(110).
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Area Trace

Select the outside shape of area tracing before starting sewing.

Bl The following two types can be selected. The selected outside shape is displayed
on the screen.

@ QJfaIH: = 8= XIS & 71N
AT [R]Sf™ -
£ 7 Bashatecs Wi (58
_Up [Domn] Lo 10300-1 000 TREE a1 Ok
=
ly o
Rectangle Octagon

1. Select the outside shape of [Area trace] from Settings menu and check it.

Pause 3

Speed Range
Head Cperation Suspend

E
o Same Speed Range i V
= —
=
0K

Hoop Feed Position
400 Embroidery Area
Embroidery Hoop 3
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending
Adjust
Activating speed up of driving shaft
Activate escape with pause.

Short stitch speed reduction.
Thin one £ thick one

Area Trace * 4 corner
Default Settings

Show Setting
Load Setting
Save Setting
Load Hoop

g & 9T
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Default Settings

Resets changes of the machine setting to the default.

M Items for setting and initialization are as follows:

Speed Range

Automatically selects the value suitable for the hoop type.

Head Operation Suspend

Cancels the head operation which is not set for rest on
the machine.

Hoop Feed Position

Returns to the machine home position.

Embroidering Area

Sets the size each for the selected hoop.

Thread Trimming Inching motion Yes
Thread removal feed length 15 mm (0.6 inch)
Thread remaining amount 5

Boring Boring No
Data shift No

Thread Breakage Sensor

All sensors are on.
Sensitivity 10

Automatic Step Back

0

Thread Breakage
Sensor Sensitivity

Not affected by the thread breakage sensor sensitivity

Automatic Feed Hoop No

Return to the start point Yes

Mending Automatically rest breakage error No
Automatically reset the rotary hook thread entanglement error ~ No
Raise the presser foot when resetting the thread trimming error ~ Yes
Stop the machine at the mending end position  Yes
Stitches before mending 1 stitch
Trim during stop in mending setting No
Conduct lock stitch when trimming thread No

Adjustment 0.0 mm for X direction
0.0 mm for Y direction

Speeding up startup of the main shaft No

Hoop feed during temporary stop for color change No

Reducing speed in a small pitch No

Thin material or thick material

110 degrees

Area Trace

"Four-sided" is selected.
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1. Select [Default Settings] from Settings menu.

: Meedle 3
= Same Speed Range
= =

Pause 3

Speed Range
Head Cperation Suspend
Hoop Feed Position L
2 Embroidery Area
Embroidery Hoop 3
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending
Adjust
Activating speed up of driving shaft
Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one
Area Trace 3

Default & gs \
Show Setting
Load Setting
Save Setting

Load Hoop
& St T

2. Click [OK].

Show Setting

Shows the setting contents and defaults.

H The following items are shown:
* Embroidering area
* Thread trimming inching motion
» Thread removal feed length
* Boring
* Shift
» Thread breakage sensor sensitivity
» Automatic step back
» Automatic feed hoop
 Return to the stant point
» Speed up after starting the main shaft
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1. Select [Show Setting] from Settings menu.

2. After checking, click [OK].

Contents ECMI
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Load Setting
Load the setting.

B The set file has an extension of "ecm".

1. Select [Load setting] from Settings menu.

Window  Help

: Meedle 3 F
o Same Speed Range
=

-

Pause
Speed Range
Head Cperation Suspend
Hoop Feed Position L
400 Embroidery Area %
Embroidery Hoop 3
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed
End of embroidery
Mending
Adjust
Activating speed up of driving shaft
Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one
Area Trace 3

Default Settings
Show Setting

Save Setting
Load Hoop
& AEERCE v

2. Select the folder and click [Open].
Open m

Laak jn: Iabrother_soft ﬂ gl

brother F 00000001 ecm

Data 00000002, ecm

data? {1 00000003.ecm

hoop 00000004 .ecm

Log

temp

Werup

File name: Open

Files af type: ISetting Filelk ecm) LI — |
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Save Setting

Saves the edit settings.

H Save the setting files with an extension of "ecm"”.
1. Change the setting.

2. Select [Save setting] from Settings menu.

M Window Help

= » F
o Same Speed Range

Pause

-

es Speed Range
Head Cperation Suspend
Hoop Feed Position L
401 Embroidery Area %
Embroidery Hoop 3
Thread Trimming
Boring
Thread Breakage Sensar
Automatic Step Back
futomatic Haop Feed
End of embroidery
Mending
Adjust
Activating speed up of driving shaft
Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one
Area Trace 3

Default Settings
Show Setting
Load Setting

Load Hoop

= - aary I

3. Select the registration folder and put a file name.
Save As m

Look in: Iabrother_soft j gl ot

brother F 00000001 ecm

Data 00000002, ecm

data? {1 00000003.ecm

hoop 00000004 .ecm

Log

temp

Werup

File name: Open

Files af type: ISetting Filelk ecm) LI — |

4. Click [Save].
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Load Hoop
Load the optional hoop displayed in "Hoop".

l The hoop file to be loaded has an extension of "ehp".
H The types and the shapes of hoop for loading are as follows:

Round frame

ROUND_FRAME21.ehp — T ROUND_FRAME25.ehp

Square frame

SQUARE_FRAME24X24.ehp 4 | K SQUARE_FRAME45X23.ehp

SQUARE_FRAME45X27.ehp SQUARE_FRAME45X32.ehp

Spider net frame

SPIDER_NET_FRAMEQ5B-1.ehp SPIDER_NET_FRAMEQ5B-2.ehp

SPIDER_NET_FRAMEQ5B-3.ehp SPIDER_NET FRAMEOSB-4ehp | 0%’

SPIDER_NET_FRAMEO7T-Lehp SPIDER_NET_FRAMEO7T-2.ehp

SPIDER_NET_FRAMEO7T-3.ehp SPIDER_NET_FRAMEO7T-4.ehp

SPIDER_NET_FRAMEQ7B-1.ehp SPIDER_NET_FRAMEQ7B-2.¢hp
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SPIDER_NET_FRAMEQ7B-3.ehp

SPIDER_NET_FRAMEQ7B-4.¢hp

SPIDER_NET_FRAMEQ9T-1.ehp

SPIDER_NET_FRAMEQ9T-2.ehp

SPIDER_NET_FRAMEQ9T-3.ehp

SPIDER_NET_FRAMEQ9T-4.ehp

SPIDER_NET_FRAME10B-1.ehp

SPIDER_NET_FRAME10B-2.ehp

SPIDER_NET_FRAME10B-3.ehp

SPIDER_NET_FRAME10B-4.ehp

SPIDER_NET_FRAME12T-1.ehp

SPIDER_NET_FRAME12T-2.ehp

SPIDER_NET_FRAME12T-3.ehp

SPIDER_NET_FRAME12T-4.ehp

SPIDER_NET_FRAME13B-1.ehp

SPIDER_NET_FRAME13B-2.ehp

SPIDER_NET_FRAME13B-3.ehp

SPIDER_NET_FRAME13B-4.ehp

SPIDER_NET_FRAME15T-1.ehp

SPIDER_NET_FRAME15T-2.ehp

SPIDER_NET_FRAME15T-3.ehp

SPIDER_NET_FRAME15T-4.ehp

SPIDER_NET_FRAME16B-1.ehp

SPIDER_NET_FRAME16B-2.ehp
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173



Chapter 6 Embroidering

SPIDER_NET_FRAME16B-3.ehp SPIDER_NET_FRAME16B-4.¢hp

SPIDER_NET_FRAME18T-1.ehp B SPIDER_NET_FRAME18T-2.ehp ]

SPIDER_NET_FRAME18T-3.ehp SPIDER_NET_FRAME18T-4.ehp (5= ¢

SPIDER_NET_FRAME19B.ehp

Tubular frame

TUBULAR_FRAME-05.ehp TUBULAR_FRAME-07.ehp

TUBULAR_FRAME-10.ehp O TUBULAR_FRAME-13.ehp
TUBULAR_FRAME-16.ehp 17 il TUBULAR FraME-19eh |
TUBULAR FRAMEZSX246hD ) _ TUBULAR_FRAME23X43.ehp T
TUBULAR_FRAME28X30.ehp | TUBULAR_FRAME30X28.ehp T
TUBULAR_FRAME30X43.ehp '. T TUBULAR_FRAME30X48.ehp i/ ]

TUBULAR_FRAME40X43.ehp
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Holder base frame

HOLDER_BASE23X24.ehp || | | HOLDER_BASE23X43.ehp

HOLDER_BASE30X28.ehp || _ HOLDER_BASE30X43.ehp

HOLDER_BASE30X48.ehp 1 HOLDER_BASE40X43.ehp

Tubular round frame

TUBULAR_ROUNDO7.ehp =] TUBULAR_ROUNDO9.ehp t
TUBULAR_ROUND12.ehp (= TUBULAR_ROUND15.ehp
TUBULAR_ROUND18.ehp )i= TUBULAR_ROUND24X24.ehp |
TUBULAR_ROUND24X30.ehp ‘_ j TUBULAR_ROUND30X30.ehp

TUBULAR_ROUND32X45.ehp ) TUBULAR_ROUND335X453.ehp
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2.

Cap frame semi-wide frame

Cap frame semi-wide.ehp

I
[

=,

&

Cap frame wide frame

Cap frame wide.ehp

Select [Load hoop] from Settings menu.

Window  Help

Meedle
Same Speed Range

Pause

Speed Range

Head Cperation Suspend
Hoop Feed Position
Embraoidery Area

Embroidery Hoop

Thread Trimming

Boring

Thread Breakage Sensar
Automatic Step Back
Automatic Hoop Feed

End of embroidery

Mending

Adjust

Activating speed up of driving shaft
Activate escape with pause.
Short stitch speed reduction.
Thin one £ thick one

Area Trace

1=

Default Settings
Show Setting
Load Setting
Save Setting

Select the folder and click [Open].

S = & il

FR ; HOLDER_BASE3D:dG.chp SFPIDEF
CaP_FRAME WIDE.ehp HOLDER_BASE40:43.chp SPIDEF
HOLDER_BASEZ3:24.chp ROUND_FRAMER] ehp SPIDEF
HOLDER_BASEZ3x43.chp ROUMD_F R MERS ehp SPIDEF
HOLDER_EASE3N:28.2hp SPIDER_MET_FRAMEOS-1.2hp SPIDEF
HOLDER_EASE3Nx43.2hp SPIDER_MET_FRAMENS-2.ehp SPIDEF
i

File name: |CAP_FRAME_SEMI_WIDE.ehp Open I
Files of type:  [Hoop Filetkehp) =l Tenzel |
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Embroidering

How to start embroidering and operation after the start are explained here.

Starting Embroidering

H The following screen appears when the edit data is retrieved from the explorer.

To run the embroidery data explorer

To run the embroidery data editor

To copy the current data to other linked machines

To start embroidering

To suspend embroidering

To display the speed and the range

To display the overall number of stitches and the current
number of stitches

The progress of embroidering is displayed on a bar chart.

To display the name of the embroidering data

To display the timing angle of the needle drop and hoop movement.

Uzgg

0/8303)

£

e vt clole|

ding by  Normal operation Eacket.ece Barder (Al
_Up | Down| Ranes 1400-800)  Speed Fpm 1 1002,
=
o | of
[ e o
|Far Help, pres== F1 [DISCONMEGT | [ [ |
Click here and the overall speed range increases by one level.
Click here and the overall speed range decreases by one level.
To display the status of the machine.

1. Click 1§ .

"Hoop" appears at the machine display window.
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2. Press the button. Embroidering starts.
Embroidery data appears in gray, indicating the embroidering status.

B gy lalx]
Q@B =18 ml XIS/ & 7K
Egm&":“"*“‘mﬂ, Epand hmﬁﬁ’:ﬁﬁ:n
=
oy
3 / ! b
e
L“\ * ,% ";
. /’lé(_ T Al S
?.-’ i A Y
Lw_\.\ %
\_\\
L——*\ ................................................ _
L | _ ol

Pause

1. Click|[8].

Canceling

1. Press the @i button while pressing the button on the machine
operation panel.

2. Click X].

3. The check screen appears. Click [Yes] to cancel.

& Ok te cancel embroidering?
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Moving the Home Position

Move the selected machine home position.

1. Select [Home Position] from Operation menu or click @ .
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Step-forward/Step-back

Allows step-forward or step-back of stitches without embroidering.

M Click |&] to stop embroidering for step-forward/back mode.
l The special tool bar appears in the step-forward/back mode.

Tool bar for step-back/step-forward

QIR 8= XISV % w121
|—1n 100] /[ /7| 5| | an| w0 [um e |52 @M

ERSKET.EOS Tubular (A1)
1m1mm Gpmad

For Halp. praza Fi CECONEST WM

Entering in the Step-forward/Step-back Mode
1. Click | to stop embroidering.

2. Select [Step F/B] from the Operation menu or click gl .
A cross appears on the screen. The current needle position is the intersection of the vertical and
horizontal lines.

e ol —wy )
@J@JEJEEIJEL&JQ_IQIE_J;!%I @J@JEJEEUELQJQ_L&IE_JEMI

Fe BT e

Current needle position
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Canceling step-forward/step-back
1. Click il of the step forward/back tool bar.

The cross disappears and the step forward/back mode is canceled.

0]

I —

i T
folle iz ST i o= Rraa = kel

FWWW\A G| e 0 '”""!“_XI

Setting Step-forward/Back Distance or Timing

Select step-forward/back distance or timing.

M The functions of icons are as follows:

[ 1 10j100| [

LI Moves forward (backward) by 1 stitch.

Moves forward (backward) by 10 stitches.

10
m Moves forward (backward) by 100 stitches.
Ay

Ll Moves to the next (previous) feed.

Moves to the next (previous) color change.

1. Click the icon to select the desired function.
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182

Stepping Forward/Back

Steps forward/back the stitches actually.

B The functions of icons are as follows:

s<|«|<u| n |||>|»|>s|@|

A

Returns to the start position. For repeating patterns, returns to the start position of the current pattern.

|2

Moves backward by the specified distance continuously. Click Ll to stop movement.

A

Moves backward by the specified distance.

|

Click this to stop after clicking 1' or zl .

v

Moves forward by the specified distance.

Moves forward by the specified distance continuously. Click Ll to stop movement.

This is selected for repeating patterns. The machine goes to the start position of the next pattern.

Bz ¥

Specify the travel length from the embroidery start point.

B Wachiva oweton Mmool Satings B Hab

l Selection of movement to the start position. The needle moves as follows:

QlQEF=] 8 ml XIS 5| &l 2102
[1 10100 /\\.“ T ) ox| x|

Esaketare Tubular 01

oparatian
| Farga 1MOS-1000}  Spasd  1000rpm 11oder.

Worrad cpanaion
Pakam 12 tha zbart paiek:of the prasions chjmck

‘[Stitches 176 - 1345/ 530amn

Embroidering Normal

ratio
Up | Down| Range

n Baskets.e
11400-800)  Speed 1000:

%

Click the ®s icon
and the needle
moves to the start
position of the next
repeating pattern.
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Click the 54 icon and the needle
moves to the start position of the
current pattern.
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276 0783030
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ineby Normal

| Down | Ranee
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n
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Chapter 6 Embroidering

1. Select the icon and move the cross to the desired position for step

forward/back.

T ] e ey Frr)
Q=6 XISlER 5 & 7k QAT =B el XIS|EEf 5 %] 2 (K2

Fn 00 /\‘l_sq‘«lql‘ DL M
b b
& A
du I 1 _>r" - T i J"
Forward Backward

Specifying the Value

Specify the travel length from the embroidery start point.

1. Click & .

2. Input the number of stitches to start embroidery. Click [OK].

Specify the stitch number from which you want to start embroidering E

Specify the stitch number from which you want to start

256

GCancel |

Resuming Embroidering
1. Click oK|in the tool bar.

The cross disappears. The embroidery status at the step forward/backward position of the
stitches is displayed.

Jie oo tachn bt [ECHIT il = b Wacton Gt 1
T Mok Gpwaion G Ll Geimgs Bbem bk 18l %) o g ey 18] x|
QlAfaF= 8=l XISEN Y & 28] QA= A= XIOERN % & 2 N7
E BIELTUIST™ o s
|t G e U805 Zpmed  1000rpem 10k |-t o Foren [T ey -yt iy
= =
. A g,
= /
J %7‘\\/
{ b
L.ﬂ.
) “\\
e | e I |
dmmn 1 ;lj iﬂl-llllﬁ ] JJ
Forward Backward

2. Click 3.

It is ready to resume embroidering and "Hoop" appears at the machine display window.

3. Press it on the machine.

START
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Moving Embroidery Position

Changes the position of embroidery data.

Hl Movement is allowed only in the embroidering area (within the red frame).

0 Mechine Qpwation Wen Tool Setings Mndow  Hab =8l x|

QQ%EE&;E&E@EV% i 282

oparatian Essketars Barder (A1l
Up | Dawm| Farse 1A00-8007  Spand Orpm 11dag

Embroidering area

Worrad cpanaion
For Halp. praza Fi DECONECT

1. Select [Move Embroidery Position] from Operation menu or click il .

2. The pointer turns into @ . Drag the embroidery data.
The mouse arrow becomes + while dragging.

0 Mechine Qpwation Wen Tool Setings Mndow  Hab =8l x|

@Atk =A éJ@IEIVIE P el

cparatian Bl 3
Up | Dawm| Farse 1A00-8007  Spand Orpm 1ddag

AT n Bley =175 A
For Halp. praza Fi DECONECT
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Centering Pattern

Moves the pattern to the machine home position.

1. Select [Move Pattern] from Operation menu.

Controller — ECGMI1

Machine “iew Tool Settings

Start Sending
a ( Stop Machine
Caneel Embraideting

Home Position
Step F/B
Maowve Embroidery Position

Centering Pattern

2. The pattern is moved.

B Wachiva oweton Mmool Satings B Hab

QA= 8 =l X OV 78

Temdeg by Harmal

oparatian Essketars Barder (A1l
1A00-8007  Spand Orpm 1ddag

Worrad cpanaion
For Halp. praza Fi DECONECT
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Saving Data

Saves the edited data. The edited data can be saved over the current file or renamed as a separate file.

Save

Saves the edited data over the current file. The original data is deleted.
1. Select [Save] from File menu or click EI )

2. If color etc. has been is changed, the pattern image appears.

Save As...

Renames and saves the edited data as a new file.
1. Select [Save as...] from File menu.

2. Select the directory to save the new file. Enter a new file name.

Save As [7]x]
Save in: Ia Samples j gl
v Basketecs ¥ Goodecs
¥ brofcolecs ¥ MONKEYS ecs
¥ broBool2ecs ¥ Monnon.ecs
¥ Enioy—33.ece
¥ Ethnic.ecs
¥ Fishingecs
¥ Golf-B3ecs
File name: IElasket.ecs ECS Save |
Save as type: I".ecs LI Crmas

3. Click [Save].

4. If color etc. has been is changed, the pattern image appears.
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Test

Carries out sensor information check, actuator operation test, test for main shaft rotation, etc. for machine
maintenance.

This function is protected by a password. A dealer engineer will use this function if
required.
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Running Other Programs

Other programs can be started when the machine power is not turned on or when the machine is in
operation for embroidery.

188

H The following programs can be started:

Embroidery data explorer Allows transfer and copy of the embroidery data.
Data transfer to the machine controller is not allowed.

Embroidery data editor Allows editing of embroidery data.

Production report Allows display and print-out of production data, etc.

1. Select [Embroidery Data Explorer independently] or [Embroidery Data
Editor independently] from Tool menu.

ine r — ECM1

Settings  Window Help

i
Language Crl+L | [
i E Edit

Embraidery Data Explorer

Praduction Report

Run Embraid Data Editor independently
Run Embraic Data Explorer independently

Copy) e Anather Machine

Caonfiguration

“ersion Upgrades

Selecting [Embroidery Data Edit Individual Start]

M Input the number of needle bars. Input the number according to your machine
specifications. Click [OK].

Setting the number of needles

Input the number of needles. (1-20)

|g Z‘ Click this to increase or decrease the value.
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Chapter 7 Operation of Machine
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Chapter 7 Operation of Machine

1. Operating Procedures

1-1 Power Source

1. Turn the power on to the machine.
® 2. Reset the emergency stop button.

3. Press the high power switch.

window indicates "BES-", and then '"962
(BES-1262BC : "1262")".

t@ 4. The power lamp lights up and the display

Iy |
T o e g 11

)

the needle bar and presser foot move up
and the frame moves up to the reference
point.

The machine enters the waiting state for an
embroidering data selection.

Note) When turning the power off and back it on
again, wait for at least 10 seconds.

f@ « An alarm buzzer sounds three times. Then

Emergency stop button Power switch

1-2 Preparation for Embroidering

- Select embroidering data while the machine is in the waiting state for an embroidering data
selection, and transmit required data by pressing the w icon.

« The READY lamp lights up and the machine is placed in the waiting state.

+ Using the jog switches (/\ \V<][>), determine a position to start embroidering.
Note) An error code is displayed in the display window if a pattern comes out of the hoop.

» Pressing the START switch starts embroidering.

R

START

* During embroidering, the speed is indicated in the display window.

- After embroidering is finished, the hoop returns to the start point and the machine is placed
in the stand-by state.
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2. Stopping the Machine

2-1 Procedure to Stop the Machine

STOP

R

2-2 Resetting Machine Stop

\ I/
I
I
I
|
/ I\

2-3 Emergency Stop of the Machine

C

2-4 Resetting Emergency Stop

C

Emergency stop button

Power switch

Press the stop button or to stop
operation of the machine.

The stop button adopts the push-turn-lock
method. If you want to keep the machine
stopped, turn the stop button clockwise
while pushing it.

When the stop button is locked by turning
it while pressing it, the message, "STOP",
is displayed while blinking on the operation
panel.

To reset the stop button, turn it
counterclockwise while pressing it. The
knob of the button pops up and machine
stop is reset.

Check to see that the other stop button is
reset.

When the emergency stop button is
pressed, all power except for that for the
fluorescent lamp is turned off.

When turning the emergency stop button
in the direction of the arrow illustrated on
the button, the knob of the button pops up
and emergency stop is reset.

Press the power switch to turn on the
power again.
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3. Permission for Hoop Movement

« When the computer has given a command
to move the embroidery hoop, "HOOP" is
displayed while blinking on the operation
panel.

\|l/
I
I
I
I
/ I\

 Press the check switch and the embroidery
hoop moves to the designated position.

=
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4. Measures against Thread Breakage

4-1 Remedies

o(0)
©

©

~

THREAD
SENSOR

N

S G-
HEAD

ON

©

OFF

MENDING

&)

@

O
THREAD
SENSOR
L
_\}é(i THREAD
@ At \ SENSOR lamp
@-ON HEAD switch
,L( OFF ‘
-0 MENDING
/‘ MENDING lamp
j—
@— MENDING
switch
STEP
@ @= STEP BACK/
BACK FWD FWD switch

If embroidering is suspended due to thread
breakage, the THREAD SENSOR lamp of
the machine head with a thread breakage
blinks.

Correct the broken thread and pass it
through again.
* Refer to "Chapter 2, 3-1 Upper Threading" for details.

Press the STOP switch or press the STEP
BACK/FWD switch in order to reset the
alarm.

Return the hoop to a position where thread
breakage occurred by pressing the STEP
BACK switch.

STEP

BACK FWD

Note) When the switch is turned for 20 stitches or
more, the machine continues operation with-
out holding the switch. To stop the machine,
turn the switch to the opposite side.

Press the START switch on the operation
panel or the start switch located between
the machine heads to resume operation.

2
11 ].

START
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4-2 Mending

The machine head whose MENDING lamp is lit performs embroidering by the preset number
stitches. When it is completed, all the machine heads start normal embroidering operation.

o] )

THREAD
SENSOR

©

(©)] vemo
@

OFF
K

NN
—O e

H Manual operation

- The MENDING lamps except for the

machine head whose needle thread has
been broken are turned off.

At this time, the machine head, whose
MENDING lamp is on, performs resewing
from the step-back position while the other
machine heads (with MENDING lamps off)
are stopped. When resewing is completed,
the other machine heads (except those
halted or with bed retracted) also start
embroidering.

The mending start and end positions can be set for each machine head using the MENDING switch on

the tension plate.

194

The MENDING lamp is lit when the
MENDING switch of each machine head is
flipped up during standby. Resewing from
the step-back position to this position can
be executed.

When the MENDING switch is flipped up
while the MENDING lamp is off, the lamp is
turned on; when the MENDING switch is
flipped up again while the MENDING lamp
is lit, the lamp is turned off.

Note) The mending end position cannot be set for
each machine head.

When all MENDING lamps are turned on, the
mending end position will be set to the posi-
tion where one of the lamps is turned off first.

Note) To cancel the mending end position, turn all
the MENDING lamps are turned on (except for
halted machine heads) .
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No.1 Stitch
|

Stand by
position A

No.1 Stitch
|

Stand by
position A

No.2 Stitch No.3 Stitch

O = = — —————

é
No.3
Mending LED is off.

No.2 Stitch No.3 Stitch

O m e o — —— ——

1]

— e

nding LED

O e e o o ———

1.

Turn off the MENDING lamp No. 3 at the
standby position A.

(The position A should be the mending end
position.)

STEP

Press the jog <] switch or ¢/ to move it
backward.

Turn off the MENDING lamp No. 2 at the
position B.

(The position B does not become the end
position; the position A remains the end
position.)

Note) When the MENDING switch of the machine

head whose lamp is off is pressed:

- The MENDING lamp of the machine head is
lit, and mending is executed for the ma-
chine head.

Note) When the MENDING switch of the machine
head whose lamp is on is pressed:

- The MENDING lamp of the machine head
goes off and mending is not excuted for the
machine head.
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5. Jog Embroidering

- Jog embroidering can be used for
preventing the thread from slipping from
the needle at the start of embroidering.

BES-962BC BES-1262BC

- Jog embroidering can be executed as long
ST as the start switch at the machine head is
held down.

Note) Never apply a tape on the switch to keep jog
operation for a long time. Doing so may cause
/ damage to the machine.

6. Hoop Feed Position

 In order to ease mounting and dismounting of the embroidery hoop, another needle position
can be set as a hoop feed position in the movable area additionally to the current needle
position. (The hoop feed position should be set by the personal computer.)

- In order to ease material attachment while operation is suspended, the hoop can be moved
to the feed position at any time by the hoop feed switch.

« The hoop can also be moved to the feed position automatically after embroidering is finished.
Refer to "Automatic Hoop Feed" on Page 159 for details.

Cy)
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7. Area Check

7-1 External Tracing

- If the check switch is pressed in other

cases than "area over", the rectangular
\ outline of the pattern is traced.

Embroidering ( bg ,

start position

D ———— g

7-2 Automatic Hoop Movement in Area

0.1mm
(Example)
 ——— — — -
! —
: | A i N
|
| =—0.1mm I I : : l |
! ' | | | ! I |
l [ | I | —f— l f !
l ' ______I l—_F"’——_J L ]
Ll _ _

Embroidering area

- If "area over" is displayed, press the check switch. The hoop automatically moves inside the
embroidering area, where the pattern is set, at the nearest position.

=

Note) After finishing the movement inside the area by this function, execute external tracing. Then, check that
the needle and the presser foot do not interfere with the hoop before starting embroidering.

If the pattern is not held in the embroidering area as shown below, the hoop cannot move into the area.
Enlarge the embroidering area on the personal computer.
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8. Jog Switches

8-1 Hoop Movement to Start Position

The hoop immediately after the embroidering mode becomes valid can be moved so that the
start position can be set as required.
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8-2 Inching Mode during Embroidering (Forcible Hoop Movement)

L
J
o

1. Press the jog switch /\ while
pressing the "STOP" switch -'
and "AJST" is displayed.

2. Press the jog switch [> to forcibly change
the hoop. "JOG" is displayed.

3. Press the "START" switch and press the jog
switch. The hoop moves to the direction of
the pressed switch.

( R

|1 A
START < D

Vv

(& J/

Notes) < Note that the forcible hoop movement will
produce deviation of embroidering by the
amount.

- If the hoop and material are deviated from
each other during embroidering, correct it
by using the jog switches.

4. Pressing the STOP switch
resets the inching mode.

5. Press the START switch
restarts embroidering. 6 I

START
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Chapter 8
Creating Production Report

Records and controls the machine operation.
The production report can be created based
on this data. Detailed information of produc-
tion report allows efficient embroidering con-
trol.
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Functions (Command Reference)

File menu

Open Report File Opens the report file. (— page 204)

% |3 | (%

Save As CSV Saves the current report data in CSV format. (— page 217)
Print Prints the report. (— page 218)

Print Preview Displays the print preview on the screen.

Page Setup Displays the setting screen for printing. (— page 218)

Exit from Production Report Exits from the production report.

Edit menu

Copy Copies the selected area to the clipboard. (— page 219)
Select All Selects all report data.

View menu

Details Displays detail data. (— page 205)

Thread Breakage Information on Needle Bar Displays the thread breakage information for each machine needle. (— page 206)

Thread Breakage information in pattern Displays the thread breakage information for each pattern. (— page 207)

Output information Displays the production output of each machine. (— page 208)

Total output information Displays the total production output. (— page 210)

Top page Displays the top page.

Previous page Displays the previous page.

EIEAEEETE

Next page Displays the next page.
Last page Displays the last page.
Tool Bar Displays the tool bar.

Status Bar Displays the status bar.

Settings menu

Items to be displayed Sets the display item. (— page 211)

Delete report file (s) Deletes the report file. (— page 220)
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Description of Screen

Thread Breakage for Each Needle Bar
Detailed Data | Thread Breakage for Each Pattern
Save as CSV Total Output About This Application

Open report file Output | Copy Print Help

@ ECh-1 - Production Repart

] o s < |1 B2 ]

Details

Machine name Brother No.1
Collate 01/01/00 - 12/31/00

Date Time Reason

00/04/08 12:01:29  Load design GOLF No. of stitches=0009341

00/04/08 17:02:25 Erbroidering started

00/04/08 17:02:26  Color change New neede bar no. =1 No. of stitches=0000000
00/04/08 12:02:47  Suspenced

00/04/08 17:02:58  Embroidering restarted

00/04/08 17:03:06 Embroidering completed

00/04/08 19:02:23  Load design Flower No. of stitches=0000487

00/04/08 19:04:09 Embroidering started

00/04/08 19:04:11  Color change New neede bar no. =1 No. of stitches=0000000
00/04/08 19:04:18  Stoppage due to thread breakage Head No.=1 MNeedle bar no.=1
00/04/08 19:04:18  Stoppage due to thread breakage Head No.=2 MNeedle bar no.=1
00/04/08 19:04:18  Stoppage due to thread breakage Head No.=3 Needle bar no.=1
00/04/08 19:04:18  Stoppage due to thread breakage Head No.=4 Needle bar no.=1
00/04/08 19:04:18  Stoppage due to thread breakage Head No.=5 MNeedle bar no.=1
00/04/08 19:04:34  Embroidering restarted

00/04/08 19:05:16 Embroidering completed

00/04410 08:48:50 Power ON

00/04110 08:54:37 Power OFF

00/04110 08:55:53 Power ON

00/04/10 09:12:01  Load design  Automobile8 No. of stitches=0000948

00/04/10 09:13:44 Erbroidering started

00/04/10 09:13:45  Color change New neede bar no. =1 No. of stitches=0000000
00/04/10 09:13:56  Stoppage due to thread breakage Head No.=6 MNeedle bar no.=1
00/04/10 09:14:21  Embroidering restarted

00/04/10 09:14:32  Color change New neede bar no. =2 No. of stitches=0000103

4]

No.

. of stitches=0000012
. of stitches=0000012
. of stitches=0000012
. of stitches=0000012
. of stitches=0000012

of stitches=0000064

Speed range=1
Speed range=1
Speed range=1
Speed range=1
Speed range=1

Speed range=1

of”

For Help, press F1
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Displaying Report

Displays the machine operation status in the form of report.

204

H The following reports can be displayed:

Details Displays detail data while the machine is in operation.

Thread Breakage

information on Needle Bar Displays the thread breakage information for each machine.

Thread Breakage

information in Pattern Displays the thread breakage information for each pattern.

Output information Displays production output or efficiency of the selected machine.

Total output information Displays production output or efficiency of multiple machines.

B Items to be displayed in each report can be set. For details, refer to "Setting
Display Items" (— page 211).

1. Select the desired report from View menu or on the tool bar.
2. Select [Open] from File menu or click E' .

3. Select the applicable machine.

Open report file

— Target machine

Brother Na. 1 =] Click here to select the
machine for detail data,
— Target machines for total output information thread breakage and

Brother Mo. output information.
E Err rer

Brother BES

Click here to select the
machine for total output
information. Click here
again to cancel the
selection.

= pea—

4. Click [OK].

5. Specify the period to read.

For more information, refer to "General" in "Setting Display Items" on page 211.

6. Click [OK].

The report appears.
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Display Example of Details

Displays the machine information chronologically that are collected within the

specified period.

The following information is indicated under the "Reason" column:

Display Contents

Power ON The machine power was turned on.
If the computer is turned on after the machine power has
been on, it shows the time when the computer recognized
the machine.

Power OFF The machine power was turned off.

If the computer is turned off before the machine power, it
shows the time when the computer program quit.

Load design (*)

The name of the loaded pattern and the number of stitches
are indicated. This is also recorded when embroidering was
started after the power was turned off and back on.

Embroidering started

Embroidering was started.

Embroidering completed

Embroidering was completed.

Embroidering canceled

Embroidering was canceled.
The information on the pattern is deleted from the record.

Color change (*)

The needle bar number and the number of stitches after
color change are indicated.

Suspended (*)

The machine operation was suspended by the operator.

Stoppage due to thread
breakage (*)

A thread breakage occurred. The head number,
the needle bar number and the speed range are indicated.

Error (*)

The machine was stopped due to an error.

Embroidering restarted (*)

Embroidering was restarted after a suspension, a thread
breakage, or an error.

The items marked with "*" can be shown or hidden on the " Setting items to be

displayed" screen.

8 v

Detals

x HEE
Bl Edt Yiw Zettings Hep
_l_lfi‘ll*ﬂl*ﬁlﬂlﬁu ]| |v| SI2 N
Maching name EBrother Mo.1
Collate 0101400 - 1203100
Reason
7 Load desion GOLF Mo, of sttches=0009341
sterted
08 Mew neadie bar no. =1 Ho, of sttches=0000000
QIE';_tiztE-:I
Load cesion Fower Mo, of stiehes=0000487
ring started
08 Mew nesdie ber no. =1 N, of stches=0000000
to thresd breakage Head No.=1 Meede bar no.=1 Mo, el ranoa=1
0 thread breakage Head Mo.=2 Meede bar no=1 Mo, el ranoe=1
10 thvead breakage Head Ho.=3 Heede bar no.=1 Mo, el ranga=1
At thread breakage Head No.=4 Neede bar no.=1 Mo, el ranga=1
it thread breakage Head Mo.=5 Neede bar no.=1 Mo, ? Speed range=1

4 E o restarted
b 1 Erbroidering completad
ar ON

08 New neadia bay no. =1 o, of stitches=0000000
ce 10 thread breakage Head No=4 Meede bar no,=1
0 restarted

e MNew neadie bar no. =2 No, of sitches=0000703

4l

o,

of stitches=0000064 Speed range=1

1of

For Haly, prasa Fi
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Display Example of Thread Breakage Information on Needle Bar

Displays the information on thread breakage occurrences with head numbers and
needle bar numbers. Three needle bars with frequent thread breakage are

indicated.
Display Contents
No. of times thread is Number of thread breakage occurrences per needle bar
trimmed (*)
No. of stitches (*) Number of stitches embroidered with the needle bar during

the specified period

Thread breakage rate (*) Thread breakage rate per 10,000 stitches
(10000 x No. of times thread is trimmed) /No. of stitches

Total (*) Total for all the heads or all the needle bars

Needle bar with frequent thread ~ Three needle bars that have thread breakage frequently,
breakage occurrence (¥) in the decreasing order of frequency

The items marked with "*" can be shown or hidden on the " Setting items to be
displayed" screen.

&% - Production Report

e e s

Thread Breakaze information on Needle Bar

<[] Sl

Machine name

Collate 01/01/96 - 12/31/97

Specified time 00:00 - 00:24

Head MNo. Meedle bar no. 12 " 10 9 i 7 i 3 4

1 Mo. of times thread breakase ocours 0 il il b 4 3 3 3 3
No. of stitches 0 0 0 84261 108613 93a61 102224 79479 100
Thread breakaze rate 0.00 0,00 000 071 0.36 0.32 0.48 0.62 0.20

2 Mo. of times thread breakase ocours 0 il il 0 0 2 0 0 4
No. of stitches 0 0 0 18983 44129 34198 22028 26004 3od
Thread breakaze rate 0.00  0.00 0.00 000 0.00 0.58 0.00 0.00 1.00

3 Mo. of times thread breakase ocours 0 il il 1 1 4 1 0 0
No. of stitches 0 0 0 18983 44129 34198 22928 26004 3od
Thread breakaze rate 0.00  0.00 000 052 0.22 1.18 0.43 0.00 0.0

4 Mo. of times thread breakase ocours 0 il il 1] 0 0 1] 3 0
No. of stitches 0 0 0 4921 J247 2433 4898 s237 107
Thread breakaze rate 0.00  0.00 0.00 000 0.00 0.00 0.00 4.81 0.0c

5 Mo. of times thread breakase ocours 0 il il 1] 1 0 1] 2 1
No. of stitches 0 0 0 4921 247 2433 4898 6237 107
Thread breakaze rate 0.00  0.00 0.00 000 3.07 0.00 0.00 3.20 0.9c
Mo. of times thread breakase occurs

206 BES-962BC * BES-1262BC



Chapter 8 Creating Production Report

Display Example of Thread Breakage Information in Pattern

Displays thread breakage information for each pattern.

Display

Contents

n th

The pattern was embroidered for the "n"th time.

Pattern name

Name of the pattern that was embroidered

Head No. (*)

Head number where a thread breakage occurred

Needle bar no. (*)

Needle bar number where a thread breakage occurred

n th stitch (*)

The ordinal number of the stitch when a thread breakage occurred

Speed range (*)

Speed range that was effective when a thread breakage occurred

The items marked with "*" can be shown or hidden on the " Setting items to be
displayed" screen.

Bl Ed Yiw Zoltigs

Beip

S| O] =] <]« | > 1] S 2N

For Haly, prasa Fi

Thread Breskaoe information n Patern |
Meching niame_brather No,1
Collate 01701700 - 1243100
Pattarm name : GOLF
nih o Head Mo, Weade barno i th stitch Spesd range
1 1 1 nnmz 1
1 2 1 nnmz 1
1 3 1 nnmz 1
1 4 1 nnmz 1
1 b 1 nmz 1
Pattem name : Fower
nih o Head Mo, Weade barno i th stitch Spesd range
i 1 0064 1
1 b k] (1204 1
1 4 4 1400 1
1 B 1 0504 1
1 2 i 0612 1
1 i 7 0716 1
L4 _IJ
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Display Example of Output Information

Displays the production information that are collected during the specified period.

Display Contents

Total electricity supply time  Total time when the machine was energized within the
specified period

Total embroidering time Total time when the machine embroidered within the
specified period

Total actual embroidering time  Total actual time when the machine embroidered
within the specified period

Excluded time Total time of intermission and maintenance for the number
of days in the specified period

Electricity supply efficiency  Electricity supply efficiency by calculating below:
(Total electricity supply time - excluded time) /
total electricity supply time

Embroidering efficiency period Ratio of the actual embroidering time to the total
embroidering time
Total actual embroidering time / total embroidering time

Number The pattern embroidered during the specified period is numbered.
Pattern name Name of the pattern

No. of stitches in pattern Number of stitches in the pattern

Total stitches (*) Total number of stitches by repeating embroidering

No. of stitches in pattern X No. of times embroidered

No. of colors in pattern (*) Number of colors in the pattern

No. of times embroidered (*) Number of embroidering repeated

No. of workpieces embroidered (*) Number of finished sheets by one embroidering cycle

Total no. of heads which Total number of the heads at rest for one embroidering
are stopped cycle
Embroidering time (*) Time from embroidering start to the end for the pattern

Actual embroidering time (*)  Embroidering time from which the time for interruption, stop
due to thread breakage, and stop due to error is excluded

Average embroidering speed  Average embroidering speed in the actual embroidering
time (the number of stitches per minute)
Total stitches/actual embroidering time

Efficiency 1 (*) Ratio of the actual embroidering time to the embroidering
time for the pattern with time for interruption excluded
Actual embroidering time/(embroidering time-time for
interruption)

Efficiency 2 (*) Ratio of the actual embroidering time to the embroidering time
Actual embroidering time / embroidering time

Time stopped (*) Total of stop time during embroidering

Reason for stoppage (*) Reasons for stoppage are indicated. Refer to the next page.

The items marked with ™" can be shown or hidden on the " Setting items to be
displayed" screen.
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Details of reason for stoppage

Interrupted Frequency and total time stopped by the operator
Stoppage due to Frequency and total time stopped by thread breakage
thread breakage
Error Frequency and total time stopped by errors
@3 186 - Production Report
File Edit Wiew Settings Help
] <> > & 282
butput information =
Machine name EBROTHER-186
Collate 04/08/9% - 04/12/98
Total electricity supply time 39:48
Excluded time 00: 00
Total embroidering time 36:49
Total of actual embroidering time 24:02
Electricity supply efficiency 100 %
Enbroidering efficiency period 65 %
Number
#1
Pattern name 11l.ecs
Ho. of stitches in pattern 6774
Total stitches 13544
Ho. of colors in pattern 10
No. of times embroidered z
No. of workpieces embroidered 12z
Total no. of heads vhich are stopped ]
Embroidering time 00:25
Actual embroidering time 00:19
Average embroidering speed £94 rpm
Efficiencyl (without Suspended) 7% %
Efficiency2 7% %
Time stopped 00: 06
Reason for stoppage Times Total time Average time
Suspended o 00:00 00:00:00
stoppage due to thread breskage 3 00:03 00:00:35
Error 7 o0:02 00:00:22
| _>l_I
For Help., press F1 [Fage 1/1 | | [NOM | 4
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Display Example of Total Output Information

Displays the output information per pattern on multiple machines that are selected.

Display

Contents

Number

The pattern embroidered during the specified period is numbered.

Pattern name

Name of the pattern

No. of stitches in pattern

Number of stitches in the pattern

Total stitches (*)

Total number of stitches by repeating embroidering
No. of stitches in pattern X No. of times embroidered

No. of colors in pattern (*)

Number of colors in the pattern

No. of times embroidered (*)

Number of embroidering repeated

No. of workpieces embroidered (¥)

Number of finished sheets by one embroidering cycle

Total no. of heads which
are stopped

Total number of the heads at rest for one embroidering
cycle

Embroidering time (*)

Time from embroidering start to the end for the pattern

Actual embroidering time (*)

Actual embroidering time excluding the stop time by thread
breakage, suspension and errors from the embroidering time

Actual embroidering speed (*)

Average embroidering speed in the actual embroidering
time (the number of stitches per minute)
Total stitches/actual embroidering time

Efficiency 1 (*)

Ratio of the actual embroidering time to the embroidering
time for the pattern with time for interruption excluded
Actual embroidering time/(embroidering time-time for
interruption)

Efficiency 2 (*)

Ratio of the actual embroidering time to the embroidering time
Actual embroidering time / embroidering time

Time stopped (*)

Total of stop time during embroidering

Reason for stoppage (*)

Reasons for stoppage are indicated. Refer to page 209.

The items marked with "*" can be shown or hidden on the " Setting items to be
displayed" screen.

4 186 - Production Report

Eile

Edit Miew Settngs Help

N

=

==l

S ] <[> || S22

#1

[Total output information

Machine name BROTHER-186
Machine name BROTHER-EMB
Machine name EMB-EHEAD
Collate 04/08/98 - 04/12/928

[Mumber

Pattern name

No. of stitches in pattern

Total stitches

No. of colors in pattern

No. of times embroidered

No. of workpieces embroidered

Total no. of heads which are stopped
Embroidering time

actual embroidering time

11l.ecs

6774
13544
10

z

1z

o
00:25
00:19

Average embroidering speed 694 rpm
Efficiencyl (without Suspended) % %
Efficiency? % %
Time stopped 00:06
Reason for stoppage Times Total time Average time
Suspended o 0n:00 00:00:00
Stoppage due to thread breskage 13 00:03 00:00:35
Error 7 on:02 00:00:22
] >
For Help, press F1 [Page 171 | [Cap [NOM | y
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Setting Display Items

Sets display items for each production report.

H The following tab windows can be set:

General Items related to the overall display of the output report.

Details Items related to detail data.

Thread Breakage
information on Needle Bar

Items related to thread breakage for each needle bar.

Thread Breakage
information in Pattern

Items related to thread breakage for each pattern.

Output information Items related to output information.

Total output information Item related to total output information.

Recess time Items not included in the efficiency calculation for

setting

output information and total output information.

1. Select [Items to be displayed] from Settings menu.

"w H H H "w
2. "Setting items to be displayed" screen appears.
Click the tab on the screen and the tab window for the items appears.
Thread Breakage information in Pattern Output information Total output information Recess time setting I
General Details Thread Breakage information on Neede Bar Tab
—Collate — Target machine
 Maonthly lFi’ |Ernther MNo. 1 LI
(Date)
© Weskly Sun -
(Day [ Specified time Storage
' Daily [+ =] N C N € 3 years
(Time)
C Yasterday 2 00:00 il - 00:24 il &1 year
~ Wﬂ _ lwil 6 months
y 3 months
™ Specify E _ =
' 00:00 00:24
T ZI ZI 1 manth
ollzte
( 01/01/86 il e 12/31/97 il ‘ 1 week
oK I Cancel | Apply | Help
Thread Breakage information in Pattern Output information Total output infarmation Recess time setting |
General Details Thread Breakage information on Neede Bar
Collaste —— ~ Target machine
 Monthly Fj [Brother Mo, 1 |
(Date)
" Weskly Sun v o
(Day? [~ Specified time Storage
& Daily [24 & oo - e £ 3 years
(Time)
 esterday & 00.00 il - 00:24 il & 1 yaar
P Wi’ _ Wﬁl £ & months
- 3 months
™ Specify - o - - o
- 00:00 00:24
I :I :I 1 month
iu] ]
’7 01,/01/86 il R 12/317/97 il ‘ 1 week
QK I Cancel | Apply | Help
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H Collate
Selects the data collection period. If month, week or day is selected, set the end
date or end hour.

H Storage
Selects the data save period.

Details

Setting items to he di

Thread Breakage information in Pattern | Output information Total output infarmation Recess time setting |

General Details Thread Breakage information on Neede Bar
—Main items to be displayed—————— [~ Sub items to be displaved
¥ [oad desion F Head no

W Calor change

¥ MNeedle no
¥ Stoppage due to thread breakage

¥ Restart
¥ Mo of stitches

¥ Suspended

¥ Error W Speed range

oK I Cancel Apply Help

H Main items to be displayed
Displays each event and the time.

Load design Transfer time of embroidery data

Color change Time of color change

Stoppage due to thread breakage  Time of thread breakage

Restart Time of resuming embroidering after suspension
Stop after pressing button Time when the emergency stop button was pressed
Suspended Error Time when an error has occurred

H Sub items to be displayed
Displays the following for each item in main display items.

Head no. Head number
Needle no. Needle number
No. of stitches Number of stitches
Speed range Speed range
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Thread Breakage Information on Needle Bar

Thread Breakage information in Pattern

General Details

Output information | Total output information | Recess time setting |
Thread Breakage information on MNeede Bar

—Main items to be displayed

¥ Mo. of thread breakage occurrences

¥ No. of stitches

¥ Thread breakage rate

—Sub items to be displayed

¥ Total

¥ Meede bar with frequent thread breakage ocourence

]

Cancel Apply Help

H Main items to be displayed

No. of thread breakage occurrences

Number that thread breakage has occurred

No. of stitches

Number of stitches used in embroidery

Thread breakage rate

Rate of thread breakage for 10,000 stitches

H Sub items to be displayed

Displays the following for each item in main display items.

Total

Total of the item for each head and each needle

Needle Bar with frequent

thread breakage occurrences

Data of three needles that have caused thread
breakage most frequently

Thread Breakage Information in Pattern

General | Details

Thread Breakage information in Pattermn Output

Thread Breakage information on Neede Bar |

infarmation Total output infarmation Recess time setting

—ltems to be displayed

¥ Head no. where thread breakage occured

¥ Ma. of stitches until thread breakage

¥ Speed range

¥ Meede bar no. where thread breakage occured

o ]

Cancel | Apply | Help |

Head no. where thread
breakage occurred

Head number that has caused thread breakage

Needle bar no. where thread
breakage occurred

Needle number that has caused thread breakage

No. of stitches until thread
breakage

Number of stitches until thread breakage has
occurred

Speed range

Speed range when thread breakage has occurred

BES-962BC
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Output Information

Time is calculated to the unit of second, but the display unit is in minute. This may

result in minor differences.

Setting items to be displayed

General Details

Thread Breakage information in Pattern

Qutput infarmation

| Thread Breskage information on Meedle Bar |

| Total cutput information | Recess time setting

[ ltems to be displayed

¥ MNo. of times embroidered
¥ Embroidering time

[V Actual embraidaring time
¥ Time stopped

¥ Embroidering efficiensy

¥ Reason for stoppage

¥ Mo. of colors in pattern
¥ HNo. of workpieces embraidered

[V Average embroidering spesd

[ Reazon for stoppage

W Times

¥ Total time

W Auverage time

[ o ]

Fevbh | EEe | s |

H Items to be displayed

Total stitches

The total number of embroidery stitches from start to end

No. of times embroidered

Number of embroidering

Embroidering time

The total time from start to end spent for embroidery

Actual embroidering time

Time spent for embroidering

Time stopped

Time not spent for embroidering

Embroidering efficiency

Actual embroidery time/ (Embroidering time-Interrupted)
Actual embroidery time/Embroidering time (in %)

Reason for stoppage

Event that caused a stop

No. of colors in pattern

Number of colors in pattern

No. of workpieces embroidered

Number of sheets embroidered.

Average embroidering speed

Number of total stitches/Actual embroidery time
(number of stitches for 1 minute in embroidering)

H Reason for stoppage

Items for selection appear when [Reason for Stoppage] is clicked in the "ltems to

be diaplayed" column.

The display shows for three cases: emergency button stop, thread breakage,

and error stop.

Frequency

Number of stops

Total time

Total stop time

Average time

Average stop time per occurrence (in seconds)

214
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Total Output Information

Time is calculated to the unit of second, but the display unit is in minute. This may
result in minor differences.

Setting itam= to be displayed

Thread Breakage information on Needle Bar ]
Total output information

General | Detsils

Thread Eraskage information in Pattern | Output infarmation Recess time satting

~Reason for stoppage

W Times

¥ Mo of colors in pattern

¥ Mo of times embroidered ¥ Mo. of workpieces embroidersd ¥ Total time

¥ Auerage time

¥ Embroidering time ¥ Average embraidering speed

¥ &ctusl embroidering time

¥ Time stopped

¥ Embroidering efficiency

¥ Resson for stoppage

ok | wewn | wEEe | sz |

H Items to be displayed

Total stitches

The total number of embroidery stitches from start to end

No. of times embroidered

Number of embroidering

Embroidering time

The total time from start to end spent for embroidery

Actual embroidering time

Time spent for embroidering

Time stopped

Time not spent for embroidering

Embroidering efficiency

Actual embroidery time/ (Embroidering time-Interrupted)
Actual embroidery time/Embroidering time (in %)

Reason for stoppage

Event that caused a stop

No. of colors in pattern

Number of colors in pattern

No. of workpieces embroidered

Number of sheets embroidered.

Average embroidering speed

Number of total stitches/Actual embroidery time
(number of stitches for 1 minute in embroidering)

H Reason for stoppage
Items for selection appear when [Reason for Stoppage] is clicked in the "ltems to
be displayed” column.
The display shows for three cases: emergency button stop, thread breakage,
and error stop.

Frequency

Number of stops

Total time

Total stop time

Average time

Average stop time per occurrence (in seconds)

H Target machine
Click and select the machine for calculation. To cancel the selection, click again.
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Recess Time Setting

Sets the time not to be included in the calculation. This time is displayed on the
"Output” report as "Time Excluded".

Setting items to be

General Details Thread Breakage information on MNeede Bar |
Thread Breskage information in Pattern Output information Total output information Recess time setting

— Target machine — Total recess time

" Enable Wi’

[ Total maintenance time

I Enable 5650 il

0K | Cancel | Apphy | Help

H Target machine
Click and select the applicable machine for calculation.

H Total recess time
Set the time not to be included in the day-to-day calculation during the designated

period.

H Total maintenance time
Set the time not to be included in the calculation throughout the period.
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Save As CSV...

Converts the production report data to CSV format that can be read in spreadsheet software.

1. Select [Save As CSV] from File menu or click E .

2. The file name "Untitled. csv'" automatically appears. To change the name,
change "Untitled".

3. Select the directory to be saved and click [Save].

Save As m
Save in: IaCsv =] gl = =

|1 TESTO1
|2 TESTO2

File name: I9?D4D16.csv Save

Sawve as type: ICSV File*.csv) LI el |

H What is CSV format?
CSV (Comma Separated Value format) means a type of file formats used
for PC. Data in each item is divided by commas and recorded as a text file.
This format is mainly used for a spreadsheet software or data base software.
The extension is "csv".
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Printing Production Report

Prints the production report from a printer.

Page Setup

Printing method is set as required.

1. Select [Page setup] from the File menu.

Setting screen is displayed.

Page Setup HE

— Previe

— Paper

—Size:

SGES j

The sample image is displayed.

r— Orientation Marging [inches]

& Portrait Left: ID.?S" Bight: ID.?S"
' Landscape Top: I‘I" Bottom: I‘I"

Set the margin.

Header: I&f

Footer: IPage &

oK | Cancel Biinter.. 1~ Set the printer.

Set the paper direction.

Set the paper size.

Print

1. Select [Print] from File menu or click £&3|.
Set the number of sheets and click [OK].
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Copying Report Data

Copies the selected area as text data. This allows use of the production report on other word processing

software.

Select [Select All] from Edit menu, or drag and select the area to be
copied.

eport

File Edit View Settings Help

S|kl oM =g B <] <] > || SN

Detalls -

Machine name Brother No.1
Colate 01/01/96 - 12/31/97

o7104/09

19

19:0
97/04/08 19:0 Color change New needle bar no. =1 No. of stitches=0000000
97/04/08 19:04: Stoppage due to thread breakage Head No.=1 Needle bar no.=1 No. of stitches=0000012 5
97/04/08 19:04:18  Stoppade due to thread breakade Head No.=2 Neede bar no.=1 No. of stitches=0000012 S|
97/04/08 19:04:18  Stoppage due to thread breakage Head No.=3 Needle bar no.=1 No. of stitches=0000012 3|
97/04/08 19:04:18  Stoppade due to thread breakage Head No.=4 Neede bar no.=1 No. of stitches=0000012 $)
97/04/08 19:04:18  Stoppage due to thread breskage Head No.=b Needle bar no.=1 No. of stitches=0000012 S|
97/04/08 19:04:34  Embroidering restarted
97/04/08 19:05:16 Embroidering completed

97/04/10 08:48:50 Power ON

97/04/10 08:54:37 Power OFF

27/04/10 08:55:53 Power ON

970410 09:12:01  Load design Automobile8 No. of stitches=0000948
97/04/10 09:13:44 Embroidering started -
4

»
For Help, press F1 [Page 171 | [ [Nom |

When dragging for selection

-1 — Pro eport
Eile Edit View Settings Help

{il| P e B o< | | +1] S 2 N2

| »
For Help, press F1 [Page 1/ 1 | [ Inum|

When selecting [Select All]

Select [Copy] from Edit menu or click .

The area is copied as text data. Start a word processing software and

select [Paste] from Edit menu.
Copied data is saved until another data is copied or cut.
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Deleting Report

Deletes the record data for production report.

1. Select [Delete report file(s)] from Settings menu.
The password entry screen is displayed. Refer to the Brother sales department for password
information.

2. Set the period to be deleted.

Delete repart file

Period

(= Delete report files until Geaar) 1996 ﬂ

i+ Delete report files until (month)  [Dec -

7 Delete report files urtil (day) |31 ﬂ

QK Cancel |

3. Click [OK].
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A CAUTION

Turn off the power switch before starting maintenance.

Failure to do so may start the machine unintentionally through an accidental activation of the START switch,
resulting in bodily injuries.

Be sure to wear protective goggles and gloves when handling the lubricating oil or grease, so that no oil or
grease gets into your eyes or onto your skin, otherwise inflammation can result.

Furthermore, do not drink the oil or grease under any circumstances, as they can cause vomiting and
diarrhoea.

Keep the oil out of the reach of children.

- Keep the machine clean at all times to prevent machine trouble.

- Keep the machine clean.

Remove dirt with a soft, dry cloth. If necessary, clean with the detergent-soaked cloth, then wipe off
the detergent with a cloth dampened with (hot) water.

« Caution
Never use benzene or thinner for cleaning the machine.

1. Cleaning

1-1 Cleaning and Lubrication of Rotary Hook

Lubricate these points.

« Clean rotary hooks daily using the brush provided at the time of lubrication. If a rotary hook
is too dirty, cleaning with a compressor (compressed air) is recommended.

- If thread breakage or rotary hook noise occurs during embroidering, lubricate the race of the
rotary hook.

Note) - Use the dropper provided to supply oil. Use BROTHER's embroidery machine oil (equivalent to Nisseki
Sewing Lub No. 10).

« Supply a proper amount of oil. Any excess may stain fabrics, etc.
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1-2 Cleaning of Needle Plate

Broken threads left around the movable or
fixed knives or the lower thread holding
plate may result in thread trimming failure
or parts damage. Clean them once a
month.

Remove broken
threads from this
section.

1-3 Cleaning of Lower Shaft Module Fan

Remove lint from lower shaft module fan
and its surroundings once a month using a
pair of tweezers, etc.
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2. Oiling

To extend the machine's service life, supply oil to the following places at regular intervals.

(Note) + When oiling, be sure to supply Brother's machine oil (Nisseki Sewing Lube #10 or the equivalent) using
the dropper.

- Excessive oiling may cause the material to be stained.

2-1 Head

l BES-962BC

l Supply oil to the top and the bottom of each
needle bar (18 points) daily as shown in the
figure.

B BES-1262BC

H Supply oil to the top and the bottom of each
needle bar (24 points) daily as shown in the
figure.
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l BES-962BC

Lubricate the following part indicated by the arrow ("clearance” between the connecting rod
and the needle thread take-up bearing) once a week.

(Note) - In lubrication, select needle bar 9 and remove arm cover L to check the lubrication area. Be sure to wipe
off excessive oil spilt at the lower part of the arm.

Thread take-up bush

Connecting rod

Arm cover L

H BES-1262BC

Lubricate the following part indicated by the arrow ("clearance” between the connecting rod
and the needle thread take-up bearing) once a week.

(Note) - In lubrication, select needle bar 12 and remove the head cover to check the lubrication area. Be sure to
wipe off excessive oil spilt at the lower part of the arm.

Thread take-up bush

Connecting rod

Head cover

Connecting

BES-962BC « BES-1262BC
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3. Greasing

To extend the machine's service life, supply grease to the following places at regular intervals.
(Note) « When greasing, be sure to use the grease tank BR2 (black) provided with the machine.
- For overhauling, contact your distributor or refer it to trained experts.

3-1 Head

H Grease two places indicated by the arrow once a month.

S

9

BES-962BC

1. Remove two connectors from the rear of
the needle bar case.

2. Loosen four bolts @, and remove the
needle case 6.

3. Loosen three screws @, and remove the
presser foot guide plate Q.

4. Loosen two bolts @, and remove the arm
cover L Q.

5. Grease all the grooves of the thread take-
up cam @ and the work clamp cam ©.

* After greasing, assemble in the reverse
order.

(Note) - When assembling the needle bar case @,
place it on the machine and turn the change
pulley (O behind the cover @ at right. Check
that it is engaged, and then tighten the bolts.

« When attaching the presser foot guide plate
0, move the presser foot up and down by
the retracting lever to check that is it not
distorted.

226
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BES-1262BC

Remove two connectors from the rear of
the needle bar case.

Loosen four screws @, and remove the
head cover @, and loosen two screws ©
and remove the head cover RO.

(Note) Because the heads No.1 and No.2 have the
head covers R and L respectively, remove
both the the covers when greasing.

Loosen four bolts @, and remove needle
bar case Q.

Loosen three bolts @, and remove presser
foot guide plate ©.

Grease all the grooves of the thread take-
up cam @ and the work clamp cam .

* After greasing, assemble in the reverse
order.

(Note) - When reattaching the head cover @ after
its removal, move the needle bar case to
the needle bar 6 position.

- When assembling the needle bar case O,
place it on the machine and turn the change
pulley ® behind the cover ( at right.
Check that it is engaged, and then tighten
the bolts.

- When attaching the presser foot guide plate
0, move the presser foot up and down by
the retracting lever to check that is it not
distorted.

—T
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H Grease the places indicated by the arrow once in six months.
(Note) When greasing, be sure to use the grease tank BR2 (black) provided with the machine.

BES-962BC
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Remove two connectors from the rear of
the needle bar case.

Loosen four bolts @, and remove the
needle case 6.

Loosen three screws @, and remove the
presser foot guide plate Q.

Loosen two screws @, and remove the arm
cover L O.

Loosen four screws @, and remove the
head cover ©.

Loosen two bolts @, and remove the cap
eaves guide Q.

Loosen three bolts @, and remove the
wiper solenoid assembly ®.

Remove screws ® (7 pcs) indicated by
arrows. Apply grease to the tapped holes
with the syringe provided and tighten the
screws again.

Also apply grease to presser bar spring @,
the end of presser bar guide bracket @,
presser bar metals U @ and D @, and
jump rotary shaft @.

After greasing, assemble in the reverse
order.

(Note) - When assembling the needle bar case @,
place it on the machine and turn the change
pulley @ behind the cover ( at right.
Check that it is engaged, and then tighten
the bolts.

- When attaching the presser foot guide plate
0, move the presser foot up and down by
the retracting lever to check that is it not
distorted.

For more information, refer to the illustra-
tion on page 226.
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BES-1262BC

1. Remove two connectors from the rear of
the needle bar case.

2. Loosen four screws @, and remove the
head cover @, and loosen two screws ©
and remove the head cover RO.

(Note) Because the heads No.1 and No.4 have the
head covers R and L respectively, remove
both the the covers when greasing.

3. Loosen four bolts @, and remove the
needle case Q.

4. Loosen three screws @, and remove the
presser foot guide plate ©.

5. Loosen two bolts @, and remove the cap
eaves guide Q0.

6. Loosen three bolts @, and remove the wiper

solenoid assembly ®.

7. Remove screws (7 pcs) indicated by
arrows. Apply grease to the tapped holes
with the syringe provided and tighten the
screws again.

Also apply grease to presser bar spring @,
the end of presser bar guide bracket ®,
presser bar metals U @ and D @, and
jump rotary shaft .

* After greasing, assemble in the reverse
order.

(Note) - When reattaching the head cover @ after
its removal, move the needle bar case to
the needle bar 6 position.

When assembling the needle bar case O,
place it on the machine and turn the change
pulley @ behind the cover ( at right.
Check that it is engaged, and then tighten
the bolts.

When attaching the presser foot guide plate
0, move the presser foot up and down by
the retracting lever to check that is it not
distorted.

For more information, refer to the illustra-

tion on page 227.
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3-2 Feed Guide Section

H Check the X-feed linear guides (2 positions) and the Y-feed linear guides (one each on the right
and left, and one point on bed No. 3).
(Note) When greasing, be sure to use the grease tank 30 provided with the machine.

Procedure

1. Loosen 12 screws @, and remove the X-
feed cover ©.

2. Loosen eight screws ©, and remove the
cover O.

3. Remove thirteen screws @. Remove bed
covers B @ and C @.

4. Grease the X-feed linear guides (3
positions), the Y-feed linear guides (one
each on the right and left), and the linear
guide inside the No. 3 bed. Slide the guide
to spread grease entirely.

* After greasing, assemble in the reverse
order.
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A CAUTION

Turn off the power switch and pull out the plug
before starting adjustment. Failure to do so may
start the machine unintentionally through an
accidental activation of the START switch, re-
sulting in bodily injuries.

- Adjustment

If adjustment should be made while the power
switch is turned on, pay special attention to your
safety.

Maintenance and inspection of the machine
should be conducted only by trained engineers.

1. Adjusting Needle Bar Height

BLEE

STOP
POSITION

=3NH

saND

» NU

BUUE
STOP
POSITION

f———

Tighten the bolt
@ so that the
clearance can be
even.

o

— Do not hit
this section.

\—

‘™
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Dismount the pulley cover and turn the pulley B @ until the pulley scale indicates 180° and
the needle bar is set at the lowest position. (The pulley B "II" mark and the stop mark "IlI"
are aligned.)

Insert the positioning bar @ into the hole of the pulley B @ and fix the drive shaft.
Note) Turn the pulley B securely in the clockwise direction to eliminate a backlash.

Loosen Needle bar guide bracket set screw © and the bolt @ of the top dead center stopper
O when the needle tip is positioned 10.8 mm above the center of the rotary hook shaft.
Adjust the position of the needle bar thread guide so that the set screw @ on it is turned to
the right by 25 ~ 30°. Tighten Needle bar guide bracket set screw © securely.

Note) When tightening the needle bar clamp set screw @, the hole in the needle bar guide should face the front.

After adjustment is finished, remove the positioning bar ©.

Set the needle bar at the highest position (where the pulley B indication mark " I " and the
cover indication mark " 1 " are aligned). Lightly press the top dead center stopper @ toward
the cushion rubber @, and tighten Socket head bolt for top dead center stopper @ while
pressing down the needle bar clamp so that it faces the front. (Tightening torque: 0.78 N-m)
Note) - Make sure that the top dead center stopper does not hit the needle bar guide rail @ at this time.
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H When using the bottom dead center gauge

BiEfiE

STOP
POSITION
«INH

ssN.D

» NU

BILfE (5 A\t

STOP
POSITION

“iNH Cutting ° ‘\ 7 °
==N.D section A

= NU

(4]
Cutting
section
" N
—
Tighten the bolt
l O so that the
N\ clearance can be
%}[ even.
(8

™o

7]

Do not hit
this section.
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Turn the pulley B @ until the scale of pulley B @ indicates 180° (where the pulley B indication
mark "II" and the stop mark "II" are aligned) and the needle bar is set at the lowest position.

Insert the positioning bar @ into the hole of the pulley B @ and fix the drive shaft.
Note) Turn the pulley B securely in the clockwise direction.

Insert the bottom dead center gauge © into the rotary hook Q.

Loosen the screw @ of the needle bar clamp @ and Socket head bolt for top dead center
stopper @, then move the needle bar up and down until the needle tip touches the gauge ©
lightly.

Note) - The needle point should touch the gauge at a place other than the cutting section.

« The bottom dead center gauge should be set in or removed from the rotary hook with its cutting section
facing upward.

Tighten the screw @ of the needle bar clamp @ securely.
After adjustment is finished, remove the positioning bar @.

Set the needle bar at the highest position (where the pulley B indication mark " I " and the
cover indication mark " I " are aligned). Lightly press the top dead center stopper @ toward
the cushion rubber @, and tighten Socket head bolt for top dead center stopper @ while
pressing down the needle bar clamp so that it faces the front. (Tightening torque: 0.78 N-m)
Note) - Make sure that the top dead center stopper @ does not hit the needle bar guide rail { at this time.
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2. Replacing (Attaching) Rotary Hook

1. Turn the power switch off.

2. Tighten the screw @ of the rotary hook
cutting section to fit to that of the lower
shaft ©.

3. When mounting, press it inward until it
stops.

Note) After replacing rotary hooks, refer to "4. Ad-
justment of Timing Between Needle and Ro-
tary Hook (Page 238)" and adjust the timing.

Cutting
section
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3. Adjustment of Clearance Between Needle and Rotary Hook

1. Turn the power switch off.

0— ..., .:.... o 2. Select the needle bar No. 1 @.
\-' '/ The illustration at the left shows the case of BES-
LeLeLoLELSLELEL el 962BC. For BES-1262BC, the No. 12 needle becomes

® I e

BilididdiE

needle bar No. 9.

3. Remove two flat screws @ and dismount
the needle plate ©.

4. Turn the pulley B until the pulley indication

mark "sa" and the stop mark "NHsa" are

aligned.

2mm _

5. Turn the rotary hook @ manually so that
the rotary hook point is aligned properly.

6. Loosen the set screw @ on the side of the
bed O.

7. Turn the eccentric screw @ on the left side of
the bed @ using a regular screwdriver and
adjust a clearance between the needle and the
rotary shaft to 0.3 ~ 0.5 mm.

8. Adjust the clearance between the needle
and the rotary hook's point to 0.3 ~ 0.5 mm
at the needle bar No. 9 @ (No. 12 needle for
BES-1262BC).

Note) If the clearance between the needle and the
0.3~0.5mm rotary hook point is not within the range of
0.3 ~ 0.5 mm, adjust again as described in the
step O until the needle bar No. 1 or No. 9 (No.

12 for BES-1262BC) whichever has the small-
est clearance may not be interfered by the
rotary hook point.
)
1)
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4. Adjustment of Timing Between Needle and Rotary Hook

SN

ssN.D

= NU

BuLaE

STOP
POSITION
=iNH

140°

Rotary
hook's point

STEP

BACK FwD

STEP

BACK FWD

«iNH

«sN.D

= NU

AL

STOP
POSITION

238

Turn the power switch on.

Check that the machine pulley is at the stop
position (at 100° of the scale). If not, turn
the pulley until it comes to the stop
position.

While the machine is at the stop position,
press the JOG switch (\/) while holding
down the STOP switch. "AJST" is indicated
on the display.

Pressing the START switch. "STEP" is
indicated. The rotary hook in each machine
head rotates to the currently set timing
position and the rotary hook can be adjusted.

R

START

Turn the machine pulley manually until the
relationship between the needle point and
the rotary hook's point can be easily
checked (at around 140° of the scale).

Press the STEP BACK/FWD switch to move
the rotary hook for each head to
adjustment.

« STEP BACK
For rotating the rotary hook little by little
in the clockwise direction
« STEP FWD
For rotating the rotary hook little by little
in the counterclockwise direction
Make this adjustment for each machine
head so that the needle and the rotary
hook's point can fit with each other.
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7. After timing adjustment the is finished for
each head, set the pulley to the stop

— —— position (at 100° of the scale) and press the

Y Sy Y A | STOP switch. "STEP" disappears from the

L display, and the machine enters the
@ standby state.

\A\¢~

STOP

The adjustment of the rotary hook is
completed and the timing is stored. The
rotary hook returns to the stop position
accordingly.

5. Adjustment of Presser Foot Height

BLLE
STOP
POSITION
waNH

saND

= NU

1. Turn the power switch off.
2. Select the needle bar No. 1.

3. Loosen the screw @ of the presser foot @, and adjust the presser foot @ until it comes
above the cloth top surface when it is at the bottom dead center (where the pulley indication
Hw Hw

mark "sa" and the cover indication mark "«a" are aligned).

Note) When the presser feet have been adjusted in height, check that each needle lowers to the center of the
presser foot hole.
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6. Adjustment of Thread Trimmer

6-1 Attaching the Fixed Knife

Attach the fixed knife @ to the pin @ and
move it backward to the end of the slot,
then mount it there.

1. Turn the power switch on and wait until the
11 Slonc hoop home position detection is finished.

2. Press the stop switch for safety.

VN e I | ke =
o o< fj‘%

Adjust the movable knife position in this
state.

3. Loosen two bolts © that connect the thread
trimmer connecting rods C @ and B ©.

4. Tighten the two bolts © until the triangle
part of the movable knife @ is projected by
1 mm from the fixed knife @.

1
1mm
Triangle part of
movable knife
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N/

-

* Bad example

I
Ie)!

)
ol 18

* Precautions for tightening the two bolts ©:

« The thread trimmer connecting rod B @
has a backlash of about 0.1 ~ 0.2 mm back
and forth. Tighten the two bolts © while
pulling them forward by the backlash
amount.

« Tighten the two bolts © so that the thread
trimmer connecting rods B @ and C @
are positioned in a straight line.

Mount head No. 3 so as to make thread
trimmer connecting rod D O parallel with
the side of the bed. (Check that no
interference will occur during feed in the
crosswise direction.)

Bed —\\.
A
©)
© :L@’: © _—0
W/

After adjustment is finished, reset the stop
switch.
"STOP" stops blinking and disappears.

Turn the power switch off once, then on
again. Check that the clearance between
the movable knife @ and the fixed knife @
is 1 mm.

When adjusting again, follow the step 2 and
after.
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7. Thread Wiper Adjustment

l BES-962BC

1. Move solenoid arm @ in the direction of the arrow with your finger. Loosen three bolts ©
and adjust thread hook @ for smooth movements.

2. Ifthere is a difference in motion between needle bars No. 1 and No. 9 (No. 12 for BES-1262BC),
loosen four screws @ and make an adjustment by moving thread presser base @ in the
direction of the arrow.

Make sure that no interference will occur when pressure foot @ is raised by the solenoid.

3. Move finger guard plate @ up and down, and align the top of finger guard @ with the tips of
the needles.

4. After the above steps are complete, check thread hook @ for smooth movements.

If the thread hook does not move smoothly, apply grease (Grease Tank BR2 (black)) to the gray part of thread guide
solenoid base (O and check its movements.

Note) - Care should be taken if the finger guard is inclined. If the finger guard in such a state is pushed exces-
sively toward the needle at the time of color change, it may interfere with the presser foot.

- Then make an adjustment in the crosswise direction by sliding bolt @ of finger guard ©.
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8. Adjusting the Belt Tension

The belt Tension is adjusted to the optimum tension at the time of shipment from the factory.
However, as the belt is used,it becomes run in and may loosen around the machine pulley
and motor pulley . Use the following procedure to check the belt tension.

Place a gauge against the belt @, loosen the nut @, and then turn the nut © to move the slot
to the appropriate position so that there is 8 mm of deflection in the belt @ when 9.8 N of

pressure is applied.

The machine operating direction is counterclockwise when seen from the machine pulley
end.
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tween patterns during repeat sewing.

Code Error Measures
E-00 | No error occurs.
This is not usually displayed.
E-01 Either motor of main shaft, X- or Y-axis, or lower
shaft has locked.
E-02 Overtravel occurs during home position detecting | Turn the power off and on once. If the same error occurs again, the home
movement. position sensor is faulty.
£.03 The stop switch is pressed during home position de- | Press the g8 or turn on the F/B switch on the head to either side to restart
tecting movement. the home position detecting movement again.
E-04 | Zero detecting movement out of range This is not usually displayed.
" Adjust the pulley stop position (100 degrees) above the needle and press
E-05 | Needle stop position error the @y or turn on the F/B switch on the head to either side.
E-06 | Needle bar case position error This is not usually displayed.
Press the @8 or turn on the F/B switch on the head to either side. If the
E-07 | Needle bar case lock ; L
same error occurs again, the color change mechanism is faulty.
Stop switch or emergency switch was pressed while . .
E-08 P g y . P This is not usually displayed.
the needle bar case is traveling.
. -, . Turn the power off and on once. If the same error occurs again, the X-axis
E-09 | X-axis home position detection error o
mechanism is faulty.
. After passing through the thread, press the or turn on the F/B switch on
E-OA | Thread breaking error P g' g P
the head to either side.
E-O0B | Stop or emergency stop during sewing
This is not usually displayed.
E-OC | Insufficient bobbin thread
E-OD | The machine does not return to the home position. | Turn the power off and on once.
E-OE | Mending finish
This is not usually displayed.
E-OF | Undefined error
. . Turn the power off and on once. [f the same error occurs again, the Y-axis
E-14 | Y-axis home position error L
mechanism is faulty.
Stop error during SSP processing (when pressing .
- It
E15 | o stop key while the hoop is moving) Hoop movement restarts if you press [ 1! ).
E-16 The destination needle bar number given from PC is
out of the movable area.
This is not usually displayed.
E-17 The speed Vol. number given from PC is out of the
appropriate range.
. . Turn the power off and on once after checking to see that the connector of
E-18 | X-axis stepping motor connector error . . .
the X-axis stepping motor is properly connected.
E-1A | Destination coordinates error
This is not usually displayed.
E-1B | The machine has reached the mending stop position.
. . . Tracing is cancelled if the g8 key is pressed when the machine is stopped
E-1C | The machine stops during mask tracing. ) . . g ey 5P ) . PP
during mask tracing. Press the key to continue tracing.
This is displayed when the stop switch is pressed while the hoop is moving.
The machine stops while the needle is moving be- icd P . P . P 9
E-1D Press the to move the hoop again. (It is necessary to press the

again to start sewing.)

Errors E-1C and E-1D are not displayed due to mechanical problems.
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Code Error Measures
This is displayed when every other head control is selected or when the
bed is retreated (including when the power is turned on). Remove the
. resser foot of the retreating head and press the return key or turn the F/B
When the power is turned on, bed can not be re- P . ) g. P y.
E-1E switch of the head to either side. If every other head control is not selected
tracted. . " .
or the bed is not retreated, the bed sensor position may be faulty. Readjust
it. Press the m key. If the same error occurs again, adjust it with the
presser foot switch.
E-1F Presser foot down error while searching for home | Press the [ or turn on the F/B switch on the head to either side. If the
position just after the power is turned on. same error occurs again, adjust the presser foot switch.
E-21 | Hoop overhang(+X)
E-22 | Hoop overhang(+Y)
E-23 | Hoop overhang(+X, +Y)
E-24 | Hoop overhang(-X)
E-25 | Hoop overhang(+X, -X)
E-26 | Hoop overhang(-X, +Y)
E-27 | Hoop overhang(+X, -X, +Y)
E-28 | Hoop overhang(-Y)
E-29 | Hoop overhang(+X, -Y)
E-2A | Hoop overhang(+Y, -Y)
E-2B | Hoop overhang(+X, +Y, -Y)
E-2C | Hoop overhang(-X, -Y) Patterr'1 or.the needle position is out of the embroidering area. . Reset the
embroidering area on PC or move the hoop to the sewable position.
E-2D | Hoop overhang(+X, -X, -Y)
E-2E | Hoop overhang(-X, +Y, -Y)
E-2F | Hoop overhang(+X, -X, +Y, -Y)
E-31 | Needle overhang(+X)
E-32 | Needle overhang(+Y)
E-33 | Needle overhang(+X, +Y)
E-34 | Needle overhang(-X)
E-36 | Needle overhang(-X, +Y)
E-38 | Needle overhang(-Y)
E-39 | Needle overhang(+X, -Y)
E-3C | Needle overhang(-X, -Y)
E-40 The status of presser foot is issued as an alarm when | When using the every other head mode, remove the presser feet according
every second machine is used. to the warning message.
E-41 | Invalid start-up error Turn the power off and on once.
E-42 | XY movement error Press the m or turn on the F/B switch on the head to either side.
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Code Error Measures
Turn the power off and on once. If the same error occurs again, the main
E-43 | Slave I/F EEPROM read error . P g
PC is faulty.
. Press the [ or turn on the F/B switch on the head to either side. If it
E-A1 | Spindle motor lock - . .
occurs frequently, the main shaft mechanism is faulty.
E-A2 | Main PC board temperature too high
E-A3 | Spindle motor voltage too low
E-A4 | Spindle motor voltage too high
This is not usually displayed.
E-A5 | Spindle motor CPU error
E-A6 | Spindle motor CPU communication command error
E-A7 | Spindle motor CPU send/receive error
Adjust the pulley stop position (100 degrees) above the needle and press
E-A8 | Spindle stop position signal error the . If the error occurs frequently, the parts related to the main shaft
stop position sensor are faulty.
E-A9 | Spindle CPU parameter error
This is not usually displayed.
E-BO | Lower shaft CPU error
E-B1 | Thread tangle in rotary hook
9 y Check to see that no lint is tangled in the rotary hook and press the |3
. . turn on the F/B switch on the head to either side.
E-B2 | Hook motor origin point error
The rotary hook may be rotated forcefully. Press the [ or turn on F/B
E-B3 | Hook motor standby position error switch on the head to either side to cancel the error. If the same error
occurs again, the lower shaft sensor is improperly adjusted.
E-B4 | Hook motor motor mode error
E-B5 | Hook motor communication error This is not usually displayed.
E-B6 | Hook motor parameter error
E-B7 | Hook motor overheat error .
Turn the power off and on once. If the same error occurs again, the lower
shaft motor is faulty.
E-B8 | Hook motor overcurrent error
. ) Turn the power off and check the thread trimmer and turn the power on
E-B9 | Thread trimming motor zero point error . . . . .
again. If it occurs again, the thread trimmer is faulty.
Turn the power off and on once. If the same error occurs again, the power
E-BA | Power supply frequency error )
PCB or power supply is faulty.
It may usually occur momentarily when turning off the machine. If it occurs
E-BC | No power error L - . .
when the machine is on, it is a power failure detection error.
Turn the power off and on once. If the same error occurs again, the main
E-BD | Lower shaft flash memory error .
PCB is faulty.
) Press the (B8 or turn on the F/B switch on the head to either side to cancel
E-BE | Lower shaft version-up error - . .
the error and upgrade the version again.
E-BB, BF | Lower shaft motor undefined error This is not usually displayed.
E-C1 | Area over during embroidering Set the embroidering area again on PC.
Ec2 | wi ¢ If the wiper is tangled with a thread, remove it. Press the n or turn on the
) Iperout error F/B switch on the head to either side.
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Code Error Measures
S Is the IF cable disconnected? If it is connected normally, the cable or the
E-C3 | Embroidering data buffer empty ) ; 4
main board is faulty.
Press the [ or turn on the F/B switch on the head to either side. If the
E-C4 | Presser foot down error - . . .
same error occurs again, adjust the presser foot switch.
E-C5 Measured voltage value could not be received form
the lower shaft motor CPU.
This is not usually displayed.
E-C6 Voltage value could not be transferred to the lower
shaft motor CPU.
The machine may be being tested in the BC test mode. Exit the test mode
E-C7 | Lower shaft error or turn the power off and on once. If the same error occurs again, the main
PCB is faulty.
. . Check the operation of the main shaft brake and the stop position of the
E-C8 | Hook motor origin point error .
main shaft (100 degrees).
The is pressed while no sewing data has been transferred to the em-
E-C9 | Embroidering start error broidery machine. Clear this error by the |8 . To start sewing, transfer
necessary data from the machine controller and press the (2] .
E-CA | No sewing permission is given from PC. This is not usually displayed.
E-CB | Spindle rotation speed error the error and press the . If the same error occurs again, there is a
possibility that the spindle is overloaded.
E-CC | Shuttle thread entanglement automatic reset This is not usually displayed.
. Turn the power off and on once. If the same error occurs again, the main
E-CD | Speed command can not be received. ) P 9
PCB is faulty.
. . Secure the bed. If the bed is secured, the bed sensor position may be
E-CE | Cylinder bed position error L P y
faulty. Readjust it.
Rated voltage value could not be received from the | Turn the power off and on once. If the same error occurs again, the main
E-CF .
lower shaft motor CPU. PCB is faulty.
E-DO | Power PC board error Turn Fhe power off and on once. If the same error occurs again, the power
PCB is faulty.
. Turn off the power and check the fan harness. Turn on the power again. If
E-D1 | Cooling fan motor stop B Tum the power off. P ) . P g
the same error occurs again, the fan or the power PCB is faulty.
E-D2 | Power voltage upper limit error (1) The voltage setting is improper. -> Set it again.
(2) Press the [ or turn on the F/B switch on the head to either side. If
the same error occurs again, the power PCB or the power supply is
E-D3 | Power voltage lower limit error faulty.
E-E1 | X-axis pulse motor overcurrent stop
Turn the power off and on once.
E-E2 | Y-axis pulse motor overcurrent stop
Turn off the power and check the fan harness. Turn on the power again. If
E-E3 | Cooling fan motor stop A Press R. P ) . P g
the same error occurs again, the fan or the power PCB is faulty.
L Turn the power off and on once. If the same error occurs again, the main
E-E4 | Lower shaft communication error .
PCB is faulty.
E-E5 | Over-run error during interfacing to main PCB CPU
E-E6 | Framing error during interfacing to main PCB CPU
This is not usually displayed.
E-E7 | Parity error during interfacing to main PCB CPU
E-E8 Receiving time up error during interfacing to main

PCB CPU
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or CPU.

Code Error Measures

E-E9 Send/Receive inconsistent error during interfacing to
main PCB CPU

E-EA ACK code receiving error during interfacing to main
PCB CPU

E-EB Send/Receive ID code error during interfacing to
main PCB CPU

E-EC Send data checksum error during interfacing to main
PCB CPU
Data empty error during interfacing to main PCB

E-ED
CPU

E-EF | Receiving error on interface

E-F1 | Send time up error

E-F2 | Request-to-waiting time up error

E-F3 | Request-to-recive time up error This is not usually displayed.

E-F4 | Receive command error

E-F5 | NACK code receiving error

E-F6 Data requested for needle position can not be re-
turned.

E-F7 | Itis not receive command for the request one.

E-F8 | PRE code error

E-F9 | No applicable command

E-FA | Interface receive data sum check error

E-FB | Send time up error

E-FF No status is returned from spindle, lower shaft motor,
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Chapter 12 Troubleshooting

If there is any indication of trouble with the
machine, check and correct as described in
the table. If the trouble cannot be corrected,
turn off the power and contact your distribu-
tor for corrective actions.
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Mechanical Section

Problem

Check Point

Check these points once again

H Thread breakage

Is the machine properly threaded?

Is thread tension too high?

Is the rotary hook assembly clogged?

Is there thread in the bobbin?

Is the needle bent?

Is there a rough edge or flaw on the needle plate, rotary hook, or
bobbin case that might cut the thread?

Is the needle installed correctly (direction, angle, etc.)

Is the presser foot in contact with the material?

Are the thread thickness and needle size correct?

Is a thread with right-hand twist being used? (If such a thread is
used, replace with a thread with left-hand twist.)

Is there any adhesive on the needle?

Is the material tension too weak?

Is there too much play between the outer rotary hook and inner
rotary hook?

Does the outer rotary hook turn smoothly?

Is the clearance between the rotary hook stopper and the rotary
hook adjusted correctly?

Does the thread come out from the bobbin case smoothly?

B Needle (presser foot) interference
with embroidery hoop

Is the embroidery hoop too small?
Check the size and needle start position in the sewing data.

H Needle breakage

Is the needle attached correctly (direction, height, etc.)?

Is the needle bent?

Is the rotary hook attached correctly?

Is the timing set correctly?

Is there any backlash with the needle bar case (back/forth and
right/left)?

Is the rotary hook stopper correctly attached to stop the rotary
hook?

Is the needle size correct and the tip sharp?

Does the thread pass through the hole center of the presser
foot?

l Not embroidered properly

Is the material edge caught in the machine?

(Are embroidery hoop and other related parts operating
correctly?)

Is the material stretched properly?

Is thread tension proper?

Does the lower thread come out smoothly?

H Machine operation abnormal

Is any set screw of the rotary encoder loosened?

Is any set screw of the machine pulley loosened?

Is any set screw of the machine motor pulley loosened?
Is embroidery data normal?

Is the XY carriage belt loosened?
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Problem

Check Point

Check these points once again

B Machine operation abnormal

Is the XY carriage belt damaged?

Are any set screws for the XY pulley loosened?

Are any set screws for the coupling of the XY pulse motor
loosened?

B Upper shaft locks at a certain point
in one cycle

Is the thread take-up stopped due to interference with the upper
case cover?
[Adjustment]

Thread take-up J
Fc:
Upper case cover—{ Bolt
Needle case— |
Thread take-up

operating lever

Loosen the hexagon socket head cap screw of the thread take-
up operating lever and adjust the take-up movable range.
Tighten it securely afterwards.

Are the needle bar clamp and the top dead center stopper
positioned correctly?

M Error display

Check the rotary hook of a machine head whose MENDING lamp
(green) is blinking to see if the thread is caught.
[Adjustment]
1.Take out the thread tangled in the rotary hook race so that
the rotary hook can be rotated forcibly by manual operation.
2.Check that the machine pulley is set to 100° of the scale, and
press the END switch.
[Measures]
1.1f the thread end is left too long or stitching is left loosened
before starting embroidering, the thread is caught in the
machine and operation stops.
2.When starting embroidering, hook the thread end on the
spring or hold it with a hand.
3.Leave thread of about 60 ~ 70 mm from the needle hole when
starting embroidering.
Is thread tangled in the rotary hook?
Clean the rotary hook.
Conduct BC sensor test of the PC test mode.
If there is any failure, replace the lower shaft with a new one.
(Refer to "Replacing the Lower Shaft Module".)

H Upper shaft pulley does not turn.

Is the presser foot lifted at a retract position when the power is
turned on?
Lower the presser foot for the six machine heads using the lever.

M Stitches cannot be made.

* |Is the needle attached properly?
¢ |s the timing of the needle and rotary hook correct?
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Electrical Section

Cautions

» Be sure to turn off the power of the machine and unplug the power cord before checking cable

connections.

* When you check connection of the cables as instructed in this manual, also check connection and

continuity between connectors.

» Carry out items described in the "Measures" section in order of appearance.
» Some checks and replacement works can be conducted only by repair people. In such cases,

contact your dealer.

Symptom

Measures

The machine does not operate even
if the power is turned on.

Is the power cord of the machine plugged in?

— Plug in the power cord.

Is the connector at the rear of the control box connected?
— Connect it after checking the connector number and the harness number.
Is the connector in the control box or the power supply base connected?
— Connect it after checking the types and colors of the connectors.
Is fuse F1 or F2 on the power PCB in the power supply base blown?
— Replace the fuse with a new one. If the fuse is blown again,
something is faulty. Check to see if the wiring is correct. Replace the
control box with a new one.

The machine does not operate even
if the power is turned on.

The message, "Release stop SW to
operate!", is displayed on the panel.

Is the stop switch turned on?
— Reset the stop switch.

» The message, "Is the presser foot
removed?", is displayed on the
machine controller when the power
is turned on.

e The red LED of head 2 or 4 or 6
does not light and the presser foot
remains lowered.

Is the retract bed sensor adjusted properly?

— Adjust the retract bed sensor of the faulty head. (Refer to "Replacing
the retract bed sensor PCB".)

Refer to the block diagram showing cable connection and check
connection from the retreat bed sensor to the main PCB.

Check to see if the frame type is set to every other head with the
machine controller.

An overtravel error occurs.

Is the frame within the cap frame area?

— Move the frame within the cap frame area and turn on the power.
Check to see if the signal of the X area sensor turns ON and OFF in
PORT test mode.

— When the signal does not change, refer to the block diagram showing
the cable connections and check to see if connection from the X area sensor
to the main PCB is proper. Replace the X area sensor with a new one.

The needle stop position error oc-
curs.

Is the pulley manually turned and out of the stop angle?

— Turn the pulley, adjust the needle at the stop position, and reset
the error.

Check the signal of the stop position sensor in the encoder test mode.
— Refer to the adjustment or cable connection block diagram and
check connection from the needle position detention sensor to the main
PCB. Replace the needle position detection sensor with a new one.
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Symptom

Measures

The needle stop position error oc-
curs.

Is the main shaft brake solenoid operating?

— If not, refer to the block diagram showing the cable connections and
check to see if the connections from the brake solenoid to the power
PCB and from connector P27 of the power PCB to connector P1 of the
main PCB are proper.

Check the resistance value of the main shaft brake solenoid at the
connector section of the solenoid. The normal resistance value is
approximately 50Q.

— Ifitis not normal, replace the solenoid with a new one. In this case, the
power PCB in the control box may also be faulty. Replace it with a new
one if it does not operate properly even after a new solenoid is installed.
Are there any problems with the main shaft mechanism? (i.e., The
screw of the main shaft pulley is loose.)

The needle bar case lock error oc-
curs.

Is the INDEX motor rotating?

— If not, refer to the block diagram showing the cable connections and
check to see if connection from the INDEX motor to the main PCB is
proper.

Check the resistance values of pins 1 and 2 and pins 3 and 4 at the
connector section of the INDEX motor. The normal resistance value is
approximately 4.4Q.

— If it is not normal, replace the INDEX motor with a new one. Also
replace the main PCB with a new one.

Manually turn the color change pulley.

— If it is abnormally heavy, adjust the color change mechanism and
the needle cap case.

Start the machine after invalidating its initial setting and operate the
head solenoid in solenoid test mode.

— If a certain head and the heads following it do not operate, refer to
the block diagram showing the cable connections and check to see if
connection of the head communication sign is proper.

Only head 1 does not operate.

— Check the communication line to head 1 and connection of the power
harness for head 1.

Do the rotary switch settings of each head PCB correspond with the
numbers of each head?

— If not, set them according to the head numbers.

Start the machine after invalidating its initial setting and enter the CASE
test mode. Do figures on the panel change when the color change pulley
is manually turned?

— If not, check to see if connection from the needle bar position sensor
to connector P7 of the head PCB (1) is proper.

Replace the needle bar position sensor (potentiometer) with a new one.
Replace the head PCB 1 with a new one.
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Symptom

Measures

X-axis or Y-axis home position de-
tection error occurs.

Was the XY carriage moving?

— If so, refer to the block diagram showing the cable connections and
check to see if connection from the X and Y area sensor to the main
PCB is proper.

Was the XY motor rotating?

— If so, check the XY carriage mechanism.

If the XY motor is not rotating, refer to the cable connection block
diagram and check to see if connection from the XY motor to the main
PCB is proper.

The thread breakage error frequently
occurs although thread is not broken.

Enter the CASE test mode and turn the thread breakage sensor pulley
corresponding to each needle bar of the head with which this error
occurs while switching the needle bar from number 1 in ascending
order and check to see that the red LED on the head blinks.

— If there is no problem, lower the thread breakage sensitivity value of
the machine controller. (The standard value is 0.)

Check connection from the thread breakage sensor PCB to the head
PCB if it does not blink.

Replace the thread breakage sensor PCB with a new one.

The X-axis motor connector connec-
tion error occurs.

Refer to the block diagram showing the cable connections and check
the connection from the two X motors on the left and right to the main
PCB.

The main shaft motor lock error oc-
curs.

Enter the encoder signal mode and manually turn the main shatft pulley.
— If it is abnormally heavy, the main shaft mechanism is faulty.

Does the main shaft motor rotate at all when the error occurs?
— If it does not rotate at all, check fuse F5 on the power supply PCB in
the control box. Refer to the block diagram showing the cable
connections and check to see if connection from the main shaft motor
to the main PCB is proper. Also check connection of connectors P6
and P4 of the main PCB and connectors P19 and P12 on the power
PCB in the box, and connection from connector P11 of the power supply
PCB to the 14v terminal of the power transformer.

Manually turn the main shaft pulley in the encoder signal test mode and
check to see if the stop position signal and encoder signal are proper.
— If either of the signals does not change, refer to the block diagram
showing the cable connections and check to see if connection from the
encoder and stop position sensor to the main PCB is proper.

ERROR A7 occurs.

Check the CPU ROM version for the upper shaft.
— If itis version A, replace it with the latest ROM of version B or later.
(PROM#4 on the main PCB)

ERROR A8 frequently occurs.

In the encoder signal test mode, manually turn the main shaft pulley
and check to see that the stop position signal is correct.

— If the signal does not change, refer to the cable connection block
diagram and check to see if connection from the stop position sensor
to the main PCB is proper.
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Symptom Measures

Thread is frequently tangled in the | ¢ Is thread tangled in the rotary hook?

rotary hook. — Clean the rotary hook.

« Conduct BC sensor test of the test mode.
— If there is any failure, replace the lower shaft module with a new
one.

¢ Conduct automatic out-of-step limit measurement of BC automatic test
in the test mode.
— Replace the lower shaft module with a new one if there is any fault.

e Check to see if the lower shaft fan of the head with which the error
frequently occurs is correctly rotating.
— If the fan is at standstill, check to see if connection from the lower
shaft fan to the BC PCB is proper. Replace the lower shaft fan with a
new one.

« If all the lower shaft fans are at standstill, check fuse F4 on the power
supply PCB in the control box.

« |Is the hole next to the bed with which the error frequently occurs clogged
with dust?
— If so, clean it.

The lower shaft motor zero point er- | « Is thread tangled in the rotary hook?

ror occurs. — Clean the rotary hook.

« Is the lower shaft with which the error occurs rotating?

— If so, check to see if connection from the lower shaft sensor PCB to
the BC PCB is proper. Adjust the lower shaft sensor. Replace the
lower shaft sensor PCB with a new one.

« If the lower shaft with which the error occurs is not rotating, check to
see if connection from the lower shaft motor to the BC PCB is proper.
Replace the lower shaft module with a new one. Replace the BC PCB
with a new one.

The lower shaft motor standby posi- | ¢ Is the rotary hook rotated manually?

tion error occurs. — This is not a fault.

* Check to see if connection from the lower shaft sensor PCB to the BC
PCB is proper. Replace the lower shaft module with a new one.

The lower shaft overheat error oc- | « Check to see if the lower shaft fan is normally rotating. If the fan is at

curs. standstill, check to see if connection from the lower shaft fan to the BC
PCB is proper. Replace the lower shaft fan with a new one.

« If all the lower shaft fans are at standstill, check fuse F4 on the power
supply PCB in the control box.

« |Is the hole next to the bed with which the error frequently occurs clogged
with dust?
— If so, clean it.

« Check to see if connection from the thermister of the lower shaft module
to the BC PCB is proper.
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Symptom

Measures

Lower shaft motor overcurrent error
occurs.

Is the red LED for the BC PCB off?

— If not, refer to the block diagram showing the cable connections and
check to see if the connection from the BC PCB to the main PCB is
proper.

Check to see if connection from the lower shaft motor to the BC PCB of
the bed on BC PCB whose red LED is off is proper.

— Replace the harness or the lower shaft module if a short circuit
occurs due to line insertion.

Measure the resistance values of pin 1 and pin 2, pin 2 and pin 3, pin 3
and pin 4, pin 4 and pin 5, and pin 5 and pin 1 at the connector of the
lower shaft motor with the tester and check to see if they are
approximately 2.6Q.

— Replace the faulty lower shaft module with a new one.

Replace the BC PCB with a new one.

Thread trimming motor zero point
error occurs.

Is lint clogged between the travelling blades?

— Remove it.

Is the thread trimming motor operating?

— If so, refer to the block diagram showing the cable connections and
check to see if connection from the thread breakage sensor to the main
PCB is proper. Also adjust the thread breakage sensor PCB. (Refer to
"Replacing thread breakage sensor PCB.)

If it is not operating, refer to the block diagram showing the cable
connections and check to see if connection from the thread trimming
motor to the main PCB is proper.

Check to see if connection from connector P3 of the main PCB to
connector P9 of the power supply PCB in the control box is proper.
Check fuse F6 on the power supply PCB in the control box.

— If it is blown, replace it with a new one. If it is blown again, replace
the power supply PCB.

Power frequency error occurs.

Check to see if connection from connector P16 of the main PCB to
connector P10 of the power supply PCB in the control box is proper.
Refer to the block diagram showing the cable connection and check to
see if connection from connector P26 of the power PCB in the control
box to connector P7 of the power supply PCB in the power supply base
is proper.

Check fuse F3 on the power supply PCB in the power supply base.
— If it is blown, replace it with a new one. If it is blown again, there is
a fault somewhere in the 24v system circuit.

Wiper out error occurs.

Does the wiper on the error head remain projected?

— If the wiper is tangled with a thread, remove it. If the wiper does not
return smoothly, adjust it.

Enter the solenoid test mode and operate the wiper solenoid. Check the
icon on the panel.

— If a sensor signal is not given, check to see if connection from the
wiper sensor to the head PCB is proper. Replace the wiper sensor
with a new one. Replace the head PCB with a new one.
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Symptom

Measures

Presser foot down error occurs.

Is the presser foot attached?

— If not, attach it.

Does it rise and drop immediately?

— If so, adjust the presser foot sensor.

Does the presser foot rise and make some noise for a while?

— If so, check to see if connection from the presser foot sensor to the
head PCB is proper. Replace the presser foot sensor with a new one.
Replace the head PCB with a new one.

Does the presser foot move? If it does not move at all, check to see if
connection from the presser foot motor to the head PCB is proper.
Replace the presser foot motor with a new one. Replace the head
PCB with a new one.

ERROR C7 occurs.

Is the lower shaft being tested in the test mode?

— If s0, refer to the operation method of the test mode and exit the test
mode or turn the power off once and on again.

Turn the power off once and on again. If the same error occurs again,
replace the main PCB with a new one.

Main shaft rotation speed error oc-
curs.

Enter the encoder signal test mode and manually turn the main shaft
pulley.

— If it is abnormally heavy, the main shaft mechanism is faulty.

Refer to the block diagram showing the cable connections and check
to see if connection from the main shaft motor to the main PCB is
proper. Also check the connection from connectors P6 and P4 of the
main PCB to connectors P19 and P12 of the power supply PCB in the
box and the connection from connector P11 of the power PCB to the
14v terminal of the power transformer.

Cylinder bed position error occurs.

The bed retract sensor is not adjusted properly. Adjust it properly.

Power PCB error occurs.

Check to see if connection from connector P16 of the main PCB to
connector P10 of the power supply PCB in the control box is proper.
Refer to the block diagram showing the cable connections and check
to see if connection from connector P4 of the BC PCB to the power
supply PCB in the control box, and connection from connector P9 of
the main PCB to connector P3 of the power supply PCB in the control
box are proper.

Replace the power supply PCB with a new one.

Replace the main PCB with a new one.

Cooling fan motor stops.

Exhaust fan motor stops.

When all three fans in the control box
stop

Refer to the block diagram showing the cable connections and check
to see if connection from connector P5 of the power PCB in the control
box to connector P1 of the power supply PCB in the power supply
base, and connection from connector P4 of the power supply PCB in
the power supply base to the 18v terminal of the power transformer are
proper.

Check fuse F3 on the power supply PCB in the power supply base.
— If it is blown, replace it with a new one. If it becomes blown again,
the 24v system circuit is faulty.
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Symptom Measures

Only cooling fan motor stops. * Check to see if the cooling fans on the left of the main PCB and inward
of the power supply PCB are rotating.
— If either of them is at standstill, check to see if connection from the
cooling fan which is at standstill to P20 or P25 of the power supply
PCB in the control box is proper. If they are connected properly, replace
the cooling fan which is at standstill.

« Both cooling fans are rotating.
— Check to see if connection from connector P16 of the main PCB to
connector P10 of the power supply PCB in the control box is proper.
Replace the main PCB with a new one.

¢ Check to see if the cooling fan on the right side of the main PCB is
rotating.
— If it is at standstill, check to see if connection from the cooling fan to
P12 of the main PCB is proper. If they are connected properly, replace
the faulty cooling fan.

» The cooling fan is rotating.
— Replace the main PCB with a new one.

Power voltage upper or lower limit | ¢ Is the voltage set on the panel?

error occurs. — If not, set it according to the power supply voltage of the area where
the machine is used.

« |s the tap voltage of the power transformer (terminal connection of mark tube
T) adjusted to the power voltage of the area where the machine is used?

— If not, switch the tap connection.

* Check the input voltage values in the power/voltage check test mode.
Measure the power supply voltage with the tester and compare them.
— If the voltage value is significantly out of the normal range (£5v or
more), calibrate it with the voltage calibration in the test mode.

¢ When you cannot enter the test mode because this error frequently
occurs, set the voltage to a relatively high value with the machine
controller if it is E-D2 and to a relatively low value if it is E-D3 to avoid
errors. Check and calibrate the voltage in the test mode.

« Check to see if connection from connector P16 of the main PCB to
connector P10 of the power supply PCB in the control box is proper.

« |Is the power supply abnormally low because a machine with a large
capacity (compressor and the like) is used?

— Change the power to the other system. Use a stabilizer.

* Replace the power PCB with a new one. Replace the main PCB with

a new one.

X-axis motor overcurrent stop oc- | « Measure the resistance values of pin 1 and pin 2, pin 2 and pin 3, pin 3

curs. and pin 4, pin 4 and pin 5, and pin 5 and pinl at each connector section
of two X-axis motors with the tester and check to see if they are
approximately 2.1Q.
— Replace the faulty motor with a new one.

« Refer to the block diagram showing the cable connection and check to
see if connection from the X-axis motor to the main PCB is proper.

« Replace the main PCB with a new one.
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Symptom

Measures

Y-axis motor overcurrent stop oc-
curs.

Measure the resistance values of pin 1 and pin 2, pin 2 and pin 3, pin 3
and pin 4, pin 4 and pin 5, and pin 5 and pin 1 at each connector
section of the Y-axis motor with the tester and check to see if they are
approximately 2.4Q.

— Replace the faulty motor with a new one.

Refer to the block diagram showing the cable connection and check to
see if connection from the Y-axis motor to the main PCB is proper.
Replace the main PCB with a new one.

The following errors frequently occur.
« Lower shaft memory error
* ERROR E5 to ERROR FF

Replace the main PCB with a new one.

Only a certain head does not oper-
ate.

Is the head out of action with either the head switch or the machine
controller?

Refer to the block diagram showing cable connections and check to
see that other cables are connected to the head switch PCB and the
head PCB and the head PCB properly.

Jump solenoids and wiper solenoids
of all heads do not operate.

Refer to the block diagram showing cable connections and check to
see if connection from connector P4 of the power supply PCB in the
control box to connector P6 of the power supply PCB in the power
supply base, and connection from connector P5 of the power supply
PCB in the power supply base to the 39 terminal of the power
transformer are proper.

Check fuse F4 on the power supply PCB in the power supply base.
— Ifitis blown, replace it with a new one. The 50v circuit is faulty if the
fuse is blown immediately after turning on the power even after
replacing the fuse.

Jump solenoid does not operate.

Check to see if connection from the jump solenoid to connector P10 of
the head PCB is proper.

Check the resistance value of the jump solenoid which does not operate
with the connector section. The normal resistance value is
approximately 56Q.

— If itis faulty, replace the solenoid with a new one. In this case, the
head PCB may also be faulty. Also replace the head PCB with a new
one if it does not operate properly even after replacing the solenoid.
Refer to the block diagram showing the cable connections and check
to see if connection from connector P12 of the head PCB to connectors
P7, 8, 13, 14, 15, and 16 on the power supply PCB in the control box is
proper.

Replace the head PCB with a new one.
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Symptom

Measures

Wiper solenoid does not operate.

Check to see if connection from the wiper solenoid to connector P11 of
the head PCB is proper.

Check the resistance value of the wiper solenoid which does not
operate with the connector section. The normal resistance value is
approximately 28Q.

— If it is faulty, replace the solenoid with a new one. In this case, the
head PCB may also be faulty. Also replace the head PCB with a new
one if it does not operate properly even after replacing the solenoid.
Refer to the block diagram showing the cable connections and check
to see if connection from connector P12 of the head PCB to connectors
P7, 8, 13, 14, 15, and 16 on the power supply PCB in the control box is
proper.

Replace the head PCB with a new one.

The lower shaft PCB is faulty.

. Turn off the power of the machine.
. Disconnect P4 and P10 of the lower shaft PCB.

. Turn on the power of the machine.

. If there is just one lower shaft PCB, reset the LEDs of the two heads

If the lower shaft PCB is removed from the machine or P8 or P9 is
disconnected, the lower shaft connected to other lower shaft PCB will
not operate, either.

The E-B2 error occurs and the green LED blinks with the head
corresponding to the faulty lower shaft. Turn off the pause switch of
the head (flip it down) and keep flipping up the mending switch until
the green LED stops blinking.

and reset the error with the STOP key on the panel or the step back
key of the head.

The lower shaft module is faulty.

Note:

. Turn off the power of the machine.
. Disconnect P1, P3, and P5 (for a fixed bed) or P2, P4, and P6 (for a

. Turn on the power of the machine.

. When the LED of the corresponding head stops blinking, reset the

The above operation will prohibit operation of the lower shaft connected to the faulty lower shaft PCB or the
faulty lower shaft module and cause the corresponding heads to pause. This is reset when the power of the
machine is turned on again. Start from the step 3 to prohibit the operation again.

retract bed) connected to the lower shaft PCB from the faulty lower
shaft module.

The E-B2 error occurs and the green LED blinks for the bed
corresponding to the faulty lower shaft. Turn off the pause switch of
the head (flip it down) and keep flipping up the mending switch until
the green LED stops blinking.

error with the STOP key on the panel or the step back key of the head.
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Personal Computer Section

Trouble

Check Point

Check these points once again

B The power lamp does not light up
when the computer power switch

is turned on.

Is the cable correctly plugged in the computer?
Is the AC line live?

B The display does not light up when
the computer power switch is

turned on.

Is the display power lamp on?
Is the display's cable correctly connected?
Is the display's contrast correctly adjusted?

M "Windows" cannot be started.

Is a floppy disk inserted?

M "Windows" can be started but the

embroidery software cannot.

Is the selection of other icons possible?
Is the selected icon correct?
Can you double-click more quickly?

B The window does not open though
the machine power is turned on?

Is the cable to the machine and the interface board correctly
connected?

Is the interface board attached properly? (Refer to Page 39.)
Is the correct COM port selected? (Refer to Page 131.)

B The screen changes when the
mouse is not operated for a while.

The screen saver is preset. Invalidate this function on the control
panel screen. Do not validate the power-saving function.

B The screen of the editor, the
explorer or the production report
disappears during operation.

The machine controller screen was clicked so that the current
screen is hidden behind it. Move the mouse to the bottom of the
screen and select the program (editor, explorer, or production

report).

M Colors set for a design and
threads are not available.

The number of colors is set to 256. Increase the number to

65000 or more on the control panel screen.
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Connection and Installation
of Optional Equipment
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Attaching Bobbin Winder

266

Mount two pieces of bobbin stand L @ on the thread winder stay @ with nut 4 @.

Mount the thread winder assembly (set) @ on the thread winder stay @ with the tightening
screw (.

Mount the thread guide @ with the drilling bolt set 6 x 20 { and nut 6 ®.

Mount the spool shaft B @ and pan @, spool mat @, and spool cushion @ with nut 5 ® and
spring washer @.

Insert the thread winder harness @ in the 2P (No. 6) connectors on the rear of the control
box.
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B Winding lower thread

e

(=~

L

Turn the power switch on.

Set the bobbin @ in the bobbin winder shaft
0.

Put the thread through the thread guide ©.

Wind the thread around the bobbin @
several times in the direction of the arrow.

Press the bobbin hold @.

Note) If the thread cannot be wound evenly, loosen
the screw @ and move the thread guide @
right and left for adjustment.

In order to wind more threads around the bob-
bin, loosen the thread @ and move the bob-
bin hold O.

After winding is finished, pull out the
bobbin from the bobbin winder shaft and
trim the thread using the thread trimmer @.

Note) - If the thread is wound too tight and comes
off from the tension disk, loosen the knob
0. If the thread is too loose, tighten the
knob ©.

If the circuit protector @ functions, the bob-
bin winder motor does not rotate. Leave it
for a while for cooling. Then press the cir-
cuit protector @. (The thread does not
come out when the motor is not cooled
enough.)
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